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Copyrights and Trademark Notices
Copyright © 2023 Telestream, LLC and its Affiliates. All rights reserved. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without written permission of Telestream, LLC. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream. Specifications subject to change 
without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player, 
GraphicsFactory, Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch, 
Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast are registered trademarks 
and Aurora, ContentAgent, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS ASM, 
MacCaption, Pipeline, Sentry, Surveyor, Vantage Cloud Port, CaptureVU, FlexVU, PRISM, 
Sentry, Stay Genlock, Aurora, and Vidchecker are trademarks of Telestream, LLC and its 
Affiliates. All other trademarks are the property of their respective owners. 

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights 
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories Licensing Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
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OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows Server 2016|Server 2019|Server 2022, Windows 10, 
Media Player, Media Encoder, .Net, Internet Explorer, SQL Server 2012|2016|2019|2022, 
and Windows Media Technologies are trademarks of Microsoft Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT 
License and Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs, 
© 2015 by Hiro, Sjoerd Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry 
Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer:

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Swagger. Licensed from SmartBear.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.
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ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

 

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.



5

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.
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Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Regulatory Compliance
Electromagnetic Emissions: FCC Class A, EN 55022 Class A, EN 61000-3-2/-3-3, CISPR 22 
Class A

Electromagnetic Immunity: EN 55024/CISPR 24, (EN 61000-4-2, EN 61000-4-3, EN 
61000-4-4, EN 61000-4-5, EN 61000-4-6, EN 61000-4-8, EN 61000-4-11)

Safety: CSA/EN/IEC/UL 60950-1 Compliant, UL or CSA Listed (USA and Canada), CE 
Marking (Europe)

California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) 
Lithium coin cells. Perchlorate Material-special handling may apply. See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Contacting Telestream

Resource Contact Information

Vantage Technical 
Support

Web Site: http://telestream.net/
telestream-support/vantage/support.htm

Support Email: support@telestream.net

Enterprise Telephone Support: 

U. S. Toll Free: (877) 257-6245

U. S. from outside U.S.: (530) 470-2036

Europe | Middle East | Africa | Asia | Pacific:
 +49 228 280 9141

Terms and times of support services vary, per the terms of 
your current service contract with Telestream.

Vantage Information, 
Assistance, FAQs, 
Forums, & Upgrades

Web Site: http://telestream.net/telestream-support/
vantage/support.htm

Telestream, LLC Web Site: telestream.net

Sales and Marketing Email: info@telestream.net

International 
Distributor Support

Web Site: telestream.net

See the Telestream site for your regional authorized 
Telestream distributor.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document, or other Telestream documents—or if 
you've discovered an error or omission, please email us.

http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
mailto:support@telestream.net
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net
mailto:info@telestream.net
http://www.telestream.net
mailto:techwriter@telestream.net
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Vantage Client Programs 
Overview

This chapter provides general information about using Vantage client programs, 
including starting and stopping, logging in to a Vantage domain, and best practices for 
accessing Windows files in Vantage.

Note: You manage Vantage licenses in the Management Console. For details on 
adding, updating, or activating licenses, see Enabling a Vantage License in the Vantage 
Domain Management Guide. Depending on how you purchase Vantage features, 
Telestream may send you additional license files or an updated license file. Follow the 
instructions accompanying the license file for adding or updating license files.

Topics
■ Adding Demo Licenses

■ Windows Vantage Client Program Management

■ Web Application Management

■ Paths for Vantage Storage Overview



Vantage Client Programs Overview
Adding Demo Licenses

22

Adding Demo Licenses
You should, as a general rule, manage your licenses using the Management Console. 

However, for convenience, you can also import demo license files (but not production 
licenses) to your domain directly in Workflow Designer.

When you receive a demo license (an XML file), install it using these steps:

1. Store the demo license file in a location that is accessible to your Vantage domain 
server.

2. Store a second copy of the file in a safe place.

3. In Workflow Designer, select File > Add/Update Demo License to display the Add/
Update Demo Licenses dialog.

4. Navigate to and select one or more licenses, and click Open.

5. Restart Workflow Designer and any other client programs that are open.
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Windows Vantage Client Program Management
Vantage provides the following Windows programs:

• Management Console

• Workflow Designer

• Workflow Portal

• Dublist Portal

These programs interact with the Vantage domain database to set up and configure, 
control, and operate it. They are often referred to collectively as client programs. 

Note: Vantage Cloud Manager is not described in this guide. For details about using 
Vantage Cloud Manager, see the Vantage Cloud User Guide.

The following topics describe general Windows client program tasks:

■ Starting and Stopping Client Programs

■ Displaying Program Tips & Warnings

■ Displaying the Version of a Windows Client Program

■ Displaying your Domain’s Database Version

■ Displaying the Vantage User Guide

■ Displaying Context-Sensitive Help Topics

■ Displaying Man Pages

■ Selecting Vantage Domains and Logging In

■ Changing Vantage Users in Windows Client Programs

■ Changing Passwords in Windows Client Programs

■ Changing or Reloading A Configuration in Workflow Portal

Starting and Stopping Client Programs
All Vantage Windows client programs connect directly to the Vantage domain 
database, and thus—can only be used on a Windows computer which has access to the 
domain (or the domain’s database host in the case of an array).

Vantage client programs start and stop like typical Windows programs.

Some client programs require configuration by an administrator before they can 
function. For example, Workflow Portal and Dublist Portal require application 
configurations, which are created in the Management Console.

■ Starting Workflow Designer

■ Starting Workflow Portal

■ Starting Dublist Portal

■ Stopping Vantage Windows Client Programs
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Starting Workflow Designer
To start Workflow Designer, use one of these methods:

• Select Start > Programs > Telestream > Vantage > Vantage Workflow Designer

• Double-click the Vantage Workflow Designer shortcut on your desktop.

Note: If you are launching Workflow Designer for the first time, you’ll be prompted to 
select and log in to a Vantage domain. See Selecting Vantage Domains and Logging In 
for details.

Starting Workflow Portal
Workflow Portal is an optional, licensed Vantage client program that allows operators 
to browse catalogs or Windows servers to select media, enter/update metadata and 
variables, and submit jobs. When you start Workflow Portal, if no license is available, it 
advises you, and operates in demo mode. When operating in demo mode, you cannot 
submit jobs or edit metadata labels.

You can run multiple instances of Workflow Portal on one computer (and one license), 
so that you can use multiple configurations at the same time. For example, you may be 
reviewing and submitting assets in one, and setting trim points in another. 

User authentication is used to control user access to Workflow Portal configurations. 
Administrators can choose which Vantage users can utilize a specific configuration. 
Administrators can also make certain configurations available to everyone.

To start Workflow Portal, do one of the following:

• Select start > Programs > Telestream > Vantage > Vantage Workflow Portal

• Double-click the Vantage Workflow Portal shortcut on your desktop.

Note: If you encounter an error when launching the Workflow Portal, please see 
Troubleshooting Workflow Portal for assistance.

If you are launching Workflow Portal for the first time, you’ll be prompted to select and 
log in to a Vantage domain and choose a Workflow Portal configuration. See Selecting 
Vantage Domains and Logging In for details.
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Starting Dublist Portal
Dublist Portal is provided as part of TrafficManager. You can run multiple instances of 
Dublist Portal on one computer, so that you can use multiple configurations at the 
same time.

User authentication is used to control user access to Dublist Portal configurations. 
Administrators can choose which Vantage users can utilize a specific configuration. 
Administrators can also make certain configurations available to everyone.

To start Dublist Portal, do one of the following:

• Select start > Programs > Telestream > Vantage > Vantage Dublist Portal

• Double-click the Vantage Dublist Portal shortcut on your desktop.

If you are launching Dublist Portal for the first time, you’ll be prompted to select and 
log in to a Vantage domain. See Selecting Vantage Domains and Logging In for details.

Stopping Vantage Windows Client Programs
To stop any of the Vantage Windows client programs, use the usual Windows 
convention—select File > Exit (Control+Q). 

You typically don’t need to explicitly save work you have performed, because all 
information is stored in the Vantage domain database, and updated automatically as 
you make changes. However, when you are editing data (for example, metadata, in the 
Management Console or Workflow Portal), you do need to save it explicitly. If you 
attempt to close a dialog window or the program without saving the data, you’ll be 
warned.
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Displaying Program Tips & Warnings
Both Workflow Designer and Workflow Portal provide tips and warnings in tooltips and 
dialogs. To hide these tips and warnings, Check the Hide checkbox on one of the 
dialogs, or select Options > Hide Tips & Warnings. To reset them to their default 
behavior, select Options > Restore Tips & Warnings.

Displaying the Version of a Windows Client Program
To determine which version of a Vantage Windows client program you’re using, select 
Help > About.

Displaying your Domain’s Database Version
To determine a Vantage domain’s database version number, in Workflow Designer 
select Help > Database Version.

Displaying the Vantage User Guide
There are several ways to access the Vantage User Guide in Workflow Designer:

• Select Help > Getting Started to display the Tours topic in the Vantage User Guide. 
The tours introduce you to Workflow Designer and describe how to create and con-
figure workflows, submit jobs, and monitor jobs.

• Select Help > Contents to display the Vantage User Guide table of contents.

• Select Help > Index to display the Vantage User Guide index.

• Select Help > Search to display the Vantage User Guide search tab, where you can 
enter search criteria to locate topics you want to read.

• If you have Internet access, select Help > Online Help to display Vantage Online 
Help on the Telestream web site, where you can access all Vantage documentation.

Displaying Context-Sensitive Help Topics
In Workflow Designer, you can click the help button  to display the topic in the User 
Guide that relates to the specific program feature that has focus:

If the topic is not available, you can search the entire User Guide for information.

Help 
button
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Displaying Man Pages
In Workflow Designer action Inspectors, man pages are context-sensitive help topics 
that provide detailed information for action configuration options.

To open the man page for any action inspector panel, click the  button.

When the man page window is open as you proceed through a series of Inspector 
panels, the man page changes as necessary, as you display each panel.

Man page 
button
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Selecting Vantage Domains and Logging In
Selecting a Vantage domain and logging in to it varies, based on several factors and 
settings in your domain. These tasks are described in the following topics:

■ Selecting the Vantage Domain

■ Logging In to a Vantage Domain

■ Creating a Workflows Category in Workflow Designer

■ Selecting a Configuration in Workflow Portal or Dublist Portal

Selecting the Vantage Domain
You may have multiple Vantage domains in your environment. (For example, domains 
for different departments, shows, or geographic locations, or for scaling your encoding 
capacity or using a Vantage Lightspeed server.) Each Vantage domain is a separate, 
stand-alone Vantage system, whose Vantage domain database and services do not 
interact with other domains. 

You might need to manually select a domain from a Vantage client program for the 
following reasons:

• You are starting a Vantage client Windows program for the first time.

• Your work requires that you connect to a different Vantage domain.

After you select a Vantage domain, the program remembers it and connects to the 
domain automatically each time you restart the program. You can change domains at 
any time.

To select a domain, do the following:

1. In any client program, select File > Change Vantage Domain (in Workflow Designer, 
you can also right-click in the Workflows panel away from any buttons and select 
Change Vantage Domain from the context menu).

The program displays the Select Vantage Domain panel.

Take one of two actions: 
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2. If you know the domain’s identity or the domain isn’t listed during a search, click 
Specify Vantage Domain Name/IP Address to expand the dialog. 

a. Enter the Vantage domain’s server name (for example, VantageServer203) or IP 
address and Vantage database instance name if different than the default, and 
click OK to connect. If you do not know what to enter, contact your Vantage 
domain administrator.

3. If you don’t know the domain’s identity, click Search to locate all domains on your 
network.

a. Select the domain you want to connect to, and click OK. 

If connection is successful and you’re prompted to enter a user name and pass-
word, see Logging In to a Vantage Domain.

When you change domains, the program closes its connection (if any) with the cur-
rent domain and connects to the new domain.
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Note: If your domain isn’t listed or you can’t connect, contact your Vantage domain 
administrator and/or refer to Connecting to an Unlisted Domain. If you are required to 
connect using a custom login, follow these steps:

To connect using custom login settings:

If the Vantage domain is using a SQL database where the default settings for the MS 
SQL server account were changed during installation, open Connection Settings to 
display the SQL Server login and password settings.

The program displays the SQL Server login and password settings.

Enter the Vantage database SQL server account user name and password (obtained 
from your Vantage administrator), and click OK to connect.

Logging In to a Vantage Domain
To access a Vantage domain, you may need to log in, providing your user credentials. 
Your Vantage administrator will either provide you with a Vantage user name or 
configure Vantage to work with your Windows user name.

Note: In Workflow Designer and the Vantage Management Console, to maintain 
security, you can elect to prompt for login each time the program is launched. Or, you 
can disable this feature, but it reduces security.
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Note: Administrators can enable or disable user authentication. They can also choose 
whether or not to use Windows user names by enabling or disabling Windows Active 
Directory. Both settings are configured in the Vantage Management Console.

Note: If you don’t have a Vantage user name, ask your Vantage administrator to 
create one for you or add your Windows user as an authorized Vantage user.

If login is required, the Vantage Domain Login dialog displays.

Enter your user name, and password if required, and click OK to connect.

In Workflow Designer, you may be prompted to create a new category—see Creating a 
Workflows Category in Workflow Designer.

In Workflow Portal and Dublist Portal, you’ll be prompted to select a configuration 
before you can continue—see Selecting a Configuration in Workflow Portal or Dublist 
Portal.

Creating a Workflows Category in Workflow Designer
When you log in, the only categories that display are those that you are authorized to 
access. (If your user has administrative privileges, all workflows in the domain are 
displayed.) Access to workflow categories by user is controlled in the Management 
Console.

When you log in, if there are no categories available then you will be prompted to 
create one. If you’re prompted to create a new category, click OK to display the Create 
New Category dialog.

Enter the name for this category, and click OK. 

This dialog is for a domain 
not using Active Directory.

This dialog indicates that 
the domain is using Active 
Directory.
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Selecting a Configuration in Workflow Portal or Dublist 
Portal
If a configuration has been previously selected, it is loaded and used automatically. 
Otherwise the Select Configuration window displays, enabling you to select a 
configuration to use during this session. 

Note: The configurations in the list include public configurations (usable by any 
Vantage user), plus those that your Vantage user account is authorized to use. Access 
to configurations is controlled by the Vantage domain administrator.

Select a configuration from the list and click OK.

Changing Vantage Users in Windows Client Programs
When you are logged in to a Vantage domain that has User Administration enabled (in 
the Vantage Management Console), you can change to another Vantage user or Active 
Directory user (depending on your User Administration settings. 

Select File > Change Vantage User to display the Vantage Domain Login dialog.

Enter your user name, and password if required, and click OK to log in.
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Changing Passwords in Windows Client Programs
When you are logged in to a Vantage domain that has User Administration enabled (in 
the Vantage Management Console) and Windows Active Directory is not being used, 
you can change the password of the Vantage user currently logged in.

Select File > Change Password to display the Set Password window.

Enter a new password, confirm the password, and click OK to update the password for 
this user. The next time you log in to the Vantage domain with this user, you’ll need to 
use the new password.

Changing or Reloading A Configuration in Workflow Portal
To change configurations when you need to perform other tasks in the same domain or 
when you have changed a configuration and need to obtain the current version, follow 
these steps:

1. Select File > Change/Reload Application Configuration.

Workflow Portal displays a list of configurations for this domain.

2. Select the configuration you want to use or update, and click OK.

Workflow Portal opens the configuration, and displays the appropriate user interface 
for this configuration.
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Web Application Management
Vantage provides the following web applications:

• Web Dashboard—Shows domain status and statistics for administrators.

• Job Status Views Web Application—Allows viewing and managing Vantage jobs.

• Workflow Portal Web Application—Allows viewing and managing catalogs and 
binders, and submitting them to workflows.

• Dublist Portal—Provides an operator web portal for managing dublists.

• Settings—Settings for web apps, including 12/24 hour clock selection, and Precon-
figure Vantage Database, which eliminates the requirement for users to search for 
the domain and log in on first use (see Bypassing Database Login). 

• External Links—A web page for storing frequently used web links. You can add links 
using the Vantage Management Console > Settings & Options > Dashboard Links.

The following topics describe general web application tasks:

■ Web Application Browser Requirements

■ Web App Home Page—Launching Web Apps

■ Logging In or Changing Domains from Web Applications

■ Returning to the Vantage Web App Home Page

■ Logging Out of a Vantage Domain

■ Changing Passwords in Web Applications

■ Displaying Version Information

■ Accessing Vantage Help in Web Applications
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Web Application Browser Requirements
Vantage web applications are implemented for execution in Microsoft IIS. JavaScript 
and cookies must be enabled to use Vantage web applications properly.

Telestream recommends the following web browsers for use with Vantage web apps:

• Internet Explorer 11—32-bit or 64-bit (Windows only)

• Chrome—current version (MacOS X and Windows)

• Safari—current version (MacOS X only).

To configure Internet Explorer for use with Vantage web applications, do the following:

1. Enable Active Scripting—Open Internet Explorer, select Tools > Internet options, 
select the Security tab, click Custom level, scroll down to Scripting, click Enable 
under Active scripting, click OK, and click OK to close the Internet Options dialog.

2. In Internet Explorer, disable Enhanced Security Configuration (ESC) using the 
Windows Server Manager. Enter the hostname or IP address into the address bar 
that is used to set up the HTTP alias. For example, if you use a hostname to set up 
the alias, then you use that hostname to browse to the web apps. If you use an IP 
address, you should use that address to browse to them. For example, http://
192.168.0.1/Vantage/Portal/ConfigSelect.aspx. The use of localhost is not supported.

3. When using the Workflow Portal Web Application on a Windows Server platform, 
you must install the Desktop Experience feature in order to view proxy media in the 
HTML5 Media Player.

Web App Home Page—Launching Web Apps
You use the Vantage web app home page (launchpad/dashboard) for accessing 
Vantage web apps. 

■ Starting Web Applications

■ Licensing Issues When Starting Workflow Portal

■ Stopping Web Applications

User authentication may be used to control user access to Workflow Portal 
configurations. Administrators can choose which Vantage users can utilize a specific 
configuration. Administrators can also make certain configurations available to 
everyone. (These functions are performed in the Vantage Management Console.)

Starting Web Applications
Logging in to a Vantage domain from a web application is a bit different than logging 
in from a Vantage Windows client, such as Workflow Designer. When you log in from a 
web application, you first start the web application by accessing the web server via a 
browser. Then, you actually log in to the Vantage domain after that.

To start Vantage web applications from the Vantage web app home page, do the 
following:
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1. Open your web browser and enter the Vantage web application home page URL:

http://<IISServerName>/Vantage/

where <IISServerName> is the DNS name of the IIS server (or its IP address)—by 
default, the same as the Vantage domain server.

Note: If you do not know the name of the Vantage IIS server (by default, the same 
server where the Vantage domain database is hosted), contact your Vantage 
administrator or IT department.

2. If you are prompted to select a domain, select the domain name, and click OK.

The first time you connect to a Vantage domain from this computer (or you deleted 
your browser’s cookies), select the domain from the list and click OK to continue. 
Refer to Logging In or Changing Domains from Web Applications for more informa-
tion.

3. Enter your authorized Vantage user name and password.

Vantage displays the Vantage web app home page. 

Listed apps vary depending on your domain settings and licenses. Click the web 
application you want to use. 

You can also launch each web application directly, by using its URL:

• Dashboard—http://<ServerName>/Vantage/Dashboard/

• Job Status Views—http://<ServerName>/Vantage/JobStatusViewer/

• Workflow Portal—http://<ServerName>/Vantage/Portal/

• Dublist Portal—http://<ServerName>/Vantage/DublistPortal/

• Live Capture—http://<ServerName>/Vantage/CapturePortal/
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• Tape Capture—http://<ServerName>/Vantage/TapeCapture/capture/

• Settings—http://<ServerName>/Vantage/Administration/Settings.aspx

• External Links—http://<ServerName>/Vantage/ExternalLinks/ExternalLinks.aspx

Licensing Issues When Starting Workflow Portal
Workflow Portal is an optional, licensed web application. When you start it, if no license 
is available, it advises you, and operates in demo mode. When operating in demo 
mode, you cannot submit jobs or edit metadata labels.

You can also run multiple instances of Workflow Portal on a single computer, so that 
you can use more than one configuration at a time—and each running instance 
requires its own Workflow Portal license. For example, you may be reviewing and 
submitting assets in one configuration, and setting trim points in another.

Stopping Web Applications
To stop a web app, close the browser or the web page tab, or change web sites.

Logging In or Changing Domains from Web Applications
When you start a web application, you may need to complete additional tasks before 
you can begin working. If additional tasks are required, Vantage will prompt you to 
complete those tasks, which are described in the following topics:

■ Selecting the Domain

■ Logging In

Selecting the Domain
Each Vantage domain is a separate, independent Vantage system. As a Vantage user, 
you might need to select a domain for the following reasons:

• You are starting a web application for the first time on a given computer.

• Your work requires that you connect to a different Vantage domain.

After you log in to a Vantage domain, the web app remembers it and connects 
automatically each time you restart the program. You can change domains at any time.

To select a domain, do the following:
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1. In any web app where you want to change Vantage domains, select Change 
Domain in the application title panel.

The web application displays the Select Vantage Domain dialog.

2. To select a listed domain, select a domain in the domain list, and click OK.

When you change domains, your web application closes its connection and con-
nects to the new domain.

If your domain is not listed, or your connection attempt is unsuccessful, contact your 
Vantage domain administrator and refer to the following topics:

■ Connecting to an Unlisted Domain

■ To connect using custom login settings:

Connecting to an Unlisted Domain

If the domain you want to connect to is not in the list, click Advanced. To connect to an 
unlisted domain, do the following:

To connect to an unlisted domain, do the following:

1. In the Select Vantage Domain dialog, click Advanced.

Vantage 
domains on 
your network.
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2. If the domain is not in the list, click My Vantage Domain is not Listed to display the 
Vantage domain server Name/IP field:

3. Enter) the domain database server’s computer name (for example, 
VantageServer203) or its IP address and click OK to connect.

4. Specify the name of the Vantage database instance, if different than the default 
VANTAGE instance.
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Connecting with Custom Login Settings

If the Vantage domain is installed on a SQL database where the default settings for the 
MS SQL server account were changed during installation, open Connection Settings to 
display the SQL Server login and password settings.

Select Use Custom Credentials, enter the Vantage database SQL server account user 
name and password (see your Vantage administrator), and click OK to connect.

Bypassing Database Login

To keep database credentials secure and simplify operator login, an administrator can 
configure operator accounts to automatically log into the database without showing 
the login and password. To configure this option, log in as an administrator, select 
Settings, check (enable) Preconfigure Vantage Database, and click Save. 
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Logging In
If you are accessing a Vantage domain for which user login is required, Vantage displays 
the Vantage Login dialog shown in this figure:

Note: If you do not have an authorized user name, contact your Vantage domain 
administrator.

To log in to the Vantage domain, do the following:

1. Enter your Vantage user name and password (if required) or use your Active 
Directory user name and password and click OK to connect. Your Vantage 
administrator will either give you a user name, or instruct you to use your Windows 
user name.

2. If you are prompted to select a domain, select the domain name, and click OK.

The first time you connect to a Vantage domain from this computer (or after you 
delete browser cookies), select a domain from the list, and click OK to continue. 
Refer to Logging In or Changing Domains from Web Applications for more informa-
tion.

3. Enter the user name and password assigned by your Vantage Administrator, then 
click Log In.

Note: The default user name is Administrator without a password.

4. Check Remember me next time to store the authentication token in a persistent 
cookie in the browser. This keeps you authenticated if you close your browser and 
reopen it again.

When you enter the Vantage web app home page’s URL, Vantage displays the Vantage 
web app home page (see the figure following), so you can select any Vantage web 
application. Otherwise, your web application displays.

Returning to the Vantage Web App Home Page
To return to the web app home page, click the title panel’s Home button. Note that the 
home page apps vary depending on your domain’s configuration.
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If the title panel is hidden, click the show/hide control.

Logging Out of a Vantage Domain
If you are viewing information that is sensitive, or viewing an operational application 
(vs. a view-only application), you might want to log out when you leave your computer 
on and unattended. You must log out when you want to change domains.

To log out of any web application, click Logout in the title panel.

Changing Vantage Users in Web Applications
When you are logged in to a Vantage domain and User Administration is enabled (in 
the Vantage Management Console), you can change user names. To log in with a 
different user, do the following: 

1. Select Log Out (upper right corner) to display the Domain Login dialog (in this 
figure, it depicts logging into the Dashboard as a sample).

2. Enter your user name, and password if required, and click OK to log in.
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Changing Passwords in Web Applications
If you are logged in using a Vantage user name (not a Windows user name), you can 
change your password. Do the following: 

1. Click Change Password (upper right corner) to display the Set Password dialog.

2. Enter your new password, confirm the password, and click OK to change it.

The next time you log in to the Vantage domain, use your new password.

Displaying Version Information
To display version information in a web application, click About in the Help menu.

Accessing Vantage Help in Web Applications
The Help menu in the web applications is at the bottom of the left, command column.

These menu items provide access to the following information and documents:

Version 
Information
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• About—Displays the web application’s version number.

• User Guide—Displays the Vantage User Guide (this guide) in PDF format. The PDF 
version contains bookmarks, and you can use the PDF search option to search for 
one or all occurrences of a term. This is also the best format for printing.l

• Web Help—Displays the Vantage User Guide (this guide) in HTML format. Web Help 
features include Contents, Index, Search, and Favorites pages. You can use Favorites 
to save links, so that you can quickly display an important topic.

To open the User Guide PDF or the web library, do the following:

1. Locate the Help menu in the left panel of the web application.

2. If no entries display under Help, click the control to the right to display the list.

3. To open the PDF version of this guide, click User Guide.

4. To open the web library, click Web Help.

You can also view help directly on the home page (applications that display depend on 
the licenses you own—Dublist Manager, for example).

For each application, you can click on the User Guide, or click Web Help for the specific 
application you’re interested in.
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Paths for Vantage Storage Overview
Vantage stores are named locations for temporary files. They are used in Vantage to 
conveniently store and access working media and attachment files, and to write media 
and other output files. Many Vantage services require access to files; Windows clients 
such as Workflow Portal also read and write files. These programs (both Windows 
programs and services) may run on one computer. Usually, however, they are 
distributed on many computers in a Vantage array. In distributed Vantage arrays, file 
access must be managed to ensure that the all programs can function correctly.

Vantage stores can be specified on Windows computer using the following forms:

• UNC paths (shares): \\ComputerName\Sharename

• Drive-letters: C:\folder\folder

If all Vantage services, clients, Vantage stores and folders are on the same server (an All-
in-one domain), you can use either form. However, Telestream recommends that you 
always use the UNC path form to reduce file access problems. It is a requirement when 
you are operating in a Vantage array.

Drive-letter paths are defined in the context of a local computer; it does not identify the 
computer that hosts the drive. This prevents them from being useful in arrays. For 
example, if you specify a Vantage store on drive C using a drive letter, and a Workflow 
Portal operator on a different computer tries to view files in that store, Workflow Portal 
will search for files on drive C on the operator’s computer, not the Vantage server.

In another example, you create a workflow in Workflow Designer installed on Computer 
A. It has a Watch action, which is executed by a Vantage Monitor Service running on 
Computer B. You specify a hot folder (or watched folder) on drive C on Computer A, 
where Workflow Designer is installed. When the service executes the Watch action, it 
attempts to locate the hot folder on Computer B’s C drive, which does not exist.

When any Vantage service or client program needs to access and use Vantage storage 
or a directory on a different computer, you must specify the path using the UNC form. 
When services or clients will access Vantage storage from another computer, the 
Vantage storage location or directory must be published as a share, and access must be 
granted to the appropriate Windows users. For more information, see Windows 
Authentication Guidelines in the Vantage Domain Management Guide.

When you want to use a SAN system, be aware that some SAN systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. You can utilize SAN drives via a letter drive reference, provided that each 
Vantage server is a client of the SAN and that all mount points use the same letter.

Note: If you are creating a store to hold proxy files viewed in Workflow Portal, be sure 
to reference the store with a UNC path. Some SAN clients do not allow frame-accurate 
representation of proxies when using shared drives.
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Designing and Managing 
Workflows

Vantage Workflow Designer is the primary client program in Vantage: you use it to 
design and configure workflows to meet your media transcoding requirements. 
Workflow Designer combines a wide range of workflow design and media processing 
capabilities into a single program, enabling you to create, construct, and configure 
workflows to automate media processing tasks in your organization.

Workflow Designer also allows you to activate and deactivate workflows, submit media 
for processing, and monitor the jobs that are created as workflows process the media.

EDNOTE: 

Topics
■ Understanding the Types of Vantage Workflows

■ Starting Workflow Designer

■ Workflows Overview

■ Using the Workflow Design Workspace

■ Managing Workflows

■ Constructing Workflows

■ Configuring Actions

■ Specifying Action Settings

■ Implementing Processing Logic in Workflows

■ Managing Vantage Folders

■ Using Open Workflows

■ Processing Cloud-based Media in Workflows

■ Troubleshooting Workflow Designer
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Understanding the Types of Vantage Workflows
Vantage supports four types of workflows, all of which are created and configured in 
Workflow Designer. Workflows that execute completely or partially in Telestream Cloud 
require a Telestream Cloud account.

Note: The different types of workflows that you can create are not formally typed in 
Vantage. After importing a workflow into Telestream Cloud however, hosted 
workflows are actually referred to as hosted.

Two types of workflows may be utilized with or without Vantage Cloud mode enabled:

• On-Premises Workflows—are hosted in an on-premises Vantage domain, and do 
not include Cloud actions. These workflows may include cloud-capable actions 
with Vantage Cloud mode disabled, and all actions are executed by on-premises 
services. 

Jobs are submitted to on-premises workflows, via Workflow Designer, or a Vantage 
API-based client program.

• Telestream Cloud Workflows—are also hosted in a Vantage domain, but include 
the Cloud Qualify action | Cloud Speech action | Location action, which execute 
projects implemented directly in Telestream Cloud. 

Jobs are submitted to Telestream Cloud workflows on-premises, via Workflow 
Designer, or a Vantage API-based client program, though Cloud action execution 
occurs exclusively in Telestream Cloud.

When you enable Vantage Cloud mode, the scope of Vantage expands to Telestream 
Cloud, and these two types workflows may also be utilized:

• Hybrid Workflows—are hosted directly in an on-premises Vantage domain. In 
addition to Vantage actions that only execute on-premises these workflows include 
cloud-capable actions, which may execute in Telestream Cloud when in Vantage 
Cloud mode.

• Hosted Workflows—are workflows that have been exported to Telestream Cloud 
after being designed in Workflow Designer. They are capable of executing directly 
in the Vantage domain as well, and are not referred to as hosted in the context of 
Vantage. They are managed in the Telestream Cloud console after deployment in 
Telestream Cloud. 

Jobs to hosted workflows are either submitted via the Telestream Cloud’s Vantage 
Cloud console or a Telestream Cloud API-based client program, and all action exe-
cution occurs exclusively in Telestream Cloud.

Note: For information about Vantage Cloud features and utilization, please refer to 
the Vantage Cloud User’s Guide, available on the Telestream web site.

https://telestream.net
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Starting Workflow Designer
To start Workflow Designer, do one of the following:

• Double-click its shortcut on your desktop

• Click Start > All Programs > Telestream > Vantage > Workflow Designer.

Next, select a domain and log in.

Note: For basic information on starting/stopping Workflow Designer, and changing 
domains and user names and passwords, see Vantage Client Programs Overview and 
Windows Vantage Client Program Management. For a comprehensive view of all of the 
actions that you can use to build workflows in Workflow Designer, see Vantage Actions.
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Workflows Overview
A workflow in Vantage is a set of connected actions (each of which performs a specific 
task). Vantage provides over four dozen different actions, which you use as the building 
blocks of workflows. Workflows can be designed and configured to perform a 
controlled, automated media processing application. Workflow Designer organizes its 
actions by category (and incidentally, by the service which executes them), for ease of 
use. While most workflows center around the process of decoding and encoding video, 
you can also construct workflows that—while still media-centric—don’t flip media. 
Instead, they might process metadata files, or perform other tasks.

These topics provide information about workflows you’ll find helpful before starting 
the construction and configuration process.

■ Workflow Basics

■ Workflow Design & Configuration Overview

Workflow Basics
You construct and configure workflows in Workflow Designer using the Workflow 
Design workspace, by adding various types of actions (Watch action, Flip action, Copy 
action, etc.) and connecting them together to form a logical chain of successive tasks. 
Workflows are stored in the Vantage domain database, and actions in the workflow are 
executed by Vantage services.

A valid workflow must start with an origin action (for example, a Watch action or 
Workorder action—those actions in the Monitor category, plus the Receive action). For 
the Asset Monitor action and the Capture action, no additional actions are required for 
a complete workflow. For other origin actions, an additional connected action is 
required to complete the workflow.

Note: As mentioned above, the Capture action can be the single action in a workflow. 
This action enables SDI live streaming capture on a Live Capture server.

Workflows may have more than one origin action, but each origin action will function 
independently of the others. Multiple origin actions permit different methods (or 
locations) in which to submit jobs to the same workflow.

Workflows are not required to end with a terminating action—an action without an 
output pin. The only formal terminating action is the Forward action. The Forward 
action permits you to pass control directly from one workflow to another workflow, 
which must have a corresponding Receive origin action. This enables you to create 
simpler, general purpose workflows, and chain them together to provide more 
automation.
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Workflows are executed by jobs, which are created whenever a new file is discovered by 
the workflow’s Watch (or other origin) action, or when you submit a job manually 
(Manually Submitting Files Directly in Workflow Designer).

Generally, you construct a workflow in stages: first, conceptualize and design the 
workflow and then add the actions, connecting them together to control execution. 
Finally, you configure each action in the workflow to perform exactly the way you want. 
Now, you can test your workflow, and fine tune it as necessary. 

Once you have constructed and configured a workflow, you click Activate so it can be 
utilized. To edit it again—or just disable it—you just deactivate it. Then, click Edit, and 
when you’re done, you click Release. When you are editing a workflow, others using 
Workflow Designer can view—but not edit—the workflow. These buttons are all 
displayed at the bottom of the main window.

To activate, deactivate, edit, or release multiple workflows at one time, see Performing 
Batch Workflow Operations.
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Workflow Design & Configuration Overview
Before constructing a workflow, it is helpful to have a solid understanding of its 
objective or application—what you want to accomplish with it. You’ll have to 
determine what actions (tasks or steps) are necessary to implement the objective; 
where the media (and optionally, metadata and associated files) originate; what 
transcoding and metadata processing is required; where any new copies of media, 
metadata, and associated files should be stored or deployed, etc.

You should also know in advance what external systems these jobs will interact with (if 
any), and whether you want to register and track the output files and metadata related 
to each job in a Vantage catalog for future use; for example, a second workflow. 

Armed with these details, you can construct the workflow, and configure each action to 
correctly perform its assigned task. Of course, if you don't have all this information at 
the start, you can configure the workflow later. 

Once you have tested a workflow, you have to click Activate so it can be utilized. To edit 
it again—or just disable it—you just deactivate it. Then, click Edit, and when you’re 
done, you click Release. These buttons are all displayed at the bottom of the main 
window.
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Using the Workflow Design Workspace
This topic provides general information about using the Workflow Design workspace.

■ Design Panel Overview

■ Viewing and Specifying Workflow Details

■ Displaying Nicknames, Variables, Run On Rules, & Perform On Settings

■ Displaying Action Summary Information

■ Showing and Hiding Grid Lines

■ Using Annotations on Actions

■ Moving the Workflow Around in the Design Space

■ Centering a Workflow

■ Zooming In and Out on a Workflow

■ Scrolling Large Workflows with the Navigation Map

■ Automatically Arranging Workflow Actions

■ Automatically Validating Workflows

■ Action Toolbar Display Options

■ Using Context Menus in the Workflows Panel

■ Controlling Workflow Status
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Design Panel Overview
You use the Workflow Design workspace (click the tab or select File > Workflow Design) 
to view, construct, and configure workflows, and activate workflows for job processing. 

The figure below illustrates the layout and main components of the Workflows panel.

At the top of the Workflow Design workspace is the actions toolbar, categorized in 
groups by action type. To sort them, right-click in the toolbar and select Sort by Name 
or Sort by Behavior.

Click the arrow to open each action group and display the set of actions in this group.

Zoom control

Workflows panel—displays 
workflows by category.

Use the Workflow Design workspace to 
construct and configure workflows.

Actions toolbar: 
Open services 
and drag 
actions onto 
the workspace 
to create 
workflows.

Zoom control

Nicknames | 
Variables | 
Run On 
Rules View

Workspaces 
(tabs) for 
each task.
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Viewing and Specifying Workflow Details
To display or hide the selected workflow’s details panel, do one of the following:

• Select File > Workflow Details Panel 

• Click in the Workflow Design panel’s title bar

This panel displays details and statistics about the workflow and its variables, plus 
settings you can configure:

■ Configuring General Workflow Settings

■ Enabling Automatic Job Reports

■ Viewing Expected Variables
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Configuring General Workflow Settings
Use the following controls to manage workflow information and settings:

• Name—Edit the workflow name.

• Description—Edit an optional description for the workflow.

• Expiration—Modify to configure the job and binder expiration time.

• Options—Check to enable open workflow mode, when enabled in the domain.

Click Apply to save your changes. Click Close to hide the workflow details panel.

Details that display directly below the Apply button include creation and modification 
dates, the current owner (which client is working with the workflow) and the workflow’s 
GUID in the database, along with basic job statistics.

Note: For SDK submission, you can select the GUID and then copy and paste it into 
other applications as required.

Enabling Automatic Job Reports
You can configure a workflow to automatically generate a job report each time the 
workflow processes media. Each time a job is processed through the workflow, a new 
job row is automatically added to the specified report file(s).

Note: You can also manually generate a job report on any job in your job history (see 
Generating Job Reports Manually).

Job reports are based on a job report configuration created in Workflow Designer or 
the Vantage Management Console (see Managing Job Report Configurations).

To add an automatic job report for this workflow, do the following:

1. In the Workflow Details area (drop-down menu above the workflow), click Modify 
to display the Automatic Reports dialog.

2. Click the New Report button  in the toolbar.

3. Select the job report configuration you want to use from the Report menu. (Click 
the Browse button to display the Job Report Manager to create a new report 
configuration or edit an existing one (see Managing Job Report Configurations).

4. Browse or enter a Location where the job report file should be created or updated.

5. Optionally, click Filename Pattern to edit the pattern used to generate a name for 
the saved report files.

6. Check Enable to allow this report to be automatically generated for each job that 
you run using this workflow.

7. Click OK to save the automatic report.

To delete a report, select the report and click the red delete  button.

To duplicate a report as the basis for a new report, click the duplicate  button.
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Viewing Expected Variables
The Expected Variables table displays a list of variables that are being utilized by 
actions in this workflow and are not generated by upstream actions in the workflow 
itself. If a variable is utilized but not supplied—the setting in an action is bound to a 
variable—it displays here, along with its description, type, and default value.

The Expected Variables table can be used to determine which variables must be 
provided to the workflow from another workflow, a workorder, added to an upstream 
action; from Workflow Portal, or from a third party program using the Vantage API.

The Default Value column displays the current (static) default value for this variable. The 
value may change during the course of workflow execution.

Note: Variables that have been added to a workflow—whether they are utilized by 
any action in the workflow or not—are not displayed in this table.

To determine which actions use a given variable, right-click on the target variable and 
select Highlight Actions. Workflow Designer displays the Workflow Design tab and 
temporarily highlights each action where the target variable is used. Continue working 
to cancel the highlighting. You can highlight the actions that use a specific variable in 
other ways, too. See Identifying Actions that use a Specific Variable.

Displaying Nicknames, Variables, Run On Rules, & Perform 
On Settings

These settings are displayed directly on the face of each action, when the workflow is 
displayed in detailed action view. To enable/disable detailed action view, use these 
methods:

• Right-click in the workflow design workspace and select Detailed Action View in 
the context menu

• Choose View > Detailed Action View

• Press Ctrl+D as a shortcut.

When detailed action view is enabled, in the Workflow Design tab or either Job Status 
tab, a Detailed Action View options menu displays in the bottom right corner. Use it to 
choose what information to display directly on the actions:

• The nicknames of media files, attachments, and metadata labels that are available 
to the action

• Variables that are utilized in the action

• Run On rules that have been applied to the action (automatically or manually).

• Perform On rules that determine if an action should execute, based on post-execu-
tion state: Success, Failure, Ignore, or any of these states.
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Right-click in the workflow design workspace to select Detailed Action View in the 
context menu or press Ctrl+D in any of these tabs to toggle it on and off.

Nickname View
To display nicknames, select View > Action Details > Nicknames or select Nicknames 
from the menu in the bottom right corner of the Workflow Design panel. In Nicknames 
view, each action displays a list of file nicknames and metadata labels (in italics), plus 
attachments, that are available to the action before it executes (on the left), and those 
that are emitted by the action and available downstream when the action completes 
(on the right).

Nicknames (and labels) that are too long to display in the action display an ellipses (...). 
To view the full nickname, hover over it on the action.

Nicknames/labels displayed in bold indicate that they are utilized in that action; as 
input files on the left or output on the right. Nicknames in italic are not used, either as 
input or output, as indicated. Nicknames that are not used, either as input or output, 
are not displayed, although they are passed through.

In the example above, the Original nickname in the IPTV Flip action has been specified 
as an input file and is passed out. Likewise, the TIFO file has been specified as an output 
file in the IPTV Flip action. In Copy, Original is not used, but TIFO is specified as an input 
file. Original and TIFO are simply passed out, but TIFOTOO is specified as the output file.

Items on an action change color based upon the validity of the workflow. 

“Technology preview” actions display the action name in yellow. A technology preview 
is essentially a beta version that you can test and use, but it is not yet released.

Nicknames displayed in red represent an error.

Note: Nicknames and labels that are used or affected by the action are highlighted. 
Nicknames and labels also change color indicating whether or not the workflow is 
valid.

For example, if you configure an action to utilize nickname Copy7 provided by an earlier 
action and then delete the action that created Copy7, then Copy7 displays in red on the 
now-invalid action.

Input 
nicknames

Output 
nicknames
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Variables View
To display variables used in this action, select View > Action Details > Variables or select 
Variables from the menu in the bottom right corner of the Workflow Design panel. 
Unlike nicknames that are always displayed when available, variables are not displayed 
if they are not utilized directly in the target action. When Variables View is enabled, you 
can click on any variable and select Highlight Actions to see which variables use it in 
the entire workflow.

Variables that are too long to display are truncated, ending with an ellipsis (...). To view 
the full name of the variable, hover over it on the action.

Variables displayed in bold indicate that they are utilized in that action as input files on 
the left or output on the right. Variables in yellow indicate variables added using Add 
Variables in the action context menu. The yellow highlighting makes these added 
variables easier to recognize when modifying workflows. 

Run On Rules View
To display run on rules used in this action, select View > Action Details > Run On Rules 
or select Run On Rules from the menu in the bottom right corner of the Workflow 
Design panel. 

Perform On View
To display the Perform On selection in each action, select View Perform On or choose 
Perform On from the menu in the bottom right corner of the Workflow Design panel. 
The Perform On selection is made by right-clicking an action and selecting a Perform 
On state in the context menu (see Setting Conditional Action Execution for details). 



Designing and Managing Workflows
Using the Workflow Design Workspace

60

Displaying Action Summary Information
To display action summary data, hover over the Inspector button as shown here: 

As you hover over the icon, a popup displays. It includes the action type, description 
(editable), and a high level description of how the action is configured.

Showing and Hiding Grid Lines
Workflow Designer provides an optional, visual grid of horizontal and vertical lines, 
which you can use to help you align and organize your workflow visually. 

To toggle the grid lines on and off, do one of the following:

• Select View > Show Grid Lines (Ctrl+G).

• Right-click in the workspace (but not on an action) and choose Show Grid Lines.

Using Annotations on Actions
You can add annotations to any action, to describe or document your workflow more 
comprehensively. You can display or hide these annotations dynamically. In addition to 
annotations, each action provides a brief comment field (see Creating a New Workflow). 

Displaying and Hiding Annotations
To toggle annotations on and off, do one of the following:

• Select View > Show Action Annotations (Ctrl+O).

• Right-click in the workspace (but not directly on an action within the workspace) 
and choose Show Action Annotations.

Inspector 
button
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Adding and Editing Annotations
To add an annotation, right-click the action and choose Annotation. (You must be in 
edit mode in order to add annotations or make other changes to an action’s 
configuration.) In the Action Annotation dialog, enter your descriptive text, up to 512 
characters and click OK.this is

To edit an existing annotation, perform the same task—right-click the action and select 
Annotation. Edit the text and click OK.

Deleting an Annotation
To delete an annotation, right-click the action, choose Annotation and click Clear. Then, 
click OK.

Moving the Workflow Around in the Design Space
A workflow with lots of actions may be larger than your workspace when viewed at the 
zoom level you’re using. 

To move the workflow around in the workspace, click and hold anywhere on the design 
area other than directly on an action. The cursor displays as a compass: you can drag 
the workflow in the appropriate direction, and release it when done.
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Centering a Workflow
To center a workflow in your workspace, do one of the following:

• Right-click in the workspace and select Recenter Diagram (Ctrl+R)

• Select View > Recenter Diagram to center the workflow in the work area.

Note: When the Unable to Activate Workflow error message displays because of an 
incorrectly configured action, after you dismiss the message, the Workflow Designer 
automatically centers and selects the offending action in the workspace.

Zooming In and Out on a Workflow
You can zoom the design space based on the current position of actions, or you can 
select an action and center the design space on that action as you zoom.

Zooming In—To zoom in on a workflow so you can better view details, do one of these 
actions:

• Drag the zoom slider bar to the right

• Select an action, press Shift, and drag the zoom slider bar to the right to zoom in 
directly on the selected action

• Select View > Zoom In

• Repeatedly press Ctrl++ (the Plus key)

• Press Control and roll the mouse scroll wheel up (forward)

Zooming Out—To zoom out on a workflow so you can see more actions, do one of these 
actions:

• Drag the zoom slider bar to the left

• Select an action, press Shift, and drag the zoom slider bar to the left to zoom out on 
the selected action

• Select View > Zoom Out

• Repeatedly press Ctrl+- (the Minus key)

• Press Control and move the mouse scroll wheel down (reverse)

Zoom in or out to get a better view 
of your workflow and actions.
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Scrolling Large Workflows with the Navigation Map
The navigation map feature makes viewing and scrolling around large workflows easier 
by showing you where you are in the workflow. To enable this feature, pull down the 
View menu or right-click the context menu, and select Show Navigation Map. 

The navigation map appears in the lower left corner of the Workflow Designer view or 
the Job Status view. The area surrounded by a white box is the area in view, and you can 
click and drag the white box to scroll the view to another part of the workflow.

To turn off the navigation map, uncheck Show Navigation Map in the View or context 
menu.

Automatically Arranging Workflow Actions
Use the Auto Arrange feature to assist you in visually optimizing and organizing the 
layout of actions in your workflow.

Enable or disable Auto Arrange 
to suit your construction style.
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To disable automatic arrangement of actions while you're adjusting actions in a 
workflow, click the Auto Arrange button, located at the bottom of the Workflow Design 
workspace, to toggle it off. While Auto Arrange is off, the Auto Arrange button displays 
Auto Arrange SUSPENDED in yellow. 

Click the button again to toggle auto arrangement back into effect.

Identifying Actions that use a Specific Variable
To identify actions in a workflow that utilize a specific variable, use these methods:

• From the workflow context menu, select Variables in Use to display the Variables In 
Use dialog. Select the variable you're investigating and click Highlight Actions. 
Workflow Designer closes the dialog and temporarily highlights in yellow the 
actions in this workflow that use the variable. 

• Select View > Action Details > Variables to display the variables used in each action. 
Next, right-click on the target variable in an action and select Highlight Actions. 
Workflow Designer displays the Workflow Design tab and temporarily highlights 
each action in the workflow where the target variable is used.

• From the Expected Variables table in the workflow details panel, right-click on the 
target variable and select Highlight Actions. Workflow Designer displays the Work-
flow Design tab and temporarily highlights each action in the workflow where the 
target variable is used.

Continue working on your workflow to cancel highlighting.

Automatically Validating Workflows
By default, Workflow Designer monitors how actions are connected and organized in 
your workflow. Workflow Designer notifies you of problems, and prevents activation in 
the case of an improperly-organized or incorrectly configured workflow.

Disabling validation allows new actions to be connected or inserted in large workflows 
(those with about 30 or more actions) much faster. It also makes it faster to delete 
action connections.

To disable workflow validation, select Options > Auto Validate Workflow. Workflow 
Designer displays an orange status button at the bottom of the design space to remind 
you that validation is off.

When Auto Validate Workflow is disabled, validation is deferred until you open an 
action Inspector, activate the workflow, or switch workflows. In addition, an orange 
indicator displays at the bottom of the tab, which you can use to re-enable validation. 

When you create a workflow with 30 actions or more, Workflow Designer displays a tip 
to inform you about the Auto Validate capability.
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Action Toolbar Display Options
Use the context menu to display the Action toolbar to suit your preferences. Right-click 
anywhere in the toolbar to select a menu item.

Toolbar Display Size—To reduce the size of the Action toolbar at the top of the design 
area, select Icons only. To display the action names (making the toolbar a bit larger), 
select Icons and Text.

Action Group Display Order—To display the action groups in alphabetic order, select 
Sort By Name. To display the action groups by functionality and (generally) in order of 
utilization in a workflow, select Sort By Behavior.

Expand/Collapse Option—To open all action groups, select Expand All. To close all 
action groups, select Collapse All. 

Using Context Menus in the Workflows Panel
The Workflows panel’s context menu displays in three variations, depending on the 
item you click on: title bar, category, or workflow. Here’s an example:

Right-click in the Workflows panel to display the following context menus, depending 
on where you click:
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In the Title of the Panel

Click in the title bar (or the empty space below the list of categories) to use this edition 
of the context menu to:

• Change the Vantage domain

• Create a new workflow category or workflow

• Import individual workflows or categories of workflows

• Perform Batch Workflow Operations

• Open a workflow you’ve used recently 

• Expand and collapse all of the workflow categories.

On a Workflow Category

When you right-click on a category, you can use this edition of the context menu to:

• Create a new workflow

• Rename or delete the category

• Import or export workflows to or from the category

• Perform Batch Workflow Operations.

Caution: When you delete a workflow category, all workflows in this category 
are permanently removed from the Vantage domain’s database.

On a Workflow in the Workflows Panel List

Right-click directly on a workflow to use this context menu to:

• Change the status of the target workflow (Edit | Release | Lock)

• Activate or deactivate the workflow

• Rename, delete, move or duplicate the workflow

• Display the Details panel for more details about the workflow

• Print the workflow

• Export the workflow in XML format, typically for archiving or transfer to another 
domain

• Export as a Compiled Workflow Document (CWD) file, used to import into 
Telestream Cloud as a hosted workflow, for cloud execution

• Upgrade the workflow, if permitted.

• Manually submit a job if the workflow is activated.

For detailed explanations of all workflow operations, see Managing Workflows.
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Controlling Workflow Status
This topic describes the four workflow status commands and how and when to change 
a workflow’s status. You change the workflow status via menu items in the File menu or 
by using the buttons at the bottom of the main window.

Each status has a unique icon (or combination), as shown below, in the  table.

Note: With user administration enabled, only Vantage users with Administrator 
authority can lock workflows in an idle or active state to prevent unauthorized 
changes or deletion. To lock a workflow, select File > Lock Workflow or right-click on 
the workflow and select Lock. Workflow Designer displays a lock icon beside the 
workflow. Locked workflows can be activated and deactivated. However, they can’t be 
edited, updated, or deleted. When user administration is disabled, anyone can lock or 
unlock workflows.

Edit—Choose File > Edit Workflow or click the Edit button to modify the selected 
workflow. If the workflow is currently active (a Watch or Receive action is running and 
the workflow can process jobs), Vantage displays a warning dialog that it is about to 
deactivate the workflow. Click OK to continue. To edit or release multiple workflows at 
one time, see Performing Batch Workflow Operations.

The Actions toolbar displays at the top of the panel when in design mode, so that you 
can add new actions to the workflow.

When you are editing a workflow, other Workflow Designer users can view the 
workflow, but no one can edit, activate it or process jobs with it.

Release—When you’re done editing a workflow, select File > Release Workflow or click 
the Release button. Released workflows can be activated, and can also be edited by 
others. To edit or release multiple workflows at one time, see Performing Batch Workflow 
Operations.

Activate—Select File > Activate Workflow or click the Activate button on a deactivated 
workflow to start a Watch or Receive action so that jobs can be submitted and 
processed by this workflow. To activate or deactivate multiple workflows at one time, 
see Performing Batch Workflow Operations. To automatically display the Monitor Status 
tab when you active a workflow, choose Options > Switch to Monitor Status on 
Workflow Activation.
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Deactivate—Select File > Deactivate Workflow or click the Deactivate button to 
deactivate the workflow. New jobs cannot be submitted and media cannot be 
processed by the workflow in this status. Existing jobs using this workflow continue 
executing to completion. To activate or deactivate multiple workflows at one time, see 
Performing Batch Workflow Operations.

The table below shows the icon or icons associated with a given workflow status, and 
provides a general description.
 

Workflow State Icon Description

Idle Indicates that this workflow is not being 
edited, but it is not running either. To set the 
idle status, either click the Release button 
(when editing), or click the Deactivate button 
(when the workflow is active).

Editing Indicates that the workflow is being edited by 
you. To edit a workflow, click the Edit button. 
When you are editing a workflow, it cannot 
accept media and others cannot edit it.

Active Indicates that the workflow’s origin action is 
currently executing and the workflow will 
accept media and start jobs. When a workflow 
is active, it cannot be edited.

Editing by other user Indicates that the workflow is being edited 
(and thus, owned) by a different user. 

Locked The workflow has been locked. With user 
administration enabled, only users with 
Administrator authority can unlock it. Locked 
workflows can be activated and idled, but not 
edited, deleted, or updated.

Idle, locked The workflow has been idled. With user 
administration enabled, only users with 
Administrator authority can unlock it. Locked 
workflows can be activated and idled, but not 
edited, deleted, or updated.

Active, locked The workflow has been activated. With user 
administration enabled, only users with 
Administrator authority can unlock it. Locked 
workflows can be activated and idled, but not 
edited, deleted, or updated.
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Managing Workflows
This topic describes how to organize, add, rename, and delete workflows and 
categories, change their status, and perform batch operations and other workflow-
related operations.

Note: Whenever you are performing a workflow operation, you can select the 
workflow directly from the Workflow panel or select File > Recent Workflows, and 
select the workflow from the list.

■ Managing Workflow Categories

■ Creating a New Workflow

■ Renaming a Workflow

■ Deleting a Workflow

■ Moving Workflows Between Categories

■ Finding and Filtering Workflows and Categories

■ Duplicating a Workflow

■ Exporting Workflows for Archive or Transfer

■ Importing Workflows

■ Printing Workflows

■ Exporting Workflows for Telestream Cloud

■ Performing Batch Workflow Operations

■ Deploying Upgrades via Update Packs and ComponentPacs

■ Upgrading Actions After Installing a ComponentPac or Upgrading to a Newer Ver-
sion

Note: To set the status of a workflow, see Controlling Workflow Status.
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Managing Workflow Categories
Vantage provides workflow categories so that you can organize your workflows by 
categories that you design, and so that you can isolate and control workflows by 
Vantage user accounts (which is performed in the Management Console).

Note: Administrators can prevent Vantage specific users from seeing (and therefore 
using) workflows by category. To select workflow categories and specify which users 
have access to them, use the Vantage Management Console.

The following topics describe how to manage workflow categories:

■ Creating a Workflow Category

■ Renaming a Workflow Category

■ Deleting a Workflow Category

Creating a Workflow Category
Create categories to store related workflows together. 

Note: All workflows are stored in categories, so you must create at least one category 
before you can create a workflow.

To create a new category, do the following:

1. Select File > Create New Category, or right-click in the Workflows panel (left side of 
the main window) away from any categories or workflows, and select Create New 
Category to display the dialog of the same name:

2. Enter the name of the category you want to create, and click OK.

Workflow Designer creates the category in the database, and displays it in the 
Workflows panel.

Renaming a Workflow Category
To change the name of a category, right-click on the category name in the Workflows 
panel and select Rename. Workflow Designer makes the text editable so you can 
change it. Press Enter or just click away from the field when you’re done.
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Deleting a Workflow Category
To delete a category, right-click on the category name in the Workflows panel and 
select Delete. Workflow Designer displays a warning that you are about to delete the 
category and all workflows stored in this category. Click OK to delete the category and 
its workflows, if any.

Caution: This action deletes all workflows in the category, and cannot be 
undone.

Creating a New Workflow
To create a new workflow, do one of the following:

• Select File > Create New Workflow

• Press Ctrl+W

• Right-click in the Workflows panel (on the left side of the main window) away from 
any category or workflow and select Create New Workflow. 

Workflow Designer displays the Create New Workflow dialog:

Category—Select the category for this workflow from the list at the top.

Name and Description—Enter the name of the workflow you want to create and an 
optional description in the Name and Description fields.

Expiration—When checked, specifies (in hours) the time that elapses before job records 
for jobs processed by this workflow that complete on SUCCESS are deleted from the 
database. The time for expiration is based on the last updated time in the job record—
not the job submission time. Once the expiration period has elapsed, the jobs are 
subject to automatic deletion by the system.

Select the category where 
you want to save the 
workflow.

Enter the name of the new 
workflow and click OK.



Designing and Managing Workflows
Managing Workflows

72

Note: Job that don’t succeed are not controlled by this setting, and do not 
automatically expire. To expire FAILed jobs, in the Domain Management Console, 
check Settings & Options > General > Expire Failed Jobs. 

OK | Cancel—Click OK to create the new workflow. Workflow Designer creates the 
workflow in the database, adds it to the specified category, and displays it in the 
Workflow Design workspace in edit mode—that is, deactivated and editable.

Renaming a Workflow
To change the name of a workflow, right-click on the workflow name in the Workflows 
panel and select Rename. Workflow Designer makes the text editable so you can 
change it. Press Enter or just click away from the field when you’re done.

Note: You can only rename a workflow when it is in edit mode.

Deleting a Workflow
To delete a workflow, select File >Delete Workflow or right-click on the workflow name 
in the Workflows Panel and select Delete. Workflow Designer displays a warning that 
you are about to delete the workflow and all job history for this workflow. Click OK to 
delete the workflow and its history.

To delete multiple workflows at one time, see Performing Batch Workflow Operations.

Caution: This action deletes the workflow and its job history, and can’t be 
undone.

Moving Workflows Between Categories
To move a workflow from one category to another, select File > Move Workflow or 
right-click on the workflow and select Move. Workflow Designer displays a Category 
dialog. Select the category you want to move the workflow to, and click OK.

To move multiple workflows at one time, see Performing Batch Workflow Operations.
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Finding and Filtering Workflows and Categories
To find workflows or categories by name—or to filter them by some phrase or string—
click the Filter icon in the bottom left corner of the Workflows panel to display its 
controls:

Workflow Designer displays the controls:

For workflow filtering, select Workflows; select Categories to filter categories. Next, 
enter a phrase or string, or select a previously-entered string. Workflow Designer 
displays only those categories or workflows/categories that meet the filter criteria. 

Click the filter icon again to clear filtering and display all of the categories and 
workflows/categories in the domain.

Opening Read-Only Inspectors for Reference
You can open action Inspectors in read-only, or reference mode while you are 
configuring another action. This enables you to conveniently reference other action 
settings without closing the action you are working on. You can open reference 
inspectors from any workflow in the domain. 

Click the Filter icon to display/
hide the controls.

Use the Filter to display only 
workflows/categories with the 
specified phrase or string.
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To open a reference inspector, click the R button in the inspector’s title bar: 

Workflow Displays a Read Only Open dialog:

Navigate to the workflow containing the action you want to inspect and then scroll 
through the actions and choose the one you want to view and click OK.

Workflow Designer displays the action inspector in reference mode, as noted by the 
orange text at the top. When you close the action you’re working on, the reference 
action is closed as well.

Click the R button to 
open the action 
inspector of another 
action you want to 
review, in read-only 
mode.
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Duplicating a Workflow
To duplicate a workflow, select File > Duplicate Workflow or right-click on the workflow 
and select Duplicate. Workflow Designer displays a Category dialog. Select the 
category you want to create the new workflow in, enter a name, and click OK.

Exporting Workflows for Archive or Transfer
You can export workflows in XML format, typically for archiving or for transfer to 
another Vantage domain. When you export workflows, the following items are also 
exported, if they are used in the workflow:

• Media nicknames

• attachment nicknames

• Variables

• Metadata labels

• Stores

• Output folders

Exporting a Single Workflow—To export the selected workflow, select File > Export 
Workflow or right-click on the workflow and select Export Workflow. Workflow 
Designer displays a File System dialog. Navigate and select the location where you 
want to save the workflow XML file, and click Save. Workflow Designer exports the 
workflow as an XML file.

Exporting Workflows by Category—To export all workflows in a given category, select 
File > Export Workflows by Category. Workflow Designer displays a dialog with all 
categories listed. Check the ones you want to export, and click OK. In the File System 
dialog, navigate and select the location where you want to save the workflows. 
Optionally, create a new folder, and click OK. 

Workflow Designer creates a folder for each category in the domain, then exports each 
workflow in each category, as an XML file.

Importing Workflows
You can import workflows which have been previously exported (as XML files) from this 
or other domains.

You can import workflows into your domain that have the same name as another 
workflow in a different category. However, if you import a workflow into a category 
which already has a workflow with the same name, Vantage assigns the imported 
workflow an incremental copy number. You can’t have two workflows of the same 
name in the same category.

Importing a workflow can create a problem with duplicate variables: The variable 
already exists, but the imported variable has a different default value. When this 
happens, the original value remains intact.
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Note: You cannot import a workflow that includes any action whose service is not 
running in the domain.

To import workflows, use any of the following options:

■ Importing Workflows into a Category You Select

■ Importing Workflows by Category

■ Importing Workflows into a Specific Category

Importing Workflows into a Category You Select
Use this method when you want to select the workflow or workflows, and then select a 
category or create a new one:

1. Select File > Import Workflows.

Workflow Designer displays a File System dialog.

2. Navigate to the directory where the previously exported workflows are located.

3. Select one or more workflows and click Open.

Workflow Designer displays the Import Workflow Category dialog.

4. Select the category or check Use Folder Name to create a new category and click 
OK.

Workflow Designer imported the selected workflows into the category.

Importing Workflows by Category
Use this method when you want to import a category or categories of workflows (for 
example, when importing all workflows you’ve exported from another domain). The 
workflows you are import should be organized into folders, with the folder name being 
the name of the category you want to use or create.

To import workflows by category, follow these steps:

1. Select File > Import Workflows by Category.

Workflow Designer displays the File System dialog.

2. Navigate to the directory directly above the folders of exported workflows (where 
each folder is named the same as the workflow category) and click Select Folder.

Workflow Designer displays the Import Workflows by Category dialog.

3. Check each folder that you want to import the workflows from and click OK. 

If a category already exists in this domain, the workflows in that folder are 
imported. If the category does not exist, a category of the folder name will be cre-
ated, and the workflows imported.

Importing Workflows into a Specific Category
Use this method when you want to import selected workflows directly into a specific 
category:
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1. Right-click on the category title in the Workflows panel, and select Import 
Workflows.

2. Navigate to the directory where the previously exported workflows are located.

3. Select one or more workflows and click Open.

Workflow Designer imports the workflow into the selected category. You can now 
rename and edit the workflow as appropriate.

Note: When importing workflows that have been created and exported from another 
domain, you may end up with duplicate variables in your domain. For example, you 
might end up with two Agency variables. This is typically not a problem. However, to 
determine which workflows use a particular variable—so that you can correct them to 
use only one definition of it—go to the Management Console > Workflow Design 
Items > Variables. Select the variable you want to search workflows for, and click the 
Find Workflows Using this Variable button in the toolbar (5th from left).

Printing Workflows
Select File > Print Workflow to print the selected workflow using the current workflow 
settings. The workflow is scaled to fit on a single page (with landscape or portrait mode 
preset based on workflow shape), unless the workflow is sufficiently large to make it 
difficult to read when scaled to a single page. Then, Workflow Designer provides you 
the option of printing across multiple pages.

Exporting Workflows for Telestream Cloud
You can export workflows in Compiled Workflow Document (CWD) file format, so that 
you can import them into Telestream Cloud, where they can be managed and 
executed.

Note: For complete details on using hosted workflows and Vantage Cloud in general, 
read the Vantage Cloud User’s Guide.

To export a workflow for use in Telestream Cloud, follow these steps:

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-Cloud-Port-User-Guide.pdf
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After creating (or updating) your workflow and testing it for proper execution, choose 
File > Export Workflow for Cloud or right-click the workflow and choose Export for 
Cloud.

Workflow Designer automatically audits the workflow to determine if the actions and 
their configurations are supported for use as a hosted workflow. If it discovers an error, 
Workflow Designer displays an error message identifying the problem:

Fix the problem and retry.
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 When the workflow passes the hosted workflow audit and is validated for hosting and 
execution in Telestream Cloud, Workflow Designer displays a File Save dialog:

Browse to the local or network location you want the file exported to, name the file 
(with the CWD) extension and click Save.

Note: When the export is complete, your work in Vantage is complete. Log into your 
Telestream Cloud account to import the CWD file and prepare it for deployment and 
utilization in Telestream Cloud.
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Performing Batch Workflow Operations
You can use the Batch Workflow Operations window to operate on several workflows at 
once. For example, you can select multiple workflows and initiate these tasks: edit/
release, lock/unlock, activate/deactivate, delete, move, or upgrade actions. 

Secured Version Control allows you to upgrade workflows or lock workflows to prevent 
upgrades until you are ready.

Note: If your domain has User Administration enabled, this feature is enabled only by 
users with Administrator privileges.

To change the status of (or operate on) multiple workflows, do the following:

1. Select File > Batch Workflow Operations.

Workflow Designer displays the Batch Workflow Operations dialog, which displays 
every workflow in the domain.

2. Select one or more workflows (using Shift and Ctrl keys).

3. Click one of the buttons at the bottom of the dialog to perform the task. The 
function of each button is listed in the following table.

4. When you’re done, click Close.

Buttons Functions

Edit Enables editing of the selected, released workflows.

Release Releases the selected workflows to idle.

Lock/Unlock Locks (or unlocks) the workflows to prevent editing.
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Activate/Deactivate Starts (or stops) the workflows so that they can accept 
jobs.

Delete Deletes the selected workflows. 
CAUTION: When you click OK in the Continue? dialog, 
the workflow is permanently deleted.

Move Moves the selected workflows to another category. A 
Move Workflows dialog lets you select the category to 
move to. You can also use a Create New Category button 
to create a category and move the workflows into it.

Push Pushes the selected workflows to another Vantage 
domain to make it easier to disseminate new or changed 
workflows. Use Search in the Select Vantage Domain 
dialog to find the target domain, or specify a domain 
name or IP. Change Connection Settings if the database 
login or password is customized; otherwise, use the 
defaults. When ready, click OK to push the workflows. 

CAUTION: When you click OK, the workflows are 
immediately pushed to the specified domain, and 
overwrite any workflows having the same workflow ID.

Notes: 
1. Workflows in separate categories can be named the same.

2. A push overwrites the correct workflow (same ID), even 
if it is renamed or moved to another category.

3. See the Workflow Details Panel for the ID. The ID 
uniquely identifies a workflow.

Set Priority Specifies the priority for all origin actions in the selected 
workflows to ensure higher priority workflows execute 
first. Priorities can be changed only for workflows in Edit 
mode. Enter or select a number, and click OK. Higher 
numbers set a higher priority. 

Expiration When checked, specifies (in hours) the time that elapses 
before job records for jobs processed by this workflow that 
complete on SUCCESS are deleted from the database. The 
time for expiration is based on the last updated time in the 
job record—not the job submission time. Once the 
expiration period has elapsed, the jobs are subject to 
automatic deletion by the system

Check for Upgrades Checks the selected workflows for available upgrades. 
Click OK to perform the upgrade.

Close Click Close to close the Batch Workflow Operations dialog.

Buttons Functions
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Deploying Upgrades via Update Packs and ComponentPacs
Vantage can be upgraded in several ways:

• Major (X.0) and minor (X.1) new version releases replace previous versions. For 
example, you can install Vantage 8.0 to upgrade from Vantage 7.1 or 7.2.

• Update Packs are sometimes issued between releases. Update packs are added to 
your existing Vantage domain to provide small new features and fix bugs.

• ComponentPacs that are included in your Vantage domain define the operation of 
a particular Vantage service or action. Telestream may send out new Component-
Pacs at any time to fix or upgrade a specific Vantage service or action. 

Instructions for deploying upgrades of all types may be provided as manuals, 
application notes, or readme files included with the upgrade, and often they are also 
made available on the Telestream.net web site, or by calling Customer Support. These 
instructions tell you how to install the upgrade while preserving and migrating your 
existing workflows and other Vantage workflow components.

Upgrading Actions After Installing a ComponentPac or 
Upgrading to a Newer Version

During a Vantage upgrade (you are converting your domain to a newer version) or after 
installing a ComponentPac, some actions may have new or modified features—for 
example, a Flip64 action with an updated x265 encoder, or an Analyze action with a 
new filter. You can update the copies of these actions in your existing workflows as well, 
although you are not required to.

Actions implemented by the following Vantage services can be upgraded:

• Analyze

• Capture

• Edit

• Flip64

• IPTV Flip

• Multiscreen Flip

• Tape Capture

• Timed Text Flip

• Tempo

Actions with only changes to the action interface itself (a new check box, for example) 
upgrade automatically, when a new version is installed. When you open a workflow, 
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Workflow Designer, checks to make sure that the actions are current. If not, the action’s 
title displays in italics to indicate that you can upgrade it.

Note: In addition, you can hover over an action to display the tooltip, which indicates 
which ComponentPac version is being used.

Right-click the action and select Upgrade to upgrade it. Or, right-click outside of an 
action and select Upgrade to upgrade all upgradeable actions in the workflow. Then, 
open the Inspector and review your configuration, making changes as appropriate, 
based on the action’s new or changed controls.

The Upgrade menu item is hidden when there are no upgrades available (for any 
actions in the workflow). The Upgrade menu item is grayed out when upgrades are 
available, but can’t be performed now (for example, when the workflow is not editable).

To upgrade multiple workflows at one time, see Performing Batch Workflow Operations.

Note: Once an action is upgraded it can't be directly downgraded. However, you can 
restore workflows by importing the automatic backup copy that Vantage places in the 
C:\VantageWorkflowBackup directory (local to the Workflow Designer client). A log file 
describing the upgrades is also included in that directory.

Note: If you want to change the location of automatic ComponentPac backups, open 
the Vantage Management Console, select Settings and Options, and browse for a new 
Location for workflow backups.

Note: During service startup, if multiple ComponentPacs are present, the service uses 
the highest-versioned ComponentPac to populate the action template in the 
database. This process updates default action configurations and also ensures that 
newly created actions always use the latest ComponentPac. 

When the title is displayed 
in italic, right-click and 
select Upgrade.
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Constructing Workflows
The following topics describe the operations you’ll use to construct workflows, which is 
done by creating actions, arranging them in order of execution, and connecting them 
together. One operation—exporting an action—can only be performed on Flip actions. 
It is used in conjunction with implementing an SDK-based Vantage application.

Note: Before you can edit a workflow (work with actions or change configuration), it 
must be deactivated and editable. When you first create a new workflow, Workflow 
Designer places it in edit mode automatically.

■ Adding Actions

■ Controlling the Order of Action Execution

■ Deleting Actions

■ Removing Line Crossings

■ Re-ordering Actions

Adding Actions
There are several ways to add actions to a workflow, depending on the situation. 

New action—to add an action, open the appropriate category in the Actions toolbar 
and drag the desired action onto the design area. When you drag an action from the 
toolbar, it must be configured before you can use the workflow.

Action template—Vantage allows you to create templates from your configured actions 
so that repetitive action configurations can be saved and reused. For details, see 
Creating Action Templates.

To add an action template to a workflow, click on the action in the action group, select 
an action template from the list, and drag it onto the workflow. 

Copy and paste—to copy and paste actions in a workflow, first right-click the action you 
want to copy and select Copy. To select multiple actions, Ctrl+click and drag across the 
desired actions in the design work space.

Next, right-click on the design area, right-click and select Paste to add the copied action 
or actions to the workflow. 

To paste an action’s configuration into an action of the same type, right-click and select 
Paste—this configures the action identically with the copied action.
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Note: An origin action (Watch or Receive action) is required as the first action in a 
workflow, even if you plan to manually submit jobs to this workflow.

When you drag an action onto the design area, Vantage may automatically align it near 
where you dropped it (unless auto-arrange is off; see Automatically Arranging Workflow 
Actions). Until you connect an action to other actions, you can move it anywhere you 
want on the work area. If you bump the action you’re adding right next to an existing 
action, Workflow Designer will automatically connect the two.

Generally, it’s easiest to drag and drop actions in a pattern similar to the flow of the 
desired workflow, working from left to right (on each branch, if more than one). 
However, you can drag actions anywhere, and connect them as desired later.

Vantage will tidy up actions—moving them and organizing them by column. Once an 
action is connected, you can move it vertically (up or down) but it cannot be moved 
from its column. Alternatively, Vantage can also attempt to optimize the workflow, 
removing as many line crossings as possible. 

Controlling the Order of Action Execution
You connect actions together linearly in a workflow to control the order of execution 
relative to other actions in the same workflow, and to control the flow of variables and 
files from one action to another.

Job execution proceeds action by action, from left to right: When a workflow executes, 
the origin action (at the far left) executes first to start the job, and each action following 
the previous action executes next.

Connecting Your Actions Together
You connect actions together from the output pin (right-side) of one action to the input 
pin (left side) of the action you want to execute next in the workflow. 

Actions can only be connected from an output pin (on the right side of the action) to an 
input pin (on the left side of the action), and control (file or logic) flows from output to 
input—from left to right.

Here are ways you can connect actions together:

• Click and drag a connecting line from one connector pin to another

• Click and drag an action (either from the actions toolbar or one already in the work 
area) and bump it into the edge of the action you want to connect it to—until a 
pale blue vertical line displays. (You must drag your mouse pointer up to the edge 
of the action you’re connecting to).

• Copy an action, and right-click on a connector line and select Paste to add the cop-
ied action between the two actions. Or, drag an action onto a connector line until it 
displays as a larger line. Then, drop it to connect it between the two actions.

Certain connections are not permitted:
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• You cannot form recursive loops, by connecting actions to themselves or to the 
input of preceding actions in the workflow.

• You cannot connect one input (left) pin to another input pin, or one output pin 
(right) to another output pin.

Note: When you connect actions by clicking and dragging a connection, Workflow 
Designer can display a popup message that provides connection details. To enable or 
disable this feature, select Options > Show Connection Helper.

You can connect one action to multiple succeeding actions, creating logical branches, 
as shown in the figure following. When you do, none of the actions you connect can 
execute before the preceding action upon which they depend completes. 

When you have branches in a workflow, you can optionally, use a Synchronize action as 
a visual connector at either end of the branches, to better organize them. Synchronize 
does not perform any special task, it merely aids in design. In this example, three Copy 
actions execute in parallel after the Watch action completes.

These three Copy actions execute independently of each other, and their start time and 
completion time relative to each other is indeterminate. They execute in parallel from 
the perspective of the actions which precede and follow these actions.

You can also connect multiple actions (branches) back to a single succeeding action, as 
shown. When you do, each of the actions you connect must execute before any 
succeeding Common action can execute. In this example, all Copy actions must 
execute before the Message action executes.
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You can also create multiple, independent action branches—each branch starting with 
an origin action. Each origin action creates its own job. Although this is not generally 
recommended, you may have situations where it is the best solution.

In this example, two independent sets of actions are in this workflow. As each origin 
action detects new files to process, a separate job is initiated.

Note: Although this is a legitimate workflow, it is an unusual configuration. Typically, 
two completely independent processes would be better defined as two separate 
workflows.
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Deleting Actions
To delete an action, select it and press Delete or right-click the action and select Delete. 
When you delete an action, Workflow Designer connects the preceding and 
succeeding actions, unless you uncheck Fill connections after delete in the Delete 
confirmation dialog.

To select multiple actions, Ctrl+click each additional action or Ctrl+click and drag across 
them in the design work space. When the appropriate actions are selected, delete them 
using one of the following options:

• Press Delete.

• Right-click one of the selected actions, and select Delete.

Removing Line Crossings
On occasion, you might connect two actions on rows in the layout that are more than 
one row apart—resulting in an unintended line crossing. To manually optimize the 
workflow layout, select View > Remove Line Crossings or right-click and select Remove 
Line Crossings. Workflow Designer reformats the workflow and optimizes the layout of 
the actions in a grid.

Re-ordering Actions
To re-order actions vertically, drag one or more of the actions up or down in the design 
area to the location where you want it. To select multiple actions, Ctrl+click each 
additional action or Ctrl+click and drag across them in the design work space. 
Workflow Designer adjusts the other actions to accommodate the manual placement 
of the other action.
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Configuring Actions
Each action (except the Synchronize action, which is simply a common connecting 
point for branches in a workflow, with no user configuration) has an action Inspector 
for setting up the action to perform in a particular way in this workflow. 

Most action Inspectors use the Wizard model; a series of one or more panels, with 
standard Previous, Next, Finish, and Save buttons. 

The Flip action is unique in its design because of its unique, transcode-centric 
functionality. 

The remaining media processing action inspectors—specifically, the Flip64 action, and 
other Telestream Media Framework-based transcoding actions such as the Multiscreen 
action—display the entire inspector in a single, multi-paneled window.

The panel’s organization and the layout of building blocks is pretty simple. The different 
controls in editor panels is insignificant. What matters is that you use the panels to 
select inputs, encoders, and outputs and configure filters, select nicknames, and make 
other selections specific to the formats you've chosen. 

■ Displaying the Action Inspector

■ Using the Flip Action Inspector

■ Using the Telestream Media Framework Action Inspectors

■ Using the Filename Pattern Editor

■ Binding Settings to a Variable

Note: Detailed, context-specific help (as shown above) is available on each inspector 
panel: Click the  icon to display its man page. Click the  icon to display this topic 
(the one you’re currently reading) in the Vantage User Guide. Once in the guide, you 
can also search for other topics. You can also hover over any control for a tooltip.
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Displaying the Action Inspector
To access the Inspector on any action, choose one:

• Click the inspector button (the round i button), which displays on the upper left 
corner of each action

• Double-click the action

• Right-click the action and select Configure. 

Until an action has been configured correctly, the inspector button displays yellow; a 
workflow cannot be activated until all actions have been configured correctly and no 
yellow inspector icons display. When an action is correctly configured, the inspector 
button disappears. When you hover over the top left corner, the inspector button 
appears in blue with a summary of the action.

The inspector panels vary, depending on the type of action, and the configuration 
choices you make. For example, here is a simple inspector—the inspector to configure 
a Copy action:

However, the Inspector for a Watch action typically consists of about 7 or more panels, 
depending on the file system you’re configuring it to monitor.

When you’re viewing an inspector of an action in a workflow that is activated or 
someone else is editing it, the term Read Only displays in the inspector’s title bar. Also, if 

Unconfigured actions display the 
inspector button in yellow.
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you have changed the configuration, an asterisk (*) displays immediately before the 
action name: For example, *Watch.

Using the Flip Action Inspector
The Flip action Inspector is unique in Vantage, and comprehensive. It contains a variety 
of general settings, a graphic representation of the transcoding process comprised of 
building blocks, and a settings detail panel for configuring each building block the way 
your require it for your application.

The general Flip action controls at the top of the inspector window enable you to select 
an encoder and create a file name pattern for naming the encoded file (for details, see 
Using the Filename Pattern Editor). You must specify an input and output media 
nickname. You use the Output Location controls to specify where to write the output 
media file. For details, see the man page.
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The media file panel is comprised of building blocks, and a toolbar for adding other 
streams and filters. 

Here are the building blocks (ordered left to right):

• Decoder—on the left edge of the stream panel; you can use the auto decoder or, 
under certain circumstances, select a specific decoder for specialized decoding.

• Video and Audio Streams—to the right of the decoder, as supported by the selected 
encoder. 

• Movie, Video, and Audio Filters—a wide variety of filters, overlaid on video and audio 
streams; added using the toolbar.

• Codecs—at the right side of the video and audio streams, listing all supported 
codecs for the selected encoder. 

• Container—at the far right of the stream; specifies the container /file format for the 
media.

Below the stream panel is the setting details panel. It displays the settings for the 
selected building block: decoder, various movie, video, and audio filters, codecs, etc. In 
this example, the Caption Conversion filter is selected and its controls display in the 
setting details panel.

Using the Media Stream Toolbar
Use the icons in the toolbar to add streams and filters; the list varies by encoder.

To add any supported type of stream for the encoder, select it from the toolbar. To add 
a filter, select the video stream or audio stream and then add the selected movie, video, 
or audio filter from the list.

Decoder
Video & Audio 
Streams

Movie, Video, and Audio Filters

Codecs
ContainerToolbar

Video Stream
Audio Stream
Video Filters
Audio Filters
Movie Filters
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If you directly click on the icon, it will add the next available filter at the top of the drop 
down list. If you click on the menu arrow on the right side of the icon, the list will 
displays and you can select the appropriate filter.

To remove any building block, select it and then click the Delete icon or just select it 
from the list again.

Using the Telestream Media Framework Action Inspectors
Vantage includes several Telestream Media Framework transcoding actions, including 
Flip64, Multiscreen Flip, IPTV Flip, Post Producer Conform, and others. Each action’s 
Inspector is designed to enable you to specify the discrete components required in an 
action’s functionality (inputs, converters, transcoders, etc.) on the left side, and detail 
panels for configuration of the selected components (and the streams inside them) on 
the right.

Each type of action’s components vary. The categories are represented by a panel—in 
this example there are four categories of components: Inputs, Converters, Transcoders, 
and Outputs. You can add one or more components to each category, depending on 
the action. For example, in the Multiscreen Flip action you can add several input 
processes, an Audio Mixer Converter, one or more transcoders and one or more 
outputs.

To remove any component, select it and then click the Delete icon.
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Configuring Components
Each component you add displays its own panel, including the video and audio 
streams, as appropriate.

To configure the component, click to select it (as shown above, with the white border).

The setting details panel displays on the right, enabling you to configure it.

Use the same process to configure each video and audio stream.

Specifying and Configuring Transcoder Filters
Transcoder components enable you to specify filters that you want to enable. To 
manage filters, select the transcoder. The Inspector displays the filters in the settings 
detail panel on the right.

Check each filter that you want to enable. 
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To configure the component, click the expander button to display its settings.

Configure the settings as required to accomplish your workflow requirements.

Using the Filename Pattern Editor
Actions that create new files often provide a filename pattern editor, so that you can 
customize the pattern for file name generation, based on the task and workflow 
requirements. The filename pattern editor is implemented in transcoding actions such 
as Flip64, IPTV Flip, and Conform, and in file operation actions including Move, Copy, 
etc.

Here’s an example—the Edit Filename button—displayed in the Outputs panel in a 
typical action:

To display the editor, click the Edit Filename button:

To produce the name generator pattern you require, you can include raw text (for 
example, .xml) and any combination of the following tokens: base name, any supported 
variable you want to select, plus date and time. The Date token includes variations of 
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month, day, and year. The Time token includes variations of hours, minutes, seconds, 
AM/PM, and Time zone offset. Hover the cursor over each selection to see a tool tip 
description. Once a token is added to the pattern, you can move it to a different 
position within the pattern field by clicking and dragging it.

Note: In all transcoding actions, the Base Name element is the base name of the 
source file without the extension (for example, myfile for a file named myfile.mpg). In 
file operations actions (Copy and Move, for example), the Base Name is the full name 
of the file, including the extension. For example, myfile.mpg.

Binding Settings to a Variable
Most settings in an action are configured with a static value—one that doesn’t change 
from job to job. For example, you configure a Watch action to poll a specific directory—
and job after job, this directory never changes—that is, the fully-qualified path string is 
a static value.

However, many actions also have settings whose values do change from job to job—
typically, based on the media being processed.

For example, you have a Message action that sends email—the To address should be 
the address of the producer, which is provided in metadata and assigned to a variable 
in a previous action. Or, a variable is updated by an Analysis action to specify the 
number of black lines are at the top of a frame; a crop filter in the workflow uses the 
variable to crop the video appropriately for that job.

To support dynamic values, Vantage enables appropriate settings to be bound to a 
variable, allowing the workflow to dynamically update the value on a job-by-job basis.

Settings that can be bound to a variable display a green Browse button:

Click the green variable browse button to 
select a variable to supply the variable’s value 
to this control. In this case, an email address.
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Click the green Browse button to display the Select Variable dialog, shown here.

The list of variables includes those variables of the appropriate type (text, true/false, 
etc.) in the domain. For example, the subject line only accepts text variables; the email 
address only accepts email address variables.

Select the variable to bind to this setting, and click OK.

Note: Click Create New Variable to if you need to make a new one. For details, see 
Creating New Variables. (You can also create variables in the Management Console.

Now, the setting displays with a green border, indicating that its value is derived from 
the current value of the variable instead of the setting (in the case of a check box or 
radio button) or a manually-entered or selected static value.

When you bind a setting to a variable, the value or state displayed is the default for the 
variable definition in the domain and the value is read only. If you remove the binding, 
the value returns to the setting’s original editable value.

Creating New Nicknames
In actions that utilize nicknames, you can create a new nickname by selecting <<Create 
New Nickname>> at the top of the nickname list. 

Settings bound to a variable display a green 
border.
Click the button again to unbind a variable or 
change the variable you want to use.
You can hover over a bound setting to display 
information about the binding—for example, 
the name of the variable.
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The inspector displays the Create New Nickname dialog:

Configure the new nickname as follows:

1. Enter an appropriate name for the nickname in the Name text box.

2. Enter a description in the Description text box. (This is optional.) 

3. Select a nickname type from the Nickname Type menu.

4. Click OK to save the nickname.

The inspector uses the nickname you just created, inserting into the control you’re 
updating.
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Specifying Action Settings
The following topics describe how to specify action settings. These settings differ from 
configuration, which controls how the action performs its task. These settings control 
the conditions in which an action executes: are all accessed by right-clicking an action 
and selecting the setting from the context menu.

■ Setting Conditional Action Execution

■ Utilizing Variables in an Action

■ Configuring an Action’s Run On Rules

■ Configuring an Action’s Fallback Rules

■ Specifying Automated Retry Settings

■ Modifying Resource Costs

■ Generating Execution Metrics

■ Changing Action Descriptions

■ Highlighting a Branch in a Workflow

■ Highlighting a Branch in a Workflow

■ Creating Action Templates

■ Exporting a Flip Action

Note: Not all actions provide each of these settings.

Setting Conditional Action Execution
You can configure most actions to execute only when the upstream action passes a 
specific, post-execution action state to the downstream action. Obviously, you can’t 
test action states or set conditional execution in origin actions—the first action in a 
workflow.

■ Action States Overview

■ Setting The Perform On State

Action States Overview
After execution, an action’s state is assigned: Success | Failure | Ignore, and is passed to 
the next action in the workflow. The state is tested in the following action (using the 
Perform On function—see Setting The Perform On State) to determine whether or not it 
should execute.

For example, if an action succeeds, the next action inherits the Success state and by 
default, executes—unless its Perform On state is set to Failure. Or, for example, if an 
action fails, the next action inherits the Failure state and won’t execute—unless its 
Perform On state is set to Failure.
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Some actions can be configured to set the Ignore state. The next action inherits the 
Ignore state and will likely not execute (unless it has been explicitly set to execute on 
Failure). Most actions, such as Message, can be configured to perform on certain 
states—this allows workflows to send an email if they detect a failure.

By default, actions only execute when the action state (as set by upstream actions) is 
Success. Success means that the upstream actions have completed normally and the 
incoming state is Success. 

The Failure state indicates that at least one action has executed and failed to complete 
normally or completed normally, but was explicitly set to Failure. If you have an action 
configured to execute on Failure, it only executes if at least one upstream action has 
reported a failure.

Post-execution states have priority: If an action receives states from two incoming 
actions (at a merge of two branches), then:

• Failure has precedence over all action states—If at least one incoming state is Fail-
ure, regardless of other incoming states, the action will inherit the Failure state.

• Success has precedence over Ignore state—If there is no Failure, but at least one 
Success state, then the action will inherit the Success state.

• Ignore is the lowest precedence—Only if all incoming states are Ignore, will the 
action will inherit the Ignore state. 

Setting The Perform On State
To set the state under which an action will execute, right-click and select Perform On > 
Success | Failure | Ignore | Any. 

The Any option is not a state—it is a selection to indicate this action should execute 
regardless of the state passed to it.
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Utilizing Variables in an Action
Sometimes, you need to provide information to one or more actions (or directly to a 
job, when you’re manually submitting it) that is independent of the functionality of the 
action.

For example, you can add a variable to set the execution priority of one workflow 
branch to high, and another to low. Or, you can collect frame rate and frame size 
information from an incoming file, save the values in variables, and pass them on to a 
specific encoder action, based on the type of media: SD/HD/4K, etc.

Vantage provides a rich set of built in variables, and you can create variables of your 
own to suit your requirements. You can add variables to an action in two ways: by 
adding them manually or by copying them from other actions, which speeds workflow 
design in large workflows.

■ Variables Overview

■ Adding Variables Manually

■ Creating New Variables

■ Copying and Pasting Variables

Variables Overview
In Vantage, a variable is a container for temporary job information—a symbolic name 
(or identifier) which contains some data: a quantity, string, or element of information; a 
value. You use the variable name to reference the current value; this separation of name 
and content allows the name to be used independently of the information it references.

Each variable has a name (such as Number of Audio Channels), a type (Integer Number, 
for example), and a default value, all of which are defined when the variable is created. 

Note: To display variables used in your actions, in detailed action view, select View > 
Action Details > Variables or select Variables from the menu in the bottom right corner 
of the Workflow Design panel. 

You can change variable values in a variety of ways. For example, a variable value can 
be set by default. Or, it can be assigned a new value in actions that are designed to use 
variables, such as the Analysis, Populate, Watch and Associate actions. Variable values 
can also be changed when manually submitting a job or using Workflow Portal to 
submit jobs.

Variables are passed from action to action according to the action connections. When 
an action creates a given variable, all downstream actions that use variables can access 
the variable and its current value.

Variables are used by some actions to control their functionality and execution—and 
thus, implement workflow logic. (Variables are also used by Vantage services as defined 
by the Vantage domain administrator.)



Designing and Managing Workflows
Specifying Action Settings

102

Many settings in an action can be bound to a variable, allowing the workflow to 
dynamically update the settings on a job-by-job basis. For details on binding settings to 
variables, see Binding Settings to a Variable.

When a variable is set to a specific value, that variable value is only available to actions 
within the same branch as the one that set the variable and actions in downstream 
branches.

Note: If two branches merge to a Common action, and both have set a value for the 
same variable, then the last upstream action to finish executing will set the variable for 
the common action. The last action to finish can not be determined from job to job.

Adding Variables Manually
To manually add a variable to an action in a workflow, right-click and select Add 
Variables. Workflow Designer displays the Add Variables window.

In the Add Variables window, you can add variables to the action prior to execution. 
Values set in this window are available to this action, and all downstream actions 
(including actions in connected workflows). Variables added using the Add Variables 
context menu appear in yellow in the action variable list.

Click the Add Variables button in the toolbar to display a list of variables.

Add Variable & Delete Variable toolbar buttons.
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Select the variable to add and click OK.

Note: Click Create New Variable to create a variable if you need a new one. For details, 
see Creating New Variables.

Next, with the variable selected, modify its default static value if necessary, and click OK 
to add it to the variable for use in the workflow.

Creating New Variables
Vantage includes some default variables, and you can create variables directly in 
Workflow Designer. Vantage domain administrators can also create variables using the 
Vantage Management Console (Workflow Design Items > Variables).

On variable selection windows in Workflow Designer, click the Create New Variable 
button. Workflow Designer displays the Create New Variable dialog shown here.

Configure the new variable as follows:

1. Enter an appropriate name for the variable in the Name text box.

2. Enter a description in the Description text box. (This is optional.) 

3. Select a variable type from the Value Type dropdown list.

4. Enter a value for this variable in the Default Value text box.

5. (Optional) Enable password encryption for Text variables.

6. Click OK to save the variable.

Copying and Pasting Variables
In the action Inspector, you can copy and paste variables in controls which use them, 
instead of creating and configuring them manually.

Copying and pasting variables simplifies designing large workflows, in which many 
actions may need to utilize the same variable. Copying and pasting variables eliminates 
opening the variable picker and searching for the desired variable and configuring it 
repeatedly in many actions.
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For example, consider this Construction action, which is configured to create a specific 
text string and store the result in a variable named JobNameVar.

After configuring this variable, you can copy it, making it available to paste into other 
controls which utilize variables, in this or other actions. After adding a new item, and 
pasting the copied variable into the text field, the inspector displays the variable, 
bound to the original, as shown here:

Note: The variable is still in the Vantage (not system) clipboard, so that you can create 
or open another action and perform the paste operation again.



Designing and Managing Workflows
Specifying Action Settings

105

Copying and pasting variables speeds the process of creating complex, large workflows 
by reducing repeated manual configuration tasks.
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Configuring an Action’s Run On Rules
Most actions have a set of rules called run on rules, which can be configured to 
determine if its service has the features or characteristics which enable it to execute the 
action. Unlike qualification rules, which are service-centric, run on rules are action-
centric.

Note: To display the current run on rules used in actions in your workflow, in detailed 
action view (Ctrl+D) select View > Action Details > Run On Rules or select Run On 
Rules from the menu in the bottom right corner of the Workflow Design panel. 

Run on rules provide explicit control over which service can execute this action in a 
workflow. As you design a workflow, you can indicate that you need to have the action 
executed by a specific service (or set of services) based on workflow state criteria. To 
implement this, you assign a True/False variable the value of TRUE to indicate that the 
service must satisfy the requirement. Assign this variable to the Vantage service or 
services that qualify, in the Vantage Management Console > Services > Variables.

For example, you are designing an HD transcoding workflow, and the Flip action must 
be executed by a Transcode Service deemed HD-capable—that is, it is running on a 
server with a processor set capable of adequately handling HD media transcoding. For 
this example, it’s a server named Vantage_HD_Transcoder.

Note: In addition to setting up specific rules on an action, Vantage domain 
administrators can set up service-based qualification rules using the Vantage 
Management Console.

Creating Run On Rules
You can create new run on rules directly in an action or you can copy user rules (not 
automatic rules, which are action-type based) from other workflows and modify them 
as needed.
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In Workflow Designer, open your workflow, right-click on an action and select Run On 
Rules to display the Run On Rules dialog:

Click the Add Run On Rules icon in the toolbar to display the Run On Rules dialog: 

Add one or more rules (selecting a variable or creating it if needed) and select an 
operator and value to configure them.

OR

Click Copy From to display the Run On Rules Copy From dialog. Navigate to the 
workflow you want and then select the action to copy from and click OK.

Next, click OK to create this rule, and click OK to save the Run On Rule.

In the Vantage Management Console, select Services > Variables and add the 
variable(s) that you have used in your rules to each Vantage Service you need to query. 
In an array, the same service may be hosted on multiple nodes.

Note: When a variable is added to a service, that variable is added to the job 
automatically, if it contains an action that the service executes. Be careful about which 
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variables you use for run on rules, and which are used for decision-making; generally 
you will want to use different variables.
Run on rules only analyze variables explicitly set by a service. They do not analyze 
variables set in a job. This ensures that run on rules only execute actions on a service 
that explicitly sets them.

Now, return to Workflow Designer and display the workflow again. Right-click on your 
target action and select Run On Rules to display the Run On Rules dialog.

Click Check Services to verify that the service now responds correctly to variable 
analysis. For example, HD-capable = TRUE.
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Configuring an Action’s Fallback Rules
Actions that have been configured to utilize the Lightspeed Server (for example, by 
selecting the Lightspeed Accelerated VPL), by default, will fall back and use the (non-
Lightspeed) Legacy Telestream VPL under these circumstances:

• No services are available to run the Lightspeed Accelerated VPL. 

• The queue length of jobs waiting for Lightspeed Servers is larger than a configu-
rable number. 

To enable and configure Lightspeed fallback rules, right-click on the action and select 
Fallback Rules to display the Fallback Rules dialog.

Check the Fallback if Queue Greater than option, and select the maximum number of 
actions already in queue you will accept, before running this action on a capable 
service running on a standard Vantage server. The rule will be activated if every capable 
service has a queue length greater than the number you have selected.

Note: In Open Mode, Lightspeed fallback doesn't occur until the action completes. 
This is by design. Fallback occurs only when Vantage determines that the action 
cannot run, and this condition will not happen until the previous action completes in 
this scenario. In this scenario, the action should be configured to explicitly use the 
multi-core mode. 

Specifying Automated Retry Settings
Certain actions (typically, those that deal with files or other network-accessible 
computer systems) which may fail due to file system latency or network delays, can be 
configured to automatically execute multiple times in an effort to overcome a 
temporary problem, according to user-specified parameters, called retry rules.

Actions that support Retry Settings have a Retry Settings menu item in the actions’ 
context menu. 

Retry Rules Overview
Default retry rules are set for each action type by the Vantage domain administrator. For 
example, the Vantage domain administrator might specify a default retry rule (in the 
Vantage Management Console) so that all Flip actions retry one time after five minutes.

The default retry rules can be modified for an action in Workflow Designer, and the 
action retry rules override the default rules. For example, you might specify that a 
specific Copy action in a workflow should retry three times: once after five minutes (in 
case of a SAN blip), once after an hour (in case of Internet congestion), and up to a 
certain number of times after two days (in case of complete Internet failure).

It is important to keep in mind that individual action retry rules specified in Workflow 
Designer override the default retry rules specified in the Vantage Management 
Console. If an action does not have override retry rules, the default retry rule for the 
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action type is used instead. If there are no override rules specified for an action, and no 
default rules for its action type, then a failed action is not retried.

Each time an action is executed, it may be executed according to either task scheduling 
rules or resource cost settings, depending on what type of load balancing is enabled in 
the domain, and it may be assigned to a different service for execution.

If you restart a job that is in the Stopped by User or Failed state, the actions execute as a 
first-time execution. For example, you have an action with retry after 4 hours. Restarting 
this job results in immediate execution, because the action is executing on its first try.

Configuration Details
Right-click on an action and select Retry Settings to view or configure retry rules. 
Workflow Designer displays the Automated Retry Settings dialog.

This dialog supports the following options:

• No Retry—Override any default retry settings, and not retry execution on failure. 

• Default—Utilize the default retry settings specified by the Vantage domain admin-
istrator. 

• Custom Limited Retry—Configure up to three retry settings. Specify the duration of 
each delay, and select Specify to set a specific retry priority for this action; select Use 
Existing to use the default Retry Priority value (which is specified in the Vantage 
Domain Console > Workflow Design Items > Action Defaults) for this action type.

• Custom Recurring Retry—Configure the time and priority (which is optional) 
between retries, and optionally, stop after a certain number of iterations. Specify 
the duration of each delay, and select Specify to set a specific retry priority for this 
action; select Use Existing to use the default Retry Priority value (which is specified 
in the Vantage Domain Console > Workflow Design Items > Action Defaults) for this 
action type.
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Modifying Resource Costs
When you right-click an action, Resource Cost is among the selections. The following 
topics explain the Resource Cost selections.

■ Cost-Based Load Balancing

■ Task Based Load Balancing

■ Setting Action Resource Costs

Cost-Based Load Balancing
Cost-based load balancing is a legacy load balancing system available with the 
Advanced Task Scheduling license and is disabled by default. To determine if cost-
based load balancing is enabled, contact your Vantage domain administrator.

Note: When cost-based load balancing is disabled (the legacy, default setting), 
Vantage uses session-based load balancing and resource cost settings are ignored. For 
information on configuring load balancing, see the Vantage Domain Management 
Guide.

When cost-based load balancing is enabled, each action has a default cost and a 
custom cost. The default cost value is defined by the Vantage domain administrator. 
The custom cost is defined by the workflow designer in the workflow itself. When you 
define a custom cost, that cost overrides the default value.

Cost-based load balancing provides a way to control how action processing is 
distributed among multiple services. During workflow processing, the action cost 
defines the relative resources that must be available on a Vantage service to process 
the action. If there are multiple services that can process an action, and if one service 
does not currently have the resources to process that action, another service with 
available resources will process the action.

The resource cost is an integer value that has an ordinal relationship to the other action 
costs and to a target resource usage value defined by the domain administrator. A 
higher resource cost in an action means that fewer actions can run simultaneously on 
the same service. A lower resource cost allows more actions to run simultaneously. The 
actual values you enter for a workflow action must conform to the service settings 
defined by the Vantage domain administrator. To determine the range of resource cost 
settings available to you, consult with your Vantage domain administrator.
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Task Based Load Balancing
Task Based Load Balancing is Vantage’s most advanced load balancing capability and 
augments the existing Vantage Session Based Load Balancing and the Vantage Cost 
Based Load Balancing. Task Based Load Balancing ensures that all Vantage servers 
remain fully utilized, maximizing server efficiency and increasing workflow throughput. 
Task Based Load Balancing also helps avoid the situation where some Vantage servers 
are over-utilized and others are under-utilized.

The older cost-based method discussed previously is limited to a single service on a 
single machine. This method can prevent a service from becoming overloaded, but it 
cannot effectively balance between different types of actions on a single machine, and 
it does not offer a global way of managing sessions across multiple machines.

Task Based Load Balancing is a separately licensed option that provides a single set of 
metrics shared across all services for scheduling tasks and balancing workload on a 
single machine or all the machines in a domain. 

These are the key features:

• Each metric can be edited and has machine scope (across all services on the 
machine) or global scope (across all services on all machines). 

• Each metric has two inputs: Cost (set for each action) and Capacity (set per 
machine, or globally). You can edit both on a per-machine basis (for per-machine 
metrics) or for the entire Vantage Domain (for global metrics).

• A default metric called System Resources is pre-configured to provide a per-
machine metric. This metric cannot be deleted and must remain per-machine. 
However, you may set the capacity for this metric on each machine, and you may 
remove the metric from an individual action.

• You can create and name your own new metrics.

• By default, each metric has machine scope, but you can edit this after creation.

• The default capacity is 100 “units” for each machine, allowing each cost to indicate 
the resource percentage an action will use. The capacity can be changed.

• You can choose which metrics are relevant to an action, and you can set the cost for 
each action.

• When executing a task:

Vantage evaluates all metrics that you attach to the action. If a metric is not 
attached to an action, it is not considered.

Vantage tracks the aggregate cost of all executing actions on a machine, across all 
machine-based metrics, and will track the aggregate cost of executing actions 
across the entire system for global metrics.

Vantage only executes an action when the aggregate cost of executing current 
actions, plus the new task, does not exceed the capacity of any of the metrics 
attached to the task.

Vantage will never execute a task when the aggregate cost of executing actions, 
including the new task, would exceed the capacity of any metrics attached to the task.
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• When tasks are queued, they may be preempted only by higher priority actions:

Certain high priority tasks will pause low priority tasks (executing on the same ser-
vice on the same machine) to free up sufficient resources across all metrics, to allow 
that high priority task to execute. If doing so would exceed the maximum number 
of paused jobs specified by the user, then the high priority task will wait until a dif-
ferent set of tasks are present which may be paused. Pauses will not occur across 
multiple machines; they occur only for actions hosted by the same service.

Task Based Load Balancing allows you to define custom task scheduling rules which 
allow jobs to be controlled/allocated based on criteria on a given machine or across an 
entire domain.

Task Based Load Balancing is enabled via the settings panel in the Vantage 
Management Console. As with other system level settings, when Task Based Load 
Balancing is enabled (or changed), services must be restarted.

Task Based Load Balancing includes capabilities that replace and extend the Cost Based 
Load Balancing. The capabilities replace the existing action cost mechanisms, and are 
used in-conjunction with the existing service capacity to provide more granularity on 
when and where an action may run.
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Setting Action Resource Costs
The preceding topics about Cost-Based and Task-Based Load Balancing provide the 
background you need to make action Resource Cost decisions, as this topic explains.

1. Right-click the action and select Resource Cost.

2. Select either Resource Cost Settings or Configure Task Scheduling.

a. If you select Resource Cost Settings, Workflow Designer displays the Resource 
Cost Settings dialog, shown here. Select Default to use the default resource cost. 
Select Custom to set your own resource cost.

b. If you select Configure Task Scheduling, the Task Scheduling Rules dialog opens. 
Select Default to apply existing system rules, or select Custom and choose the 
custom rules you’ve created that you wish to apply. Also specify a cost and click 
Done.

For details about creating Task-Based rules using the Vantage Management Con-
sole, refer to the Vantage Domain Management Guide, “Managing the Vantage 
Domain” chapter.

3. Click OK to save.
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Generating Execution Metrics
For most actions, you can collect execution metrics, and assign them to variables for 
processing downstream. For example, you can generate start and end times, total 
elapsed time, and final action state, among other values. You can use these metrics to 
enhance your ability to fine tune your system, and improve throughput, or identify 
bottlenecks. 

To generate execution metrics for a given task, right-click the task and select Execution 
Metrics. Vantage displays the Execution Metrics dialog.

Check the metrics you want to collect, and assign each one to a variable. Then, 
downstream you can access these variables for analysis. 

Changing Action Descriptions
You can change an action description by directly clicking on the description text field at 
the bottom of the action, or right-click and select Description. Enter the new text and 
then click away.
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Highlighting a Branch in a Workflow
In a complex workflow, it might be difficult to determine at a glance exactly which 
actions are in a specific branch of the workflow. To see all of the actions which will 
execute on a given branch clearly, right-click on the farthest downstream action that 
you want to see in the context of its branch and action execution path, and select 
Highlight Path. To turn highlighting off, left-click on the same action.

All of the actions in this branch that precede the target action are temporarily 
highlighted in yellow so that you can identify them.
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 Creating Action Templates
Vantage allows you to create action templates to make workflow construction easier. 
With action templates many of the repetitive steps of action configuration can be saved 
for reuse. To create an action template, follow these steps:

1. Add an action to a workflow. 

2. Configure it as appropriate.

3. Edit the description (at the bottom of the action), used to name the action 
template.

4. Right-click and select Create Template to save the selected action as a template.

5. Enter a description (this is optional).

6. Add or select a group, or select None and click OK.

Grouping allows you to organize your action templates. If you want more than one 
level of grouping, separate each group with a vertical bar (|)—for example, Broadcast 
Servers | Grass Valley. The description of the action displays as the name of the action 
template.

The action template is added to the template list, and can be selected by clicking on 
the action.
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Exporting a Flip Action
When you are creating a custom Vantage application using the Vantage SDK, you can 
create and configure a Flip action and then export it as an XML file, for use as a template 
in your application.

To export a Flip action, first create and configure the action to meet your requirements. 
Next, right-click the Flip action and select Export. Workflow Designer displays a File 
Save dialog, where you can navigate and save the XML file with a name you choose. 

You can use this XML file (which contains a definition of your Flip action) in your 
Vantage SDK-based application. You can also edit the XML file separately from 
Workflow Designer, of course. 

Note: Only Flip actions can be exported using this feature.
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Implementing Processing Logic in Workflows
Many workflows consist of several actions connected in a single line—thus, each action 
is executed, in turn, for the entire workflow.

However, you may want to create branching workflows that are intelligent and flexible, 
so that they can process media files with differing processing or output requirements 
automatically. These workflows can extract information about the media or container 
at runtime (using the Analyze action, for example), and store that information in 
variables. Then, you can add a Decide action to examine the variable values in and pass 
control to one branch or the other, based on the value. (You can also use the Compute 
action to perform string processing and math operations on the metadata.)

Generally, controlling the flow of media through a workflow is achieved by adding 
variables and assigning them values, using a Decide action to evaluate them, then 
setting an action state that follows the Decide action. For many decisions or multiple 
levels, the decisions and their variables can be combined in a single Multi-Decide 
action. The outputs of Decide and Multi-Decide actions serve as the input for 
subsequent actions or entire branches of workflow processing. The Decide or Multi-
Decide ensures that only the appropriate branch for a specific set of detected 
conditions executes. For example, you can detect an aspect of the video or audio, such 
as SD or HD or bitrate, and route the media to different processing branches depending 
on what is detected.

You can add as many decide actions and branches as you need in order to further refine 
your processing choices.

In this example, some metrics about the input file are being examined by the Watch 
action—file modification date, for example. The Decide action determines if the date is 
prior to or later than a given date, and sets Success or Failure, based on the answer. 

The top branch’s Flip action only executes on Success (processing those files whose 
modification date is prior to the test date), and the lower branch’s Flip action only 
executes on Failure (processing those files whose modification date is later than the 
test date).
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Managing Vantage Folders
Vantage folders are aliases (or alternate names) for specific file system directories or 
folders, on any supported file system in Vantage. You can create (and name) Vantage 
folders as URLs, UNCs, or drive letters to identify specific paths you use frequently. 
Vantage folders simplify directory referencing by allowing you to specify a short, 
descriptive folder name instead of a long, complex file path. Vantage folders also allow 
you to update a path or credentials once, and automatically update all actions using 
that Vantage folder.

For example, you might have a folder on a given server for HD MPEG2 content: 
\\voyager\SunupCampaign\Darwin\WaitingApproval\HDMPEG2. You can create a 
Vantage folder in the Vantage folder address book for this path, and name it 
SunupHDWaitingApproval. If you need to change the path or any password associated 
with the address later, you can simply change it in the address book and all actions will 
automatically update.

When you create a workflow that accesses a folder for a file or generates media you 
want saved in this folder path, you simply select SunupHDWaitingApproval in the 
action’s Inspector.

For Windows, Telestream recommends using UNC paths instead of drive letter paths, 
and it is required in Vantage arrays. For a detailed discussion, see Paths for Vantage 
Storage Overview.

You can also create Vantage folders in the Address Book to identify buckets in your 
Cloud accounts—Amazon AWS or Google Cloud, for example.

You can create Vantage folders in both the Vantage Management Console and in 
Workflow Designer.

To create and manage Vantage folders in Workflow Designer, do the following:

1. Click on the browse  button to the right of any location field that accepts Vantage 
folders.

For example, open a Flip action and open the Output Location panel, which dis-
plays a Browse button to the right of the Vantage Store/Folder field. 
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2. Select Vantage Store/Folder and then click the Browse button. Vantage displays the 
Vantage Folder Address Book, shown here:

3. Click the Add Folder toolbar button (the new folder button at far left).

4. Name—Enter the Vantage folder name.

5. Location—Click Modify to display the Folder Location Editor dialog, which presents 
you with a list of all supported file system types in Vantage.

6. Select the file system where the Vantage files will be stored, then click Next.
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7. Configure each field or control in each panel to set up the folder address—panels 
and controls vary by file system, of course. 

8. To specify a Windows directory with a UNC path (recommended), do the following:

a. Click Browse to display the Browse for Folder dialog box.
b. Open Network, open the computer name, and then select the root directory for 

the folder.
c. Click OK.

You can also type a UNC path in the Location text box. For example, \\Computer-
Name\Sharename.

9. To specify a Windows directory with a drive letter path, do the following:

a. Click Browse to display the Browse for Folder dialog box.
b. Select a local folder.
c. Click Select Folder.

You can also type a drive letter path in the Location text box. For example, 
C:\folder\folder.
For a detailed discussion, see Paths for Vantage Storage Overview.

10. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on 
the local folder warning dialog.)

11. Click OK to add this new Vantage folder address to the domain and close the Add 
New Folder dialog.

12. Description—Enter the description, purpose, or use of this folder address.

13. Collision Resolution (not supported on all file systems)—Specifies the action 
Vantage takes when it saves a file with the same name of a file that already exists.

– Create Unique Name—Workflow Designer adds a suffix to the filename, making it 
unique, then saves the file in the location.

– OverWrite—Workflow Designer deletes the current file and saves the new file in 
the location.

– Set Failure State —Workflow Designer does not save the file; it sets the action 
state to Failure so that downstream actions may detect the error and perform a 
specified task under this condition.

14. To test your connection speed to this location and optimize the block size for file 
transfer, click the Advanced button.

15. Click the Disk icon in the toolbar to save changes to this new Vantage folder 
address.

16. Click Select to close the dialog and use the currently-selected folder address, then 
press OK to save changes. Click Close to simply close the Vantage Folder Address 
Book dialog with changes.
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Using Open Workflows
The Open Workflows licensed option provides a way to gain much greater processing 
efficiency and speed from Vantage workflows. Open workflows can run many times 
faster on the same hardware because of concurrent processing. 

■ Licensing Requirements

■ How Open Workflows Work

■ Open Workflow Indicators

■ Open Actions

■ Open File Formats

■ Creating Open Workflows

Licensing Requirements
A license is required to utilize open workflows. Licenses may be enabled for an entire 
domain, or for individual nodes within a Vantage array so that jobs requiring open 
workflow processing can be submitted to these specific nodes.

How Open Workflows Work
Open actions in a workflow run in parallel, unlike the serial operation of traditional 
Vantage workflows. The ability for actions to execute concurrently is constrained by 
media processed within a file, not by file processing itself. That is, multiple actions can 
independently utilize a file that is currently being processed by other actions, without 
waiting for previous actions to complete and close the file. This removes the inherent 
latency associated with the discrete steps of a traditional closed workflow. 

Consider this example:

Closed Workflow
• Existing Vantage behavior     • Actions execute sequentially
• Throughput is constrained    • Run time is cumulative

Open Workflow
• Optional open capability   • Actions may run concurrently
• Throughput is dynamic      • Run time is greatly reduced
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In the figure above, the upper workflow is executing serially. While the Flip action is 
executing, the second Copy action waits for it to finish. In the lower workflow, the open 
Copy and Flip actions run concurrently. Once the media blocks have been written to 
disk in the first Copy, the Flip action is able to read these media blocks and begin the 
transcoding process. When the Flip action finishes processing and writes the resultant 
transcoded media blocks to disk, the final Copy action moves them to the appropriate 
destination. 

In this example, the first Copy action takes 10 minutes. However, since the Flip action 
and the final Copy action can begin processing the incoming file almost immediately, 
the overall job will be completed in approximately 12 minutes. The figure below 
illustrates the concurrent nature of this execution:

Open Workflow Indicators
Open workflows include certain visual characteristics so you can recognize open 
actions. As shown below, connectors are hollow, and the nicknames are italicized if an 
action is operating in open mode. Actions in closed mode look the same as they always 
have, with filled connectors and regular type.

Hollow connectors 
for open mode

Oblique font for 
open mode
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Open Actions
Many actions can execute in Open mode—but not all. Additionally, in some instances, 
the inbound processing to the action may be open but the outbound is closed, and 
vice versa. The following table summarizes the actions supported by open workflows.

Service Actions
Open 
Inbound

Open 
Outbound Notes

Monitor Watch N/A Yes On Windows, the file being submitted 
can be an open, growing file (one that 
is being written). On other file 
systems, the file must be complete 
and closed before it can be submitted.

Transport Copy Yes Yes Input and output may be TIFO, 
Transport Stream or Program Stream 
files; only valid when using the 
Windows File System.

Transcode Flip, Flip64 Yes Yes Input only for supported file formats 
(below)

Note: In order to localize a file from a file system other than Windows in open mode, the file must 
already be complete. For example, in the following workflow: Watch (FTP) > Copy (local Vantage 
store) > Flip, the Copy and Flip actions will run in open mode when the source file on the FTP server 
is a complete, closed TIFO file, since the Flip action only supports TIFO open inbound.

Multiscreen Multiscreen Flip Yes No Input only for supported file formats 
(below).

IPTV IPTV Flip Yes Yes Input only for supported file formats 
(below).

Edit Tempo, Conform No Yes Input only for supported file formats 
(below).

Live Capture No Yes Outbound only.

Metadata Populate, Transform Yes No Instantaneous, no media dependency; 
XML files are closed.

Common Compute, 
Construct, Decide, 
Delay 

Yes Yes Instantaneous, no media dependency, 
actions will not run until input 
variables are all available.
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Open File Formats
Only file formats that are able to be read while being written (aka growing files) are 
supported by Open workflows. This is fundamentally controlled by both the file 
wrapper and the codec utilized for transcoding the media.

Note: In order for a transcoding action to ingest media an input in open manner, the 
decoder must be configured for a format that supports open workflows.

The following file formats are supported for both reading and writing in all open 
transcoding actions listed in the preceding table:

• All actions that are Open Workflow-capable support open TIFO for inbound, out-
bound, or both depending on the action

• Open Transport Stream is only supported for IPTV Flip and Flip actions outbound

• Open Program Stream is only supported for Flip actions outbound

• Flip actions only support PCM audio for inbound

Choosing an appropriate file wrapper greatly enhances the speed of execution for an 
open workflow. The Telestream Intermediary Format (TIFO) offers a good choice for file 
wrapping as it supports open workflows and all codecs. When you are capturing live 
content from a Telestream Pipeline HD Dual or the Lightspeed Live Capture server, the 
media can be a TIFO wrapped file that can immediately be consumed by an open 
workflow for extremely fast live content deployment.

If you need additional speed, adding a Telestream Lightspeed Server will further 
increase processing speed and reduce the time to produce media assets.

Open workflows are ideal for scenarios where media residing on external systems (S3, 
FTP and Aspera servers) is to be localized, processed, and delivered to external storage 
locations. Files processed on S3, FTP or Aspera systems are limited to complete, closed 
files in TIFO format.

Open workflows are also ideally suited for Vantage workflows in which one action is 
creating a mezzanine file for the purpose of a second action creating a specific 
rendition. For example, Post Producer might create a high resolution mezzanine file 
followed by the Cable IPTV Flip to produce a vendor specific Transport Stream.
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Detecting an Open Workflow Error State
An Error state may occur for both actions and jobs. If an action running in open mode 
catches a critical error (that would be shown in the session log view), but must wait 
until the open block completes before failing, the user is alerted as follows:

• The action border displays light orange in the Job Status view

• The job status transitions to Error, in light orange text.

The Error state indicates that the action and the job are going to fail when the upstream 
open actions complete.

Note: The Error state is only displayed when a service become aware of a critical error. 
It is possible that a condition introduced during execution (full disk, network 
interruption, etc.) may cause the service to encounter an error that is not reported to 
Vantage until completion. However, if a critical error is propagated to the session log 
during execution, the Error state is triggered to alert you.

Creating Open Workflows
You create an open workflow using the Workflow Designer in the same way as a 
standard workflow. However, open workflows must be enabled in three places:

• Enable domain level in Vantage Management Console Settings & Options > General

• Enable workflow level in Workflow Designer, workflow drop-down

• Enable action in context menu (right click) Workflow Mode

These are the steps to create your first open workflow:

1. Open the Vantage Management Console, select Settings & Options, select the 
General tab, and check Enable Open Workflows.

2. Open the Workflow Designer and create a new workflow, such as this one.

Enable Open Workflows
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3. Select the workflow drop-down menu, and check Options: Open mode.

4. Right-click each action in your workflow, select Workflow Mode, and check Open.

This completes Open mode configuration. You can submit jobs and use the workflow 
as you normally would. Notice that the Job Status shows some of the open actions 
operating simultaneously.

Enable Open Mode

Workflow Drop-down Menu
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Processing Cloud-based Media in Workflows
Vantage Cloud is a set of containerized Vantage actions that execute in Telestream 
Cloud, which are executable by workflows in locally based Vantage domains or entirely 
deployed in Telestream Cloud as hosted workflows. You create a Vantage Cloud 
account at cloud.telestream.net to leverage additional, cloud-based media processing 
on demand. 

Implementing Vantage Cloud in your Vantage domain enables you to rapidly deploy a 
Vantage Engine Container and processes the media in the cloud using the Cloud-
capable actions in your workflow.

Vantage workflows can be configured to process media in the cloud, whether it is 
stored locally or in third-party Cloud storage such as Amazon AWS, Microsoft Azure, or 
Google Cloud Storage. Media that is in the cloud, stays in the cloud. Local media is 
transferred automatically to the cloud for cloud processing.

This topic describes licensing requirements and Workflow Designer features related to 
Cloud-based media processing.

Note: Information about using Vantage Cloud is described in the Vantage Cloud User‘s 
Guide, including an overview, configuring, and using Vantage Cloud to process cloud-
based media. For information about Vantage Cloud features and utilization, please 
refer to the Vantage Cloud User’s Guide, available on the Telestream web site.

■ Licensing Requirements

■ Vantage Cloud Mode Transcoding Actions and Functionality

■ Enabling and Configuring Vantage Cloud Mode and File Lifespan

■ Specifying Output File Lifespan (Hosted Workflows Only)

■ Correcting Unsupported Action Configurations

Licensing Requirements
Using Vantage Cloud in your Vantage domain requires the following:

■  A license for Vantage Transcode (V-XCODE-SW) or higher. 

■ A Telestream Cloud account (https://cloud.telestream.net). Cloud-capable actions 
operating in the cloud include licensing in the per-minute execution price of Van-
tage Cloud.

■ A storage account with AWS, Azure, or Google. 

http://cloud.telestream.net
https://telestream.net
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Vantage Cloud Mode Transcoding Actions and Functionality
The following transcoding actions can be executed in Vantage or in Telestream Cloud:

• Analyze

• Conform 

• Flip64

• IPTV Flip

• Multiscreen Flip

• Tempo

• Timed Text Flip

When an action is placed in Vantage Cloud mode, the following functionality applies:

• Execution of the action occurs in the specified cloud account and is executed by 
the Cloud Service; not by the service it is normally executed by.

• A vcp-uploads bucket is automatically created in the specified Cloud storage, where 
binders are created to contain local files that have been uploaded for processing.

• The Output Location settings (which pertain only to Vantage execution) are dis-
abled; the Cloud Store settings are used to identify the output bucket. Transport 
actions (Move, Copy, etc.) must be used to perform file operations.

• Open workflow-capable actions don’t operate in Open Mode in Telestream Cloud.

Enabling and Configuring Vantage Cloud Mode and File 
Lifespan

Note: Vantage Cloud mode settings only apply to Cloud-capable actions in hybrid 
workflows executing in Vantage. When you export a workflow into Telestream 
Cloud—creating a hosted workflow—it executes independently of Vantage, and these 
settings must be specified directly in Telestream Cloud.

Cloud-capable actions display a Telestream Cloud badge when Vantage Cloud mode is 
enabled:

Vantage Cloud mode 
badge (displays when 
Vantage Cloud mode 
is enabled.
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To enable Vantage Cloud mode and configure the settings, right-click on the action and 
select Vantage Cloud Mode > Configure Vantage Cloud Mode to display the Vantage 
Cloud Setup dialog.

Configure the following settings:

Enable Vantage Cloud Mode. Check to enable Vantage Cloud mode for this action.

Select the Cloud Account. Specifies the Cloud account to utilize, which must be 
specified in the Vantage Management Console (Settings & Options > Cloud tab).

Select Cloud Storage to Utilize. Specifies the cloud storage bucket to utilize, which 
must be specified as an address in the Vantage Folder Address Book.

Note: The folder you create in the Vantage Folder Address Book must use exactly the 
same name as the storage you identify in the Telestream Cloud account. This is 
required to provide translation of the signed URL specifying the cloud-stored media’s 
location to a URL usable by the subsequent action. 
If matching entries are not included in the Vantage Folder Address Book, the URL 
translation does not occur, and downstream actions may fail. See Managing Vantage 
Folders for configuration details.

Specify Subfolder Path in Storage. Specifies an optional subfolder (bucket) path to 
use when writing files. May be statically specified and/or variables, date and time 
tokens may be applied.

If Vantage displays an error when you attempt to enable Vantage Cloud mode, make 
sure you have added a Vantage Cloud account in the Vantage Management Console 
(Settings & Options > Cloud tab).

Also, you may have configured a Vantage Cloud mode action incorrectly:
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Determine the configuration error and retry.

Specifying Output File Lifespan (Hosted Workflows Only)
In hosted workflows, generated files created by an action, by default, have a permanent 
lifespan and can only be deleted beyond the scope of the workflow. To delete temporal 
output files that you do not want to exist beyond the duration of the job, right-click on 
the action and choose Vantage Cloud Mode > Output Lifespan.

In the Output Lifespan dialog, choose:

• Transient—choose when the material created by this action should be deleted 
immediately after the workflow has completed.

• Permanent—choose when the material should be retained (not deleted) after the 
workflow has completed. In this case, file management is beyond the scope of the 
workflow, Vantage, or Telestream Cloud.

Click OK to save the setting and close the dialog. 

Correcting Unsupported Action Configurations
On occasion, you may configure an action in such a manner or specify a certain action 
plugin (an encoder for example) that can not execute in Telestream Cloud. In these 
situations, Vantage displays an error similar to this:

Reconfigure the action in a way (or using another plugin) to enable it to run in the 
Cloud or process the media locally.
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Troubleshooting Workflow Designer
The following topics describe Vantage conditions and behaviors that you may 
encounter, together with suggested solutions.

Domain name doesn’t display at login

When opening Workflow Designer for the first time, depending on the design of your 
network and the location of your workstation and Vantage database server, the 
Domain login dialog may not display the domain. If this is the case, you can log in by 
using the name or IP address of the server.

Workflow waits indefinitely

Vantage qualification rules can cause an action to fail and the workflow to wait 
indefinitely. This is intended behavior, but if it is troublesome, one workaround is to set 
the qualification rule to OPTIONAL rather than REQUIRED. To do this, open the Vantage 
Management Console and select Services and the desired service. Select the 
Qualification Rules tab for the service and the affected variable in the list. From the 
Qualifier drop-down menu, select Optional. 

Note: For customer service, see Contacting Telestream. You may use the Data 
Collection Utility (Vantage Management Console > Support Utilities > Data Collection). 
You may also use the Change Log or Error Log utilities to provide information during 
your service call.
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Vantage Actions

This chapter describes each of the Vantage services (action groups) and their actions, 
by the type of tasks being performed. Workflow Designer groups actions according to 
the service that executes them (except for actions in the Common group which can be 
executed by all Vantage services).

Some actions are optional and require a specific license.

Note: For detailed help describing specific settings for each action, open the action 
Inspector and click the  icon to display its manual page. 

Topics
■ Tasks—What can you do in a Workflow?

■ Services and Actions
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Tasks—What can you do in a Workflow?
When you begin using Vantage Workflow Designer for the first time, your first question 
is probably, “What can I do with a workflow?” This topic provides a list of many tasks 
you can perform, and the Windows services and actions you use to accomplish them. 

The list is not comprehensive, but it leads you quickly to the most common ones. Some 
actions are available only with an optional licenses, such as Post Producer, 
TrafficManager, Live Capture, Tempo, and others. Contact Telestream Sales or Support if 
you have any questions.

Monitoring Folders and Ingesting Media and Files
You can monitor folders and ingest media or files for processing from a comprehensive 
range of file storage systems

Industry Standard File Systems
• Watch action (Monitor group)—Watch a folder for media or attachments.

• Workorder action (Monitor group)—Perform automated submission of multiple 
jobs in batches based on CSV workorder text files that describe media files, attach-
ments, and variables.

• Associate action (Monitor group)—The Associate action ingests files associated 
with a job and assigns a user-specified nickname.

Special-Purpose File Systems
• Camera Ingest action (Monitor group)—The Camera Ingest action monitors a tar-

get device or directory for new shot files from supported cameras and formats and 
initiates a job each time a complete shot is discovered.

• Capture action and Tape action (Live group option)—Using a Lightspeed Live Cap-
ture Server, captures streaming video from live or tape playback sources and saves 
to files.

Advertisement and Commercial Processing Platforms
• Catch action (Traffic group option)—Monitors a target Traffic directory for media 

associated metadata files and initiates a job when a new media file is discovered.

• Dublist action (Traffic group option)—Monitors the target Traffic directory on the 
specified file system for new dublist files and initiates a dublist processing job each 
time a new dublist file is discovered.

• Syndicate action (Traffic group option)—Transforms sidecar metadata from sup-
ported providers (for example, PitchBlue) into a mezzanine format attachment 
(used by the Syndicate action) that contains episodic metadata information includ-
ing segment timing information.
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• Syndication Forward action (Traffic group option)—processes incoming jobs from 
a traditional syndication source, such as a catch server, and allows for automatic for-
warding of a CML file to a publishing workflow which performs segment extraction 
and processing. This removes the step of manual Workflow Portal interactions 
involving a typical Syndication action workflow in cases where an automated pro-
cess is required or desired.

Avid Platforms
• Asset Monitor action (Avid group option)—Monitors the specified Avid folder for 

new or modified assets to ingest and generates a metadata and/or Telestream MP4 
media file. The Asset Monitor action initiates a job each time a new media asset is 
discovered and generates the required output.

Transcoding Media
Transcoding actions convert media between formats and manipulate media essences 
(digital baseband video and audio). Various transcoding actions provide transcoding 
for different applications, both on-premises and in Telestream Cloud:

• Conform action (Edit group option)—Renders multi-layer video compositions (as 
defined in a Composition Markup Language (CML) file with transition and image 
effects, graphic overlays, and conformed audio. The output is encoded in the speci-
fied CML media format. 

• Flip action (Transcode group)—Mainline, industry standard transcoding of 
decoded digital baseband media into another media encoding format. Includes 
exporting configurations for use in SDK applications. Open Workflow capable.

• Flip64 action (Transcode group)—A 64-bit multi-core-optimized encoder that 
transcodes media from SD to UltraHD and 4K in a broad range of file formats, from 
QuickTime to MPEG-4 and TIFO, including encoding for x264, x265 (H.265 HEVC), 
MXF, and more. Open Workflow capable except when executing in Vantage Cloud 
mode. 

• IPTV Flip action (IPTV group option)— Converts media files to formats for cable/
IPTV/VOD/set-top box applications. Open workflow capable.

• Multiscreen Flip action (Multiscreen group)— Generates Adaptive Bitrate packages 
from media files. Optimizes and delivers multiple bit rates and/or multiple resolu-
tions that may be selectively displayed by the client of a streaming media server. 
Open workflow capable.

• Tempo action (Edit group option)—Re-times file-based media and adjusts the run-
ning time of shows and segments while maintaining program quality. Newly-timed 
media is encoded into the CML-specified output video format. 

Transforming Attachment Files
• Syndicated Media—The Syndicate action (Traffic group) transforms sidecar meta-

data from supported providers (for example, PitchBlue) into a mezzanine format. 
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The mezzanine file contains the relevant episodic metadata information including 
segment timing information. The mezzanine attachment can be utilized by Van-
tage Portal in Syndication mode (Syndication Workflow Portal) or consumed 
directly by other Vantage components.

• Catch action (Traffic group option)—Monitors a target Traffic directory for media 
associated metadata files and initiates a job when a new media file is discovered.

• Dublist action (Traffic group option)—Monitors the target Traffic directory on the 
specified file system for new dublist files and initiates a dublist processing job each 
time a new dublist file is discovered.

Captioning
The Cloud Speech action submits media from Vantage workflows via the Cloud Service 
and the Telestream Cloud API to the Telestream Cloud for speech-to-text conversion. To 
use the Cloud Speech action you must have a Telestream Cloud account and enter the 
account credentials in the Vantage Management Console Settings to enable Vantage to 
access the account. When the Cloud Speech action executes, the input file is uploaded 
and processed according to the Cloud Timed Text Speech project chosen in the Cloud 
Speech action, and the results are returned to the workflow for downstream use.

Analyzing Media
Use the actions in the Vantage Analysis Service to perform essence-level operations 
(black detection, interlace, PSNR, Telecine, etc.), perform DPP validation, etc. and report 
the results for QA and intelligent branching within a workflow to deal with media 
essence non-conformity and other issues.

Manipulating Metadata
You can process metadata label to extracting, creating, and transforming them using 
these actions:

• The Extract action identifies and extracts specific values from structured metadata 
and populates variables for use in downstream actions. The Extract action enables 
you to identify the location in the structured data where the value is located.The 
workflow can ingest an XML or JSON file during job execution or by making web 
service calls. The Extract action automatically generates XPATH or JSONPath refer-
ences from the structured metadata in these files to extract the data, and populates 
a variable with the value. During execution, each extraction path is evaluated 
against the input and the associated variables are populated for use in downstream 
actions. This action is open workflow capable.

• The Populate action enables you to bring media and other files into workflows, cre-
ate metadata labels and variables from file names and labels. You can also transfer 
metadata from job-related system information to variables. 

• The Transform action enables you to transform metadata using XSLT, and to trans-
form metadata between attachments and Vantage labels.For example, you can 
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transform a given XML file (attachment) with the specified XSLT to generate 
another XML attachment. Or, you can convert a Vantage label from one form to 
another.

Note: You can only use style sheets that have been implemented in the Vantage 
domain database—you can't select an XSL style sheet from a file system. You manage 
your XSL style sheets using the Vantage Management Console (Vantage Domain > 
Workflow Design Items > Style Sheets). Before the Transform action can execute, it 
must be configured using the Inspector. This action is open workflow capable.

Performing File Operations
Most of these actions perform file operations on industry-standard file systems, such as 
Windows and FTP, etc. To perform file operations on platforms including Avid and 
others, use Deploy.

• The Copy action duplicates a file (by nickname) to another location, leaving the 
source file in place. Use the Copy action when you need to replicate a file from one 
server or path to another. For example, you have a workflow that is monitoring an 
FTP site for incoming media—but opening and reading a file directly from an FTP 
server by the Flip action is not permitted.

• The Delete action erases the file (or the asset’s file set) identified by nickname from 
its location. The file must have been ingested or created by an upstream action in 
the workflow in order to obtain the nickname.

• The Move action replicates the file (or the asset’s file set) identified by nickname 
from its location to another location, and upon completion, deletes the original. 
The file must have been ingested or created by an upstream action in the workflow 
in order to obtain the nickname. Copying and deleting separately achieves the 
same goal.

• The Deploy action supports the delivery of files or file groups to major platforms, 
where standard file operations are not allowed. These include Avid and social plat-
forms such as Facebook, Vimeo, Twitter and others.

• In addition to supporting major platforms, interaction with many other media-cen-
tric platforms is supported. 

Communication with External Systems
Vantage actions include a comprehensive set of utilitarian actions for communicating 
with external systems of all kinds: 

• You can use actions in the Automate group to communicate with automation sys-
tems including AdID, ASDB, Bxf, Itx, Florical, Pebble Marina, Sundance and others

• Send automated emails pre-formatted for messages, HTML content, and send 
metadata, media and other file attachments, and apply style sheets.

• Transform files into ZIP and TAR files and deliver them to other systems.
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• Externalize data to a wide variety of systems, including automation systems, Dolby 
DP600, Avid, NexGuard, and SeaChange.

• Generate XML and JSON files, and generate text and CSV files.

• Invoke shell scripts, communicate with HTTP servers, and invoke Web Services.

Interacting with Media-Centric Platforms
Vantage enables workflows to interact with a wide variety of media-centric platforms, 
including:

• MediaMate

• Faspex

• Cerify

• Signiant

• FileCatalyst

• AudioTools

• MediaInfo
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Services and Actions
The following topics list each Vantage service and its actions, which are organized by 
group in Workflow Designer. Each action is described under the service that executes it. 

Note: For detailed help describing the functionality in detail, and each setting for the 
action, open the action Inspector and click the  icon to display its man page. 

■ Alchemist Service

■ Analysis Service

■ Aspera Service

■ AudioTools Service

■ Aurora Service

■ Avid Service

■ Baton Service

■ Live Service

■ Catalog Service

■ Cerify Service

■ Cloud Service

■ Common Group

■ Communicate Service

■ Edit (Post Producer) Service

■ emotion Service

■ FileCatalyst Service

■ IPTV VOD Service

■ MediaMate Service

■ Metadata Service

■ Monitor Service

■ Multiscreen Service

■ Nexidia Service

■ Publish Service

■ Pulsar Service

■ Signiant Service

■ Staging Service

■ Timed Text Service

■ Traffic Service

■ Transcode Service

■ Transport Service

■ VidChecker Service
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Alchemist Service
The Alchemist service contains the Alchemist File Action.

Alchemist File Action
The Alchemist File action allows Vantage to interact with an installation of the Grass 
Valley Alchemist software. For configuration and set up details, see the Alchemist File 
app note available on the Telestream website.

Analysis Service
Use these actions (executed by the Analysis Service on behalf of the Telestream 
Transcode & Analysis Engine) in workflows when you want to perform measurements 
on media files, compare media files, or identify the characteristics of media files, and 
publish the results as variables or metadata labels, or set the state of the workflow 
based on the results.

You can publish analysis results in a metadata label within the binder, or you can 
publish results as variables so that they can be used for decision-making, or to supply 
values to settings in other actions. In some cases, you can also set the action state of the 
action based on the results of the measurement.

■ Analyze Action

■ Compare Action

■ DPP Validate Action

■ Examine Action

■ Identify Action

■ MediaInfo Action

■ Report Action

Analyze Action
Use the Analyze action to perform analysis on media using a variety of analysis tools, 
and variables for use downstream, with the result of the analysis. This action is Vantage 
Cloud-capable.

Compare Action
Use the Compare action to examine two media files and determine their differences.

DPP Validate Action
The DPP Validate action is part of the optional DPP license. You can use the DPP 
Validate action to confirm compliance of a DPP metadata XML file. If the XML file passes 
validation, TRUE is generated; otherwise FALSE is generated. You can test the results of 
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the action downstream to change the workflow’s actions based on the validation 
results. Optionally, you can also generate a report.

Examine Action
Use the Examine action to analyze the video and audio of a media file, by selecting a 
given analyzer (black detection, macro-blocking analysis, slate detection, etc.).

Identify Action
Use the Identify action to examine and identify certain media characteristics, or extract 
the properties of a media or attachment file (for example, file name, extension, size, or 
path) or to generate an MD5 hash of a media or attachment file, which you can use to 
compare two files downstream, or in other workflows.

You can also extract metadata (such as Author or Title) from media files.

In addition, you can extract a comprehensive set of properties from media files (for 
example, frame size, frame rate, codec, bitrate, number of audio channels, etc.). 

Extracted values are assigned to variables (which you create in Vantage Management 
Console or directly in Workflow Designer), for use later in a workflow. You can also set 
the workflow state as a result of execution conditions.

MediaInfo Action
Use the MediaInfo action to perform 2 tasks, based on its analysis of the media file and 
its streams: Create variables from properties via the MediaInfo API, and create a report 
of the properties and their values.

In each category, you can produce variables of selected metrics with the results the 
analysis.

Report Action
Use the Report action to generate a report file which contains a list of variables and 
their values.

Aspera Service
The Aspera service contains the Aspera Faspex Delivery Action. 

Aspera Faspex Delivery Action
The Aspera Faspex Delivery action is an optional, licensed feature in Vantage. Aspera 
servers and applications enable secure, high-speed batch file transfers of various file 
types, including media and metadata files. The Aspera Faspex Delivery action is an 
optional, licensed feature in Vantage; it is used to deliver media or other files to Aspera 
systems.
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The Faspex Delivery action is used to deliver media or other files to Aspera Faspex drop 
boxes and users.

Aspera Faspex 5 Delivery Action
The Aspera Faspex 5 Delivery action is an optional, licensed feature in Vantage. Aspera 
servers and applications enable secure, high-speed batch file transfers of various file 
types, including media and metadata files. The Aspera Faspex 5 Delivery action delivers 
media or other files to Aspera Faspex 5 systems.

The Aspera Faspex 5 Delivery action is used to deliver media or other files to Aspera 
Faspex drop boxes and users.

AudioTools Service
The AudioTools service contains the AudioTools Action.

AudioTools Action
The AudioTools action is an optional, licensed feature in Vantage. It uses the AudioTools 
Service to enable Vantage workflows to utilize and interact with various AudioTools 
products from Minnetonka Audio Software. The AudioTools Custom Workflow executes 
a selected, pre-defined AudioTools Server workflow. AudioTools Loudness Control 
executes the typical loudness processes, including hitting multiple target parameters 
using an iterative processing pass.

Aurora Service
The Aurora service contains the Aurora Action.

Aurora Action
The Aurora action is an optional, licensed feature in Vantage. It uses the Vantage Aurora 
Service to utilize and interact with various QC tests provided by the Digimetrics Aurora 
software. The tests provide the ability to determine whether a particular input media 
(specified by nickname) either passes or fails a particular QC check. Each test also 
generates a report file that may be utilized during later stages of the workflow.

Avid Service
Use these actions (executed by the Vantage Avid Service) in Vantage workflows to 
process media interactively with Avid servers:

■ AAF Action— Ingest incoming AAF files and process the MXF folder referenced in 
the AAF file.

■ Asset Monitor Action—Ingest into Vantage new media stored on an Avid server.

■ Media Creation Action—Check in media created in a Vantage workflow to an Avid 
server.
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Before you can use these actions in a Vantage workflow with a given Avid server, you 
must first create and configure an Avid connection in the Vantage Management 
Console > Settings & Options >Avid panel.

AAF Action
The AAF action ingests incoming AAF files and processes the MXF folder referenced in 
the AAF file. Avid Media Composer then utilizes Persistent Media Record (PMR) files for 
information about the online status of file Media Object information (MOB). Each PMR 
file provides an index in a form that an editor can quickly load all the file MOBs and their 
associated media files in the media directory in which the PMR file resides.

Media Creation Action
The Media Creation action delivers new media to the specified Avid server and issues 
Interplay commands to check the file into the Avid server. Settings in the action 
determine which file nickname to look for and specify the Interplay server details to 
allow logging in and placing the file.

Asset Monitor Action
The Asset Monitor is an Open Workflow capable origin action that monitors the 
specified Avid server for new files to ingest. When a new file is discovered, the Asset 
Monitor action submits the file as a job for the workflow to process. The action 
generates the processed output in a CML (Interplay Metadata) or MPEG-4 Reference file 
media descriptor format. 

Settings in the action specify where on the Avid server to find the file, which file type to 
look for, how often to scan for new files, and so on. The Outputs section includes 
settings to specify the CML (Interplay Metadata) or MPEG-4 Reference file format, the 
output location, file name, and nickname.

Baton Service
The Baton service contains the Baton Action.

Baton Action
The Baton action is an optional, licensed feature in Vantage. It uses the Baton Service to 
enable Vantage workflows to utilize and interact with various QC tests provided by the 
Baton software. The tests provide the ability to determine whether a particular input 
media (specified by nickname) either passes or fails a particular QC check. Each test also 
generates a report file that may be utilized during later stages of the workflow.

Live Service
The Live service contains the Capture and Tape Actions and the SubClip action.
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Capture and Tape Actions
The Capture and Tape actions are origin actions. Capture actions are executed by the 
Vantage Live Service on a Lightspeed Live Server equipped with the Live Capture 
option. Capture actions support Open Workflows on the outbound side and are used to 
capture Lightspeed Live Capture server's live SDI input or an IP media stream delivered 
over Ethernet, and output captured media files to Live Storage using the specified 
output container and encoder.

The Capture action may be included in workflows created in Vantage domains with the 
Live Capture option installed on a Lightspeed Live Capture server. The Capture action 
Inspector allows you to select and configure live streams for processing, filtering, 
transcoding, and output. See the Lightspeed Live Server Guide for more details.

The Tape action is used to start SDI tape capture workflows created in a Vantage 
domain installed on a Lightspeed Live server. The Tape action Inspector allows you to 
select and configure VTR sources for processing, filtering, transcoding, and output. You 
can also use the action to add metadata labels.

SubClip Action
The SubClip action allows for sub clip editing of high resolution files based on edit 
decisions made from within the Live Edit web app user interface. The SubClip action is 
used with media created by a Capture action. The Live Edit web app UI utilizes an HLS 
proxy created by the Capture Action and served to the Live Edit UI via an Origin server.

This action is open workflow capable if the Open Workflows license is installed; right-
click the action and select Workflow Mode > Open. Open Workflows must also be 
enabled for the current workflow and in the Vantage Management Console Settings. 

Catalog Service
Catalog actions enable you to query a Vantage catalog to determine if a binder exists, 
and also to register a binder in a catalog. These actions executed by the Vantage 
Catalog Service:

■ Remove Action

■ Exist Action

■ Register Action

Remove Action
A Remove action is executed by the Catalog Service, and is used to permanently 
remove a binder from the catalog and set the associated file resources to expired. If the 
action succeeds, it emits an action state of Success; otherwise, Failure. 

This action is Open Workflow capable if the Open Workflows license is installed.
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Exist Action
Use the Exist action to determine if a binder of the same name already exists, thus 
indicating that a job has already run on the same media file. 

This action is Open Workflow capable if the Open Workflows license is installed.

Register Action
The Register action adds the workflow binder generated by each job to a specified 
Vantage catalog. This allows Vantage to preserve the binder—and all files it 
references—even after a job expires (which deletes the associated binder by default). 
This is also how binders become accessible to operators in Workflow Portal. For details 
about Workflow Portal, see Using Workflow Portal. 

This action is Open Workflow capable if the Open Workflows license is installed.

Cerify Service
The Cerify service contains the Cerify Action.

Cerify Action
The Cerify action is an optional, licensed feature in Vantage. The Cerify action enables 
Vantage to interact with the Tektronix Cerify suite of QC components.

Cloud Service
The following actions utilize the Cloud Service and the Telestream Cloud API to provide 
interactive processing with the Telestream Cloud.

■ Cloud Speech action

■ Location action

■ Cloud Qualify action

Cloud Speech action
The Cloud Speech action submits media from Vantage workflows via the Cloud Service 
and the Telestream Cloud API to the Telestream Cloud for speech-to-text conversion. To 
use the Cloud Speech action you must have a Telestream Cloud account and enter the 
account credentials in the Vantage Management Console Settings to enable Vantage to 
access the account. When the Cloud Speech action executes, the input file is uploaded 
and processed according to the Cloud Timed Text Speech project chosen in the Cloud 
Speech action, and the results are returned to the workflow for downstream use.

Location action
The Location action, part of the Cloud group and executed by the Cloud Service, 
generates Boolean variables indicating a media file’s storage location in the cloud or on 



Vantage Actions
Services and Actions

148

premises. This information may be used to execute a given branch based on location. 
The Location action can also generate pre-signed URLs for files in cloud or object 
storage.

Cloud Qualify action
The Cloud Qualify action, part of the Cloud group and executed by the Cloud Service, 
provides quality control functionality using the Encoding.com cloud platform and 
content present in cloud storage.

Common Group
Common actions are light-weight, short duration, utilitarian actions that are 
implemented in multiple Vantage services (Catalog, Communicate, Staging, and 
Metadata) so that any of those available services can execute them quickly and 
efficiently.

■ Compute Action

■ Construct Action

■ Decide Action

■ Delay Action

■ Forward Action

■ Multi-Decide action

■ Receive Action

■ Synchronize Action

■ Utilization action

Compute Action
A Compute action is a Vantage Cloud-capable action. It uses variables to set other 
variables. For example, you can use Compute to add two numbers and assign the result 
to the selected variable. Compute can perform mathematical operations such as 
addition, subtraction, division and multiplication. It can also convert variables between 
types (such as converting a time code to a string), string manipulation, such as 
appending strings together into an output variable, and comparison functions. 

This action is Open Workflow capable if the Open Workflows license is installed.

Construct Action
A Construct action is a Vantage Cloud-capable action. It enables you to construct 
complex strings, paths, and math expressions from literals, variables, and tokens, for 
use in downstream actions. 

This action is Open Workflow capable if the Open Workflows license is installed.
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Decide Action
A Decide action is a Vantage Cloud-capable action. It sets the action state based upon 
variables. It is commonly used to determine whether or not a branch in a workflow 
should execute (it sets the Success state) or not (it sets the Ignore state).

For example, if one branch is for HD, it will start with a Decide action that will set the 
state to Success for HD content, ignore otherwise; if another branch is for everything 
else, it will start with a Decide action that performs the opposite behavior.

Delay Action
The Delay action provides the ability to delay the workflow for a fixed number of 
seconds before continuing. The Delay action operates in Open Workflow mode; for 
example, if you set a 60 second delay, the action will turn green, delay 60 seconds, then 
propagate the Open signal to the next action.

Forward Action
A Forward action starts a new job for the target workflow, delivering a binder and all 
current variables from the originating. A Forward action can only be added to the end 
of a workflow, and requires that the target workflow has a Receive action as its first 
action.

The Forward action is the only terminating action in Vantage—it does not have a 
connecting pin on the right side. Thus, once you add a Forward action to a workflow (or 
branch in a workflow), you cannot add any more actions, because control has passed to 
another workflow with a Receive action as its origin action.

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to chain 
workflows enables you to create run-time customizable workflows consisting of smaller 
workflow building blocks.

Multi-Decide action
The Multi-Decide action is a Vantage Cloud-capable action. It simplifies a branching 
Vantage workflow by allowing multiple phases of Boolean logic called Decision Groups 
to be implemented within a single action. One Multi-Decide action can evaluate many 
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different groups of variables and set a Result variable to represent the evaluation result 
for each group. 

A key feature is that the Decide Groups defined in the action can be chained together, 
similar to Compute and Construct actions, so that the Result variable of one group 
within the action can feed the input conditions of a subsequent group within the same 
action. This provides powerful internal logical processing within a single Multi-Decide 
action. The variable values resulting from a Multi-Decide action can trigger any of 
several branches in a workflow.

As an example, a Multi-Decide action can implement internal logic as follows to trigger 
downstream workflow branches: IF the Video Format is MXF AND the Video Framerate 
is 60, THEN IF the Bitrate is 35 MB/sec, trigger branch 1; IF the Bitrate is 50 MB/sec, 
trigger Branch 2; otherwise, Trigger Branch 3. IF the Video Format is NOT MXF or the 
Framerate is NOT 60, Trigger Branch 4. The Multi-Decide greatly reduces the number of 
Decide actions required per workflow because many expressions can be grouped into a 
single action. 

Receive Action
The Receive action is a Vantage Cloud-capable action. It is similar to a Watch action in 
that it starts jobs. Unlike a Watch action, it allows you to ingest a file from an external 
program and submit it for processing. 

Methods you can use to submit jobs to a Receive-based workflow:

• Another workflow

• A Vantage SDK-based program

• Workflow Portal

Like a Watch action, you can also drag and drop a file on it to start a job. 

The ability to chain workflows enables you to create run-time, customizable workflows 
consisting of smaller workflow building blocks. When you chain workflows, you can 
also pass binders and variables between them.

Note: An origin action is required as the first action in a workflow, even if you plan to 
only manually submit jobs to this workflow.

Synchronize Action
The Synchronize action is a Vantage Cloud-capable action. It is used in workflows 
where multiple actions connect to multiple subsequent actions. Synchronize provides 
a common connection point, where all upstream actions need to be connected to all 
downstream actions.

Utilization action
A Utilization action enables users to determine the relative load on the domain as well 
as transcoding services within the domain. Other downstream actions can then make 
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intelligent branching decisions based on that information: Cloud versus on-premises 
transcoding of media, for example.

Communicate Service
Communicate actions are used to communicate with external systems. They are 
executed by the Communicate Service.

■ Automate Action

■ Message Action

■ Notify Action

Automate Action
The Automate action, which is executed by the Communicate Service, is similar to the 
Notify action. It contains system-integration extensions which are relevant to 
TrafficManager workflows, enabling you to save job or other metadata to a file and 
interface/integrate with external automation systems. This capability ranges from 
writing XML-based material to a file system to direct integration with specific 
automation systems.

In TrafficManager applications, this action is useful to notify automation systems that a 
commercial has been processed and is available for air. For example, a Notify action can 
create text or CSV dublists and provide them to automation systems that are capable of 
processing dublists in that format. 

Each extension has specific features which are detailed in the manual page for the 
extension.

Message Action
A Message action enables you to generate and transmit an electronic message—an 
email, for example. You must configure Vantage to use an SMTP server before email can 
be utilized; this can be done in the Vantage Management Console. 

This action is Open Workflow capable if the Open Workflows license is installed.

Notify Action
A Notify action transfers job information to external systems via Web Services or other 
methods to transfer data. The job information may also be transferred via an XML file or 
files of other formats. You can also use the Notify action to invoke a command shell. 

This action is Open Workflow capable if the Open Workflows license is installed.
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The Notify action is extensible, and can communicate with a wide variety of systems 
and generate various files as well as invoke services. These are the available functions: 

– Automation File Notifier—Creates a notification file based on specific criteria.

– BXF File Notifier—Creates a BXF file based on specific criteria.

– Cloud Notifier—Post notifications from Vantage workflows to cloud aggregation 
endpoints.

– Dolby DP600 Notifier—Submit work orders to a Dolby DP600 via web services.

– Dump—Dump an XML file describing the current job.

– External Shell Notifier—Invoke an External Command Shell.

– HTTP Notifier—Invoke a command on a remote server via HTTP.

– Interplay Notifier—Invoke an Avid Web Service method.

– Invoke—Invoke external programs/scripts via command line while generating 
new Vantage nicknames, custom file schemas, and variable values.

– Avid MOBID Generator Notifier—Generate MOB ID Variables.

– NexGuard Notifier—Invokes a NexGuard web service method.

– SeaChange MVL Notifier—Invoke the SeaChange MVL Notifier.

– Text/CSV Report Notifier—Generates text file reports from workflow variables.

– WebService Notifier—Invoke a web service method.

The TrafficManager-centric extensions are implemented in the Automate action, but 
are also available in the Notify action for backward-compatibility.

Edit (Post Producer) Service
Edit actions are components of Vantage Post Producer, an optional, licensed feature. 
These actions are executed by the Edit Service, and may run on a Vantage Lightspeed 
Server or a standard Vantage server. 

■ Chronicle Action

■ Colocate Action

■ Compose Action

■ Conform Action

■ Tempo Action

Chronicle Action
The Chronicle action converts a post-rendered Composition XML file into formats for 
use in other systems—ad-insertion systems, for example.

Colocate Action
The Colocate action converts a Composition XML file with non-file-based URLs (for 
example, Amazon S3) and localizes the media and produces a modified CML file with 
the URLs converted to the localized file paths. 
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This action is Open Workflow capable if the Open Workflows license is installed.

Compose Action
The Compose action converts various media descriptor file formats: Anystream AN2, 
Final Cut Interchange XML, Simplified Avid AAF, QuickTime Reference, Adobe FC7XML, 
and Telestream TSEDL) into a Composition XML file so that it can be used by the 
Conform action to compose media. This action is Open Workflow capable if the Open 
Workflows license is installed.

Conform Action
The Conform action assembles and optionally transcodes multiple video and still 
image files into a single output file, applying filters as specified by you. The input files 
and related instructions for the output file are all defined in a Composition XML file.

This action is Open Workflow capable if the Open Workflows license is installed. The 
Conform action is also Vantage Cloud-capable.

Tempo Action
The Tempo action is part of the Edit group. All actions in the Edit group are executed by 
the Edit service. The Tempo action is included in Tempo, a time-adjusting encoding 
solution built on the Vantage platform. The Tempo action uses the Edit Service for re-
timing file-based content and intelligently decreasing or increasing the running time of 
shows and segments. This action is Open Workflow capable if the Open Workflows 
license is installed. The Tempo action is also Vantage Cloud-capable.

emotion Service
The emotion service contains the emotion Action. 

emotion Action
The emotion action is an optional, licensed feature in Vantage. The emotion action 
enables Vantage to utilize and interact with Emotion Systems Emotion Engine audio 
software. 

FileCatalyst Service
The FileCatalyst service contains the FileCatalyst Action.

FileCatalyst Action
The FileCatalyst action is an optional, licensed feature, which enables Vantage 
workflows to access and deliver files to FileCatalyst servers via integrated FileCatalyst 
client software.
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IPTV VOD Service
The IPTV VOD group contains the IPTV Flip Action.

IPTV Flip Action
The IPTV Flip action (in the IPTV VOD category) is included with the Cable / IPTV version 
of TrafficManager. IPTV transcoding is designed for generating MPEG2 Transport 
Stream files and meeting multiplexing requirements. The IPTV Flip action is executed 
by the IPTV VOD Service, which can optionally run on a Lightspeed Server for GPU-
accelerated x264/x265 encoding and video processing. 

The IPTV Flip action and IPTV VOD Service supports the features required to handle 
varying IPTV, set-top box and cable encoding requirements, and ancillary metadata 
specific to cable ad splicing and cable/IPTV set-top box environments. Transcoding is 
performed by the Telestream Media Transcode and Analysis Engine on behalf of 
Vantage.

This action is Open Workflow capable if the Open Workflows license is installed. The 
IPTV Flip action is also Vantage Cloud-capable. 

MediaMate Service
The MediaMate service contains the MediaMate Action.

MediaMate Action
The MediaMate action enables you to implement screen subtitling. This is an optional, 
licensed feature. The MediaMate action is used to provide screen subtitling, by utilizing 
various subtitling systems from Screen.

Metadata Service

Metadata Action
Metadata actions are an optional, licensed feature available in certain Vantage editions. 
They are used to extract or modify metadata values, and perform conversions between 
attachment files, metadata labels, and variables. These actions are executed by the 
Metadata Service.

■ Extract Action

■ Lookup Action

■ Populate Action

■ Transform Action
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Extract Action
The Extract action is a Vantage Cloud-capable action. It is used to extract specific values 
from element attributes in XML or key-value pairs in JSON-formatted metadata files. 
The Extract action identifies and extracts specific values from structured metadata and 
populates variables for use in downstream actions. The Extract action enables you to 
browse a sample file and identify the location in the structured data where the value is 
located.

The workflow can ingest an XML or JSON file during job execution or by making web 
service calls. The Extract action automatically generates XPATH or JSONPath references 
from the structured metadata in these files to extract the data, and populates a variable 
with the value. During execution, each extraction path is evaluated against the input 
and the associated variables are populated for use in downstream actions.

This action is Open Workflow capable if the Open Workflows license is installed.

Lookup Action
The Lookup action performs a search operation on a set of key-value pairs in a master 
CSV file, based on values extracted from the metadata file associated with a job 
submission. Lookup is typically used in TrafficManager applications. 

Populate Action
Populate actions transform data between variables, attachment files, and metadata 
labels. During ingest, metadata labels can be added to ingested media and generally 
include trim information, audio levels, file properties, and commercial metadata. The 
metadata labels can then be reviewed and modified by operators using Workflow 
Portal. At any stage of a workflow, Vantage can extract information from labels using 
the Populate action, allowing Vantage to, for example, trim clips during a transcode or 
use audio level limits to dampen audio when creating a broadcast asset. 

This action is Open Workflow capable if the Open Workflows license is installed.

Transform Action
A Transform action transforms data between XML files (ingested into the job as 
attachment files) and labels. XSL style sheets are used to perform these 
transformations. 

This action is Open Workflow capable if the Open Workflows license is installed.

Note: The Transform action is available in Metadata and Transcode Connect licenses. 
You can only use style sheets that have been imported into the database; you cannot 
reference XSL files directly. The Vantage administrator manages your XSL style sheets 
using the Vantage Management Console (Vantage Domain > Workflow Design Items 
> Style Sheets).
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Monitor Service
Monitor actions are used to identify and ingest files to be processed by a workflow, and 
in the case of the Watch action, start jobs for this workflow. They are executed by the 
Monitor Service.

■ Associate Action

■ Camera Ingest Action

■ Listen Action

■ Watch Action

■ Workorder Action

Associate Action
An Associate action uses the Monitor Service to poll a target location (a directory, for 
example) on a device or file system (FTP, network folder, etc.) to discover new files in the 
context of a job.

Often, an Associate action follows a Watch action, and utilizes the file name of an 
existing media file or attachment as the basis for discovering new files; for example, if 
media file Vantage.mpg is currently in the workflow, then the Associate action may look 
for Vantage.scc. The Watch action can publish the file name as a variable, and pass it to 
the Associate action to pick the corresponding file (the file extension must be dropped 
to accomplish this). The required file match pattern can be configured in the Associate 
action's Inspector.

When Associate actions are executing, subsequent actions must wait until a file is 
found or a time-out occurs. When a new file is discovered, the Associate action ingests 
the file, assigns a nickname, and makes the file available to other actions in the 
workflow.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow—Associate is not an origin action.

Camera Ingest Action
A Camera Ingest action is an origin action; it uses the Monitor Service to regularly poll a 
target location (a directory, for example) on a card reader device or Windows file system 
to discover new camera files of supported formats, including reference files. You can 
also manually submit jobs to workflows beginning with a Camera Ingest action.

Note: Each Camera Ingest action is configured to detect a specific camera file format. 
If the target contains both P2 AVC-Intra and XDCAM EX files, two Camera Ingest 
actions are required.

When a new file or shot is discovered, the Camera Ingest action submits a job for the 
workflow which it is part of, for processing.
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The Camera Ingest action has features including stitching individual shots (including 
self-contained, split, and spanned clips), and controlling whether camera content is 
broken into individual sections, or treated as a single unit.

You can check a box in the Inspector to turn on logging for such errors as watching a 
non-existent directory or failure to submit a file.

Listen Action
The Listen action uses the Vantage Monitor Service to listen to a cloud-based message 
queue and generate jobs from received messages. The Listen action uses a plugin 
model for various cloud endpoints such as Amazon Simple Queue Service (SQS).

The content of these messages could be very simple and contain a single value such as 
a file path or some sort of identifier to be used, or they could be more complex such as 
a blob of json/xml to be processed by a downstream action such as Extract.

The Listen action automatically deletes messages from the queue as it processes them. 
Any messages that are present in the queue when the Listen action starts up will be 
processed.

Watch Action
A Watch action is an origin action, which uses the Monitor Service to continually (and at 
regular periods) poll a target location (a directory, for example) on a device or file 
system (FTP, network folder, etc.) to discover new files. 

The Watch action submits a job to the workflow which it is part of, when:

• A new file is discovered in the target folder

• You manually submit a file to the workflow

• You drag and drop a file on the Watch action in the workflow

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

This action is Open Workflow capable if the Open Workflows license is installed. 

You can check a box in the Inspector to turn on logging for such errors as watching a 
non-existent directory or failure to submit a file.

Workorder Action
A Workorder action is an origin action; it uses the Monitor Service to regularly poll a 
target Windows directory for new workorder files to process. The Workorder action 
provides a simple and highly effective method of submitting multiple, similar jobs 
without using the SDK. 

When a new file is discovered, the Workorder action submits one job for each row in the 
file.
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You can check a box in the Inspector to turn on logging for such errors as watching a 
non-existent directory or failure to submit a file.

Multiscreen Service
Multiscreen actions, executed by the Multiscreen Service, are used to produce high-
quality, industry-standard, adaptive rate streaming formats, including digital rights 
management. 

■ DRM Action

■ Multiscreen Flip Action

DRM Action
The DRM action is part of the Multiscreen group, and is executed by the Multiscreen 
Service. You use the DRM action to execute a script that utilizes input data and 
generates a JSON string. The string contains the information required to encrypt 
streaming media with DRM (digital rights management) in Multiscreen workflows.

Scripts are created externally in a supported language and added to a Vantage domain 
via the Vantage Management Console > Workflow Design Items > Scripts. The specified 
script is executed in the DRM action, generating the output into a text variable for use 
in a downstream Multiscreen action. Multiscreen Flip uses the output of the script 
when encoding the media.

Multiscreen Flip Action
The Multiscreen Flip action is an optional, licensed feature. Multiscreen Flip actions are 
executed by the Multiscreen Service. The Multiscreen service may run on a Vantage 
Lightspeed Server or a standard Vantage server. 

This action is Open Workflow capable if the Open Workflows license is installed. The 
Multiscreen Flip action is also Vantage Cloud-capable.

The Multiscreen Flip action allows you to encode and package decoded digital 
baseband media into industry-standard adaptive rate streaming formats, including 
Adobe HDS, Apple HLS, Microsoft HSS, and others. Transcoding is performed by the 
Telestream Media Transcode and Analysis Engine on behalf of Vantage.

Nexidia Service
The Nexidia group contains the Nexidia Action.

Nexidia Action
The Nexidia action is an optional, licensed feature in Vantage. It uses the Vantage 
Nexidia Service to interact with Nexidia QC servers running Nexidia QC software. The 
specified input files are passed to the Nexidia QC software where they are analyzed 
using the test profile selected.
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Publish Service
The Publish group contains the Stanza Action and Frame.io Action.

Stanza Action
The Stanza action allows Vantage to create new projects within an installed server 
instance of Stanza. For more information on Stanza server installations and 
configurations, see the Stanza page on the Telestream website for details. 

Frame.io Action
The Frame.io action is an optional, licensed feature which allows for the creation and 
delivery of assets, between Vantage and the Frame.io online hub for organization and 
collaboration around media assets.

Pulsar Service
The Pulsar group contains the Pulsar Action.

Pulsar Action
The Pulsar action is an optional, licensed feature which enables broadcasters to 
integrate the Pulsar suite of content verification components directly in Vantage 
workflows.

Signiant Service
The Signiant group contains the Media Shuttle Action and Signiant Delivery Action.

Media Shuttle Action
The Media Shuttle action is an optional, licensed feature which allows for automated 
Media Shuttle accelerated file transfers among a specified list of users using Vantage 
workflows. 

Signiant Delivery Action
The Signiant Delivery action is an optional, licensed feature which enables Vantage 
workflows to deliver files to Signiant-enabled servers. The Signiant Delivery action is 
executed by the Signiant Service, and uses the Signiant Content Transfer Engine (CTE) 
feature, which must be licensed on the Signiant server.

Staging Service
The optional, licensed Staging Service actions are responsible for file operations in 
preparation for moving files to other systems/platforms with special packaging 
requirements. They are executed by the Staging Service:
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■ Archive Action

■ Gather Action

Archive Action
Use the Archive action to convert the selected input file to another format, usually in 
preparation for copying, moving, or deploying a file to a given system that has special 
file format requirements. The Gather action is only enabled with the optional, licensed 
Metadata option.

Gather Action
Use the Gather action to collect one or more files from a specified server and directory 
(and optionally, its sub-folders), and bring them into the workflow as attachments. Use 
of a file matching pattern allows you to select only certain types of files. The Gather 
action is only enabled with the optional, licensed Metadata option.

Timed Text Service
The Timed Text group contains two actions: Timed Text Conform and Timed Text Flip.

■ Timed Text Conform Action

■ Timed Text Flip Action

Timed Text Conform Action
Use the Timed Text Conform action to ingest a Timed Text CML file with references to 
caption/subtitle files in order to create SCC, MCC, or IMSC outputs. This action is 
Vantage Cloud-capable.

Timed Text Flip Action
Use the Timed Text Flip action to automate caption file-type conversions, extract 
caption data from media with embedded captions, create subtitle overlay graphics, and 
manipulate the timecode of caption data to match media. This action is Vantage Cloud-
capable.

Traffic Service
The following actions are executed by the Traffic Service and are a component of 
TrafficManager, an optional, licensed feature. Catch and Dublist actions monitor catch 
servers and dublist servers for new files. These actions are both origin actions. The 
Syndicate action processes metadata files for syndicated media processing.

■ Catch Action

■ Dublist Action

■ Syndicate Action

■ Syndication Forward Action
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Catch Action
Use the Catch action (an origin action) to select a catch server, and configure the action 
to monitor it for new commercials and syndicated content arriving from the publisher, 
expose all relevant metadata, and submit the commercial for processing in 
TrafficManager workflows. The Catch action is part of TrafficManager; an optional, 
licensed feature of Vantage.

The Catch action submits a job to the workflow which it is part of, when:

• A new file is discovered in the target folder.

• You manually submit a file to the workflow.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

You can check a box in the Inspector to turn on logging for such errors as watching a 
non-existent directory or failure to submit a file.

Dublist Action
Use the Dublist action (an origin action) to perform dublist processing in 
TrafficManager workflows. The Dublist action is part of TrafficManager, an optional, 
licensed feature of Vantage.

In the Dublist action’s inspector, you can select a dublist system or server as the target, 
and configure the action to monitor it for new dublists, which it resolves with the 
standing dublist. 

The Dublist action submits a job to the workflow which it is part of, when:

• A new file is discovered in the target folder

• You manually submit a file to the workflow

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

The Dublist action uses the binder name as the unique identifier for the commercial, so 
it should be set to the Ad ID.

You can check a box in the Inspector to turn on logging for such errors as watching a 
non-existent directory or failure to submit a file.

Syndicate Action
Use the Syndicate action in syndicated media ingest workflows to convert sidecar 
metadata XML files to a mezzanine format for use in downstream actions in the 
workflow, or for use in Syndicated Workflow Portal applications. The Syndicate action is 
part of TrafficManager, an optional, licensed feature of Vantage.



Vantage Actions
Services and Actions

162

In the Syndicate action Inspector, you can specify the type of metadata file being 
transformed, and configure the action to utilize specific templates for processing. 

Syndication Forward Action
Use the Syndication Forward action to process incoming jobs from a traditional 
syndication source, such as a catch server, and allow for the automatic forwarding of a 
CML file to a publishing workflow which performs segment extraction and processing. 

Transcode Service
The following actions are in the Transcode action group and are executed by the 
Transcode Service:

■ Flip Action

■ Flip64 Action

Flip Action
The Flip action is a broadly-used, general-purpose transcoding action, executed by the 
Transcode Service (which in turn utilizes the Telestream Transcode & Analysis Engine for 
this particular action). Use the Flip action to create media of a new format, and save it as 
a file, using a prescribed codec profile. How you configure the encoder depends on the 
encoder you choose. 

This action is Open Workflow capable if the Open Workflows license is installed.

Flip64 Action
The Flip64 action is a 64-bit multi-core-optimized encoder that transcodes media from 
one or more input files into another format as specified by the output configuration. 
Available resolutions extend from SD to UltraHD and 4K in a broad range of file formats, 
from QuickTime to MPEG-4 and TIFO, and including encoding for x264, x265 (H.265 
HEVC), MXF, and many more. This action is Open Workflow capable if the Open 
Workflows license is installed. The Flip64 action is Vantage Cloud-capable. 

Transport Service
Transport actions are executed by the Transport Service and perform file operations on 
specified files.

■ Copy Action

■ Move Action

■ Delete Action

■ Deploy Action
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Copy Action
Use the Copy action to duplicate a file from one directory to another directory on a 
given file system. The new file can be tracked by the workflow—that is, referenced in 
the binder. As a result, the new file must be given a nickname. 

This action is Open Workflow capable if the Open Workflows license is installed.

Move Action
Use the Move action to remove a file from one directory and place it in another. You can 
optionally specify a different destination nickname during the move.

Delete Action
Use the Delete action to delete a file on the specified file system. This action also 
removes the file reference from the binder.

Deploy Action
The Deploy action copies one or more files to a destination in a single step, and may 
perform additional custom steps depending upon the type of deployment.

Deployed files are not referenced in the binder, and are not tracked after the action 
completes.

VidChecker Service
The VidChecker group contains the VidChecker Action.

VidChecker Action
The VidChecker action is an optional, licensed feature which enables broadcasters to 
integrate VidChecker, automated QC and intelligent automated correction, directly in 
Vantage workflows.
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Monitoring Workflows and 
Managing Jobs

The topics in this chapter describe how to submit jobs, monitor workflows, and manage 
jobs in Workflow Designer.

Topics
■ Submitting Jobs to Workflows

■ Monitoring Workflow Status & History

■ Monitoring and Managing Jobs

■ Generating Job Reports Manually

■ Managing Job Report Configurations

■ Viewing the Domain Summary

■ Viewing Binders and their Assets

■ Controlling Action Execution in Jobs

■ Viewing Action Status

Note: In addition to submitting jobs in Workflow Designer, you can also submit jobs 
by dropping media files into target directories, or by using the Dublist Portal and the 
Workflow Portal clients. You can also submit jobs from other programs using the 
Vantage SDK. 

Note: You can also monitor and manage jobs using the Job Status Views web 
application. See Using the Job Status Views Web Application.
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Submitting Jobs to Workflows
This topic discusses the various methods used to submit media or other types of files to 
Vantage workflows for processing. You can submit jobs in the following ways: 

• Directly in Workflow Designer using various methods. See Manually Submitting Files 
Directly in Workflow Designer, following.

• Automatically, by adding files to directories monitored by active workflows.

• As a batch, by submitting a workorder file to a Workorder-based workflow. See Sub-
mitting Files as a Batch, following in this topic.

• From Workflow Portal client applications. See Using Workflow Portal and Workflow 
Portal Web Application.

• From Dublist Portal. See the TrafficManager User Guide.

• From third-party or custom programs using the Vantage SDK.

Manually Submitting Files Directly in Workflow Designer
To submit files manually to a workflow for processing directly in Workflow Designer 
(which starts a new job for each file submitted), do one of the following:

• Drag and drop the selected file or files from a Windows Explorer directory directly 
onto the origin action of the target workflow. See Submitting Files via Drag and 
Drop.

• Select the workflow and click the Submit Job button. See Submitting Files via the 
Submit Button.

Note: The file(s) you submit aren’t always media files; though they commonly are. You 
can manually submit any file that the workflow can process. It might be an XML file 
(metadata, for example). Or, it might be a workorder file for a Workorder action 
workflow, for submitting several jobs at once. It also may be some other form of file, 
based on your workflow.

Submitting Files via Drag and Drop
To submit files for processing using drag and drop, follow these steps:

1. In Workflow Designer, select the target workflow (which must be active) to display 
it in the Workflow Design workspace.

2. In Windows Explorer, navigate to the directory where the file or files that you want 
to process are stored.
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3. Select one or more files and drag them over the origin action in the workflow.

4. When the origin action highlights (displays a bright green border), drop them onto 
the action to submit them for processing.
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Vantage displays a confirmation dialog when all jobs have been submitted:

Click OK to dismiss the dialog; then display the Job Status workspace to track your jobs.

Submitting Files via the Submit Button
To submit a file to an activated workflow manually, follow these steps:

1. Select the target workflow in the Workflows panel.

2. Click the Submit Job button as shown below.

In a multiple origin action workflow, Workflow Designer displays a dialog that lists 
the origin actions. 

Click the Submit Job 
button to select 
media files for 
processing with the 
selected workflow.
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3. Select the action you want to start the job, then click Next to continue.

For a multi-file workflow (for example, a Receive-based workflow that expects more 
than one file), Workflow Designer displays this Submit Job dialog:

Enter or browse and select the file for each nickname and proceed to Step 6. 

For a single-file workflow, Workflow Designer displays the Submit Job dialog:



Monitoring Workflows and Managing Jobs
Submitting Jobs to Workflows

170

4. Select the type of file system (or a Vantage folder) where the input file or files are 
stored, and click Next.

Workflow Designer displays the Windows Explorer window:

5. Navigate to the server and directory, and select one or more directories and/or files 
for processing and click Open. Click Browse to add more files or click Clear to start 
over. As you select files, they are added to the list:
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6. When the list is correct and you’re ready to submit them, click Next. 

7. Optionally, click Variables to manually add variables with values for this job. The 
variables must be identified in actions. These variables are initialized to the default 
value of the variable definition in the domain, and the value may be changed by 
actions in the workflow. For details, see Utilizing Variables in an Action.

8. Click Submit to submit the file(s) for processing.

Vantage displays a confirmation dialog when all jobs have been submitted:

When you have submitted the job(s), you can view their progress in the Job Status 
workspace (see Monitoring and Managing Jobs).
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Submitting Files as a Batch
To submit a batch of files to a workflow for processing (which starts a new job for each 
file entry in the workorder submitted), you use a Workorder action as the origin action 
in the workflow, and you create workorder files (a CSV file) to identify those files you 
want processed. Next, you can use any method you like to submit the file for processing 
to the active workflow.

The Workorder action enables automated submission of multiple jobs in batches. For 
example, you can use a workorder-based workflow to process multiple media files, 
without manually adding the files to a target directory—instead, you just submit a 
workorder file, which contains a job entry for each media file you want to process. The 
Workorder action initiates one or more jobs each time a new workorder file is 
discovered (based on the number of job entries in the file) and passes control to the 
next action in the workflow. Workorder files must be conform to the schema specified 
in the selected workorder scheme. Workorder schemas are created in the Management 
Console.

Workorder files are a simpler, automated submission alternative to job submission via 
the Vantage SDK. A Workorder file is a text file containing one or more work orders, or 
job descriptions. The format of workorder files is CSV-based. Each job description is 
comprised of a fully-qualified reference to one or more media files, attachments, plus 
variables-all the input needed for the workflow performing the processing. At least one 
workorder scheme must be created (either directly in the Workorder action or in the 
Vantage Management Console) in order to properly identify the workorder schema and 
submit the jobs in a Workorder action-based workflow.

Jobs may be of any type, including Post Producer jobs, where the job identifies a CML 
file for processing. (Post Producer jobs require a special license.) While workorder files 
may be manually created (in an Excel spreadsheet, or a text editor of some kind, for 
example), ideally a system component responsible for submitting media to Vantage for 
processing will dynamically and automatically create workorder files and deliver them 
to the target share for submission and processing.
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Monitoring Workflow Status & History
To check on the status and history of workflows, use one of these methods:

• Choose a workflow and click the Monitor Status tab (or select File > Monitor Status)

• Domain Monitor Status tab (or select File > Domain Monitor Status)

• Domain Summary tab.

The monitor status panels are useful when you’re performing operator-related tasks or 
when you’re managing or performing domain-wide production media processing. The 
only difference between the two tabs is one of scope.

The Domain Monitor Status tab displays all of the workflows currently active in the 
domain. Because this tab’s focus is domain-wide, it also displays two additional 
columns of information not found in the Monitor Status tab: Workflow and Category.

The Monitor Status tab displays all activation records for the selected workflow, 
indicating the dates and times when the workflow was active. 

The Domain Summary tab displays active workflows, and the number of jobs by 
category, including totals. 

Each time a workflow is activated, a new activation record is added. It displays each 
origin action’s execution (for example, Watch actions) in the workflow, and indicates its 
current status.

Static information in the activation record includes the origin action, state and status, 
source location, and several date/time stamps, including when the action will expire. 
The state is real time information, indicating the state of the action: In Process 
(currently executing), Completed, etc.

Click any column to make it primary, sorting it in ascending/descending order.

Each row is an active origin action, indicating status and other details.

Monitor Status toolbar
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These topics provide information on using the Monitor Status tab:

■ Using the Monitor Status Toolbar

■ Viewing Origin Action Record Details

■ Viewing the Monitor Status of Camera Ingest Actions

Using the Monitor Status Toolbar
The Monitor Status workspace provides the following buttons in the toolbar:

• Show in Groups button —Click to organize records for the selected action by 
group, based on the primary column—the one selected. Click again to turn group-
ing off. For example, if you select State as the primary field in the table and display 
Groups, Workflow Designer sorts the records by state: In Process and Complete. 

When displayed in groups, click the Down arrow on the table entry to display the 
origin records in this group (In Process, or Complete, for example).

• Delete button —Click to delete the selected record(s). Or, right-click on the record, 
and select Delete. You can only delete records whose origin actions are complete—
that is, the session has ended because the workflow was deactivated.

• Status button —Click to display the selected workflow’s origin action details. Or, 
right-click and select View Status.
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Using the Monitor Status Context Menu
The Monitor Status panel’s context menu includes these commands for controlling 
completed or in process monitor actions:

• Delete—Choose to delete highlighted Complete monitor sessions.

• Disable/Enable—Choose to disable (pause) an In Process monitor session. Select 
Enable to activate the monitor session again.

• Process existing files—Choose to enable one-time processing of existing files in the 
monitored location. This feature supports submitting all content or content limited 
to the last specified time range (last x minutes, hours, days, weeks, months, or 
years). 

• View Status—Choose to open the Status/History window showing the status details 
about the selected monitor session.

• Open Monitored Folder—When the selected origin action is monitoring a Windows 
directory, choose to open the monitored folder. 
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Viewing the Monitor Status of Camera Ingest Actions
For workflows beginning with a Camera Ingest action which has been configured to 
monitor multiple locations—a card reader with multiple drives, for example—the 
Monitor Status workspace displays additional details.

In the status column, you can determine the number of shots being processed—as well 
as incomplete shots where the action is waiting for files before submitting the job. The 
Source column identifies the location—for example, drive letters on a card reader.
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Viewing Origin Action Record Details
To display details about the origin (the first) action for the selected workflow, double-
click the row (or select a row and click the Status button ).

The Status/History dialog (the  figure and the  figure) provides details about the status 
of the origin action.

When an action is complete, the Status/History dialog displays information on each 
aspect of the action’s execution. You can use this information to review details about its 
execution, and when an action fails, you can use this information to determine why and 
correct the problem.

The text in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

Click the symbol to the left of the summary lines in the upper panel to hide or display 
subordinate summary lines.

When an action is In Process, (Queued, Paused, In Process, or Waiting states), the Status/
History dialog displays a progress bar, the path of the target directory, and the status.
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For jobs in the post-execution Success, Ignore, and Failure states, the Status History 
dialog displays the following buttons:

• Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, 
or export them for processing in other systems.

• Session Log—To display a session log, select a session in the upper panel and click 
Session Log.

The session log displays session activity entries for the action, including which 
ComponentPac version was used and which variables have been provided to each 
action. This information can be helpful when debugging the use of variable, or when 
working on an issue with Telestream Customer Service.

Export Variables—Click to browse and export an XML file listing variables passed 
through the action. 

Select
Click
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Monitoring and Managing Jobs
To monitor and manage jobs, display one of these two workspaces:

• Select a workflow and click the Job Status tab (or click File > Job Status)

• Click the Domain Job Status tab (File > Domain Job Status).

The Job Status and Domain Job Status workspaces each display a list of jobs and 
provide job details. Use these workspaces to monitor media processing, set priorities, 
view binders and associated files, and to pause and resume jobs in progress.

Note: The Domain Job Status panel displays only current jobs (Active | Failed | 
Stopped | Waiting by default. To display completed jobs as well, check Include 
Completed Jobs in Domain Job Status in the Vantage Management Console > Settings 
& Options > General.

These workspaces are useful when you’re performing operator-related tasks or when 
you’re managing or performing domain-wide production media processing. The only 
difference between the two tabs is one of scope.

The Job Status workspace allows you to select a workflow in your user account and 
display all of this workflow’s jobs. The Domain Job Status workspace displays all the 
jobs currently executing in the domain, plus all completed jobs, if the Include 
Completed Jobs in Domain Job Status is enabled (Vantage Management Console > 
Settings & Options).

Each row is a job processed by the selected workflow, indicating 
status and other details.

Job Status toolbar

Real-time view of transaction processing.
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When an action is executing, it is displayed with a green border, and a progress bar 
displays at the bottom of the action, indicating execution progress. This indicator 
provides a relatively accurate prediction of how far along the total execution has 
progressed.

The following topics provide additional information for using the job status 
workspaces:

■ Viewing Workflows and Actions in Detailed Action View

■ Using the Jobs Table

■ Using the Job Status Table’s Toolbar and Context Menu

■ Stopping All Jobs in the Domain

The progress bar indicates progress for this action.
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Viewing Workflows and Actions in Detailed Action View
Whenever you are viewing a workflow or job (via the Workflow Design | Job Status | 
Domain Job Status tabs, you can view the individual actions in detailed action view: 
select View > Detailed Action View. The information that is displayed depends on the 
tab you’re using:

• Workflow Design Tab: Each action in the workflow itself displays the details (nick-
names, variables, run on rules and perform on settings), as specified by your current 
configuration options, plus the description, directly on the action.

• Job Status | Domain Job Status | Workflow Analytics Tab: Each action in the 
selected job for this workflow displays its state, relevant dates, machine, and 
resource cost), as specified by your current configuration options. directly on the 
action. For the life of the job, during task execution, the action may pass through 
many states in real time; after the job terminates, only post-execution states are 
appropriate.

To view actions in detailed action view, select View > Detailed Action View. In this view, 
each action displays its state, creation and update dates, and s directly on the action.

Action States During Execution

Note: At any time before an action starts executing, it may be re-assigned (re-
balanced) to another service which can execute it.

During job execution, each action in the selected workflow displays a color-coded 
border to identify its current state in real time:

• Green—In Process. The action is currently executing.

• Blue—Completed with Success. The action is complete, and performed the task 
successfully. For actions whose state can be manually set, displays the appropriate 
state based on the configuration specified.

• Red—Completed with Failure. The action is complete, and did not perform the task 
successfully or an upstream action failed, and represents the failed state of the 
workflow itself. For actions whose state can be manually set, displays the appropri-
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ate state based on the configuration specified. This action has failed or an upstream 
action failed, causing this action to not execute, and replicate the failed state.

• Black—Ignored | Waiting on License. This action completed without executing 
because the incoming state did not equal the Perform On condition, thus prevent-
ing it from executing or it executed in some exception-processing way (action-
dependent) because a required license was not present.

• White—Idle. The action is ready to execute pending the assignment of a service to 
execute it.

• Yellow—Pending or Waiting for Intervention. The action is ready to execute pend-
ing the availability of the required resources or execution was interrupted for some 
other reason where the service requires intervention from a user. (Note that a yel-
low action title does not reflect the state but indicates a “technology preview.” 
These actions can be tested and used but are not yet officially released or recom-
mended for use in production applications.)

• Light Gray—Paused or Suspended during execution. The action has been paused 
by a user or suspended by a higher-priority action.

• Magenta—Stopped by User. The action was stopped by user intervention.

• Light Orange—Open Workflow Error. A failure is expected when the upstream open 
actions complete.

• Orange—Waiting to Retry. The action attempted unsuccessfully to execute to com-
pletion, and is currently waiting to re-execute.

• Purple—Waiting on a Service. No service of the required type is running that can 
execute the action. For example, no Transcode Service is running to execute a Flip 
action.

• Light Green—Waiting execution due to Run On Rule. The action is waiting due to a 
run-on rule that must be satisfied before it can execute. For example, a Flip action is 
configure to execute on a Lightspeed server, but no Lightspeed servers are online.

Action States After Execution
Each action in the selected workflow displays a color-coded border to identify its final 
status at the end of the job:

• Blue—The action completed successfully—final state: Success. 

• Red—This action has failed—final state: Failure.

• Black—This action did not execute—final state: Ignore.

Note: Completing without errors does not mean that the action performed the 
task—an action may be configured to execute only when a previous action succeeded 
or when a previous action failed—thus, an action may complete without errors, and 
perform no task at all.
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Using the Jobs Table
Click any column title in the Jobs table to make it the primary column and sort it in 
ascending or descending order. The Jobs table presents information about the job in 
the following columns:

Job—The Job column displays the name of the file submitted to start the job, and the 
type of submission: Manual Submit, for example.

Workflow (Domain Job Status Only)—The Workflow column displays the name of the 
workflow that is processing or has processed this job.

Category (Domain Job Status Only)—The Category column displays the category of the 
workflow.

Note: Because the Domain Job Status workspace displays all of the jobs in the 
domain, the Jobs table also displays two additional columns of information not found 
in the Job Status workspace: Workflow and Category. It also displays an Emergency 
Stop button in the bottom right-corner. For details, see Stopping All Jobs in the 
Domain.

State—This column displays color-coded key words to identify the status of the job:

• In Process—the job is active (being processed).

• Paused—the actions in this job have been paused.

• Complete—all of the actions in this job have completed successfully.

• Error—indicates that an open mode action recognizes a critical error (that would be 
shown in the session log view), and will fail when the open block completes.

• Failed—one or more of the actions in this job have failed.

• Waiting—the job is active, but is currently waiting for a resource (a service) to 
accept and process one of the actions in the workflow.

• Stopped by User—the job was stopped by a user.

• Waiting to Retry—the job is active, but is currently waiting for one of the actions in 
the workflow to re-execute.

Progress—The information displayed in the Progress column depends on the Detailed 
Job Progress setting in the Vantage Management Console.

If Detailed Job Progress is disabled, the Progress column displays the percentage of 
actions that are complete at the moment. For example, if you have a 10 action workflow 
and the 4th action is currently executing, Vantage will report the workflow as 30% 
complete.

If Detailed Job Progress is enabled, the progress column displays a percentage value of 
the current amount of time consumed compared to the total estimated time for the job 
to complete. Using the job’s start time to determine how long the job has been 
executing, you can use the progress percentage to extrapolate the approximate 
completion time, assuming the load on the domain remains relatively constant.
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Note: To change the Detailed Job Progress setting in the Vantage Management 
Console, start the console and click on Settings & Options > General Tab to set the 
Detailed Job Progress check box.

Started—Displays the time the job started by date and time.

Updated—Displays the last time the job record was updated (typically, when the job 
ended) by date and time.

Compute Time—Displays the sum of all action execution time for a job. A value is not 
displayed in this column for jobs that are stopped by the user or failed.

Elapsed Time—Displays the difference of when a job was last updated subtracted by 
when a job started.

Expires—Displays the time the job expires, and will be removed from the database 
(along with its binder). To change the expiration period for a workflow, select it and 
click on the title to display its detail panel, where the Expiration period is displayed. See 
Viewing and Specifying Workflow Details.
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Using the Job Status Table’s Toolbar and Context Menu
The toolbar and context menu provide a variety of commands for managing jobs. The 
toolbar is displayed directly above the table.

The context menu has the same set of commands, with the exception of the Jobs Filter 
button (at far right in the toolbar), which is not specific to the selected job. To display 
the context menu, right-click on any job in the table.

• Show in groups —Organizes jobs by group, based on the primary column—the 
one you have selected. Click again to turn grouping off.

• Stop —Halts processing on this job. When you stop a job in process, each action 
for that job is notified to stop its own transaction. When all actions have been 
stopped, the job is considered complete, in a user-stopped state.

• Restart —If a job was stopped or it failed, re-starts and continue processing 
where it was stopped. Actions that fail or are stopped by a user are re-executed. 
When you restart a job, it is started as a first-time job again. This affects the execu-
tion of retry rules.

• Set expiration —Modifies the default expiration time for this job. Workflow 
Designer displays the Set Job Expiration dialog—specify a new expiration date and 
click OK.

• Delete —Deletes the selected job row(s). Or, right-click and select Delete.

• View Binder —Displays the selected job’s binder. Or, right-click an action or the 
job row in the table, and select View Binder. For details, see Viewing Binders and their 
Assets.

• View Job Errors —Displays details about errors encountered in the job.

• Job Report —Creates a job report. Select one or more jobs in the table, and click 
on the Job Report button. For details, see Generating Job Reports Manually.

• Jump to Workflow —This button only displays in the Domain Job Status work-
space. To jump directly to the workflow for this job, select a job in the table and 
click the button.

• Jobs Filter —Displays only jobs that contain specific text in the job name. Enter 
the text to begin filtering displayed jobs. Delete the text (or just close the filter by 
clicking the filter button) to display all jobs again.

Stopping All Jobs in the Domain
If you get in a situation where you need to immediately stop all running and queued 
jobs in the domain, you can use the Emergency Stop button, which is located in the 
bottom right corner of the Domain Job Status workspace.

Note: If possible, Telestream recommend using the Management Console to place 
the services in maintenance mode (or the Windows Services Console to stop the 
services) before using this command. 
After issuing a command to stop all jobs, it may take several minutes to complete. The 
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time to completion is dependent on the volume of affected jobs in the database and 
the consequent load on the computers in the domain.

To stop all running and queued jobs in the domain using this button, follow these steps

1. Click the Domain Job Status workspace.

2. Click on the Emergency Stop button in the bottom right corner. 
Workflow Designer displays a warning dialog.

WARNING: The Emergency Stop button stops all active jobs in the domain, and 
can not be reversed. This will lead to a potential loss of work and/or data. You 
should only utilize this command in an emergency. (For example, mistakenly 
submitting thousands of jobs.) Ideally all services should be in maintenance 
mode before executing this command.

3. Click Yes to Continue.

Workflow Designer issues the Emergency Stop command to the domain database.

After clicking the 
Emergency Stop button 
to stop all of the jobs in 
the domain, Workflow 
Designer displays a 
warning dialog.

Emergency Stop button.
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Generating Job Reports Manually
Workflow Designer allows you to generate job reports for the selected job or jobs, as 
comma-separated value (CSV) files. You can open these reports in spreadsheet 
programs and other programs that display CSV files, or you can use them in other 
systems, such as databases or media asset management systems.

Note: You can also configure a workflow to automatically generate a job report each 
time the workflow executes. See Enabling Automatic Reports in the Domain 
Management Console.

Each job report is based on a job report configuration you select (see Managing Job 
Report Configurations).

Note: If there are no job report formats, Workflow Designer displays a dialog that 
enables you to create one. Click OK to display the Job Report Manager (Managing Job 
Report Configurations).

To create a job report, follow these steps:

1. Select one or more jobs in the Job Status table.

2. Click on the Job Report button  in the toolbar, or right-click the job and select 
Create Report. Workflow Designer displays the Create Job Report dialog (below). 

3. Select a report format from the drop-down list. (Report formats are created in the 
Vantage Management Console Report Configurations > Job Reports window). 

You can also click the browse  button to display the Job Report Manager window 
(see Managing Job Report Configurations for details). 

4. Choose Selected Jobs or Archived job history. For Archived job history, specify from 
and through dates 

Selected Jobs reports on jobs highlighted in the job list and provides a full report 
including all fields specified in the report format. Archived job history reports on 
historical jobs within the window of dates you specify, including expired jobs; only 
the standard fields defined in the Management Console > Job Reports format are 
included; no custom columns are included.
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5. Select where you want to save the CSV report file for the selected jobs, as shown in 
the following figure.

Vantage displays the File System dialog, which you can use to select the server and 
directory where you want the CSV report file for the selected job or jobs stored, as 
shown in the following figure.

Optionally, enter a new name for the job report file (or append a date or other 
significant qualifier) and click Save to process the report and save the file as a CSV file. 

When the report file has been generated, Vantage displays a dialog to indicate where 
the file was saved. Click OK to close the dialog.
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Managing Job Report Configurations
Two types of job reports are available: automatic reports and manually generated 
reports. 

Automatic reports are set up using the Automatic Reports: Modify button in the 
Workflow Details panel and run every time a job runs. For details see the Designing and 
Managing Workflows chapter of this guide—Enabling Automatic Job Reports. 

Manually generated reports, which you can run on selected jobs as needed, are 
described on the following pages. These reports are configured by right-clicking jobs in 
the Job Status or Domain Job Status panel and selecting Create Report.... 

Note: Completed jobs in the Domain Job Status tab are visible only if the Include 
completed jobs in Domain Job Status selection in the Vantage Management Console 
Settings & Options General panel is checked (enabled).

Before you can generate job reports, you must create at least one job report 
configuration. You can create multiple configurations; one for each type of job report 
you want to generate.

You use the Job Report Manager to create, edit, and delete job report configurations. 
(The Job Report Manager is also available in the Vantage Management Console.)

Note: Reports are set up in Workflow Designer’s Workflow Details panel using the 
Automatic Reports: Modify button, or in the Job Status or Domain Job Status panel by 
right-clicking jobs and selecting Create Report. When checked, the Include completed 
jobs in Domain Job Status selection in the Vantage Management Console Settings & 
Options General panel enables visibility of completed jobs in the Domain Job Status 
tab; when unchecked, only current jobs are shown.

The following sections describe these tasks:

■ Displaying the Job Report Manager

■ Creating a New Job Report Configuration

■ Choosing and Adding Report Columns

■ Duplicating a Job Report

■ Deleting a Job Report
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Displaying the Job Report Manager
To display the Job Report Manager, follow these steps.

1. Display the Job Status or Domain Job Status workspace.

2. Select a job from the Job table.

3. Click the toolbar Job Report button  to display the Create Job Report dialog:

4. Click the browse  button to the right of the report menu.

Workflow Designer displays the Job Report Manager window.

Toolbar buttons:
Create | Delete | Save | Duplicate
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Creating a New Job Report Configuration
To create or edit a job report configuration, do the following:

Note: Vantage domain administrators can also create report formats with the 
Vantage Management Console.

1. To create a new job report configuration, click a job in the Job Status or Domain Job 
Status window, and click the Create a report button. 

Note: Completed jobs in the Domain Job Status tab are visible only if the Include 
completed jobs in Domain Job Status selection in the Vantage Management Console 
Settings & Options General panel is checked (enabled).
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2. Click the Create/Edit/Delete Job Report Configuration button (below). 

The Job Reports Manager dialog opens.

3. To edit a job report configuration, select it from the list, or to create a new 
configuration, click the Create a new report configuration button .Enter a name 
in the Name field.

4. Optionally, enter a report description in the Description field.
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5. If you want to include a header row, check Add Header Row.

6. Click the Save button  to save the new report.

Choosing and Adding Report Columns
Check the boxes to configure reports to include or exclude the following columns:

• Job ID, Job Name, State, Progress, Started, Updated, Expires, Category Name, Work-
flow Name, Job Run Time (seconds), Job Queue Time (seconds), Media Duration 
(seconds), and Cloud Cost.

• Additional columns for metadata label parameters (not available for archive 
reports)

When you choose to display a column for a metadata label, the column displays the 
label value. To add or delete columns for metadata labels, do the following:

1. Click the Add Column button  to display the Select Label Parameters for Columns 
dialog.

2. In the Labels panel, select a label for which you want to display parameters.
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3. In the Parameters panel, check the checkbox for any parameter you want to display, 
and clear the checkbox for any parameter you do not want to display. 

To toggle between showing and hiding categories in which the parameters reside, 
click the Category button . 

4. Click OK to save the selected label parameters and close the dialog.

5. To change the displayed order of parameter labels in the Job Report, select a label 
in the list and use the green up  and down arrow  buttons to move the label 
up or down in the list.

The top listed parameter becomes the first column after the “standard” columns in 
the job report, and the last item becomes the last column on the right.

6. Click the Save button .

The Job Report Manager displays your changes. 
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Duplicating a Job Report
When you duplicate a job report, a new report is created with a modified report name. 
All settings in the duplicate report match those in the original report.

To duplicate a job report, do the following:

1. Select the report to duplicate.

2. Click the Duplicate button .

3. In the Name text box, enter a new name for the duplicate report.

4. Make any other desired changes.

5. Click the Save button .

Deleting a Job Report
To delete a job report, select the report and do the following:

1. Click the Delete button .

2. When the confirmation dialog displays, click OK.
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Viewing the Domain Summary
The Domain Summary tab displays, on a per-workflow basis, the following data for all 
jobs in the domain: In Process, Waiting, Completed, Failed, Stopped by User, and Total 
Jobs. 

Consider thinking of this as a general purpose or quick report that you can quickly 
examine instead of having to set up and generate a jobs report. The display is static and 
offers no control over workflows, but you can use the Open Selected Workflow button 
or right click context menu to jump to a specified workflow in the Workflow Designer.
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Viewing Binders and their Assets
The Binder panel displays information about their assets—files ingested or generated 
in a job—or in subsequent jobs, when the Register action is configured to overwrite 
binders if a file of the same name is submitted (Conflict Resolution). Assets in a binder 
can include media files, metadata labels, and attachment files.

To view the binder for the selected job, choose:

• Click the binder button  in the toolbar

• Right-click on any action, or job row in the table, and select View Binder. 

• Double-click the job row in the table.

Viewing Media
The Media Files tab displays a list of media files ingested or created in the job, including 
the file’s path, nickname, and filename. To the right is a WMV player, where you can 
preview the selected file provided that it is playable by Windows Media Player 
(typically, WMV, AVI, and ASF files, depending on your configuration).

You can also right-click any file and Choose these options:

• Open Containing Folder—displays the Windows directory where the file is stored.

• Open With Default Program—opens the file in the program specified as the default 
program to open these types of files, based on its extension.

• View Files List—displays the list of files submitted as part of the job.

• View Full URL—displays the full URL of the file submitted. See Using View Full URL to 
Submit a Remote File via API for additional information.

The ability to play media depends on the operating system where the file is located:

Local Windows Storage
• You can Open Container Folder or Open With Default Program

• The Player window displays and plays compatible media.
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Network Windows Storage
• You can Open Container Folder or Open With Default Program

• The Player window does not display or play compatible media.

Cloud storage and other file systems (FTP, Aspera, Pathfire, BML)
• You can not Open Container Folder or Open With Default Program

• The Player window does not display or play media.

Viewing Metadata
Use the Metadata Labels tab to display the labels associated with the job, their 
parameters and values. (You cannot edit values in this viewer.) 

Viewing Metadata
The Attachments tab displays a list of attachment files, including each file’s path, 
nickname, and filename.

Using View Full URL to Submit a Remote File via API
The View Full URL feature in the Job Status > View Binder panel helps API users submit 
files located on remote file systems such as Amazon S3. In particular, the output 
displayed in the View File URL dialog is precisely the properly formatted URL needed for 
an API command addressing a remote file location. 

Note: User Administration must be enabled in the Vantage Management Console, 
and only users who are administrators are able to use the View File URL feature.

To use this feature, follow these steps:

1. Set up a simple workflow, such as Receive and Register, and activate the workflow. 
The purpose of this workflow is simply to register a remote file which represents 
files in the remote file location that you want to use. The Receive action Media Files 
Expected Nickname should be set to Original.

2. Use Submit Job and manually browse to a representative file in the remote location 
and submit it to the Receive action. 
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3. Right-click the job in the Job Status table, and select View Binder.

4. Right-Click the Original file in the binder and select View Full URL. The resulting 
dialog is as follows:

The text of the dialog is exactly the text that you need to cut and paste directly into 
an API submission message to submit the same file to another workflow via the API.   
Refer to the Vantage Rest API Guide (available on the Telestream support website) 
for detailed information about submitting files to a Vantage workflow.

To submit other files in this location to other workflows, change the name of the 
remote file in the URL (boxed in red) while leaving all else in the URL the same. The 
file name portion of the URL is NTSC_TC_CC.mpg. That is the only portion of the URL 
that you need to change to a new file name.

Controlling Action Execution in Jobs
These topics describe how you can control action execution in your jobs:

■ Pausing and Resuming Actions

■ Pause for Priority in Actions

■ Setting Action Execution Priority

Pausing and Resuming Actions
To pause and resume actions in a job in progress, right-click on the action and select 
Pause from the context menu. To resume a paused action, right-click on the job and 
select Resume from the context menu.

You cannot pause actions in certain states or in certain workflows. For example, you 
cannot pause an action that has failed. Also, you cannot resume an action downstream 
of another failed action, without restarting the first failed action, etc.

Pause for Priority in Actions
Pause for Priority is an automatic feature of Flip64, Multiscreen Flip, IPTV Flip, and 
Conform actions. If a Transcode Service is saturated (performing the maximum number 
of jobs), Vantage will queue up incoming jobs and wait for a slot to become available. 
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For example, a Transcode Service is configured to run 2 simultaneous jobs; it receives 
three jobs (A, B and C); jobs A and B begin execution (the service was idle prior to this) 
and C is queued until either A or B completes, at which point C will execute).

Pause for Priority comes into play if job C has a higher execution priority than job A or B. 
In this case, job A is paused and job C begins processing immediately. When Job C or B 
completes; then A (which was previously paused) returns to processing.

Setting Action Execution Priority
You can modify the execution priority of actions in a running job, when they are in the 
Wait, Pause, or Running states. You cannot set an action priority for a completed action. 
To change the priority of an action that has not completed, do the following:

1. Right-click the action and select Priority to display the Action Priority dialog.

2. Change the priority value (larger numbers equal higher priority), and click OK to 
modify the action’s priority in this job. (Zero and negative numbers are allowed; for 
example, a 0 priority pauses a -1 priority, and a -1 pauses a -2.)

Viewing Action Status
To view details about the status of any action in a job, select the job in the jobs list, 
right-click the target action in the workflow, and select Status.

The Status/History dialog provides details about each aspect of the action’s execution. 
You can use this information to gather details about its execution, and when an action 
fails, you can use this information to determine why and correct the problem.
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Each line in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

The symbol to the left of the summary lines in the upper panel allow you to hide or 
expose subordinate summary lines. Click a symbol to hide or display subordinate 
summary lines.

Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, or 
export them for processing in other systems.

Session Log—To display a session log, select a session in the upper panel and click 
Session Log.

Click Done to dismiss the Status/History window.
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Using Workflow Analytics

Use this chapter to learn how to use Workflow Designer to analyze workflows and job 
history to identify problems and improve overall system performance.

Topics
■ Workflow Analytics Overview

■ Using the Workflow Analytics Panel

■ Performing Bottleneck Analysis

■ Performing Execution Analysis

Note: Features in editions for which you do not have a license are disabled, and 
indicate that you need a license to use them.
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Workflow Analytics Overview
Workflow analytics is an optional, licensed feature in Workflow Designer, and requires a 
Reporting and Analytics license. Workflow analytics enables you to visually analyze 
workflows and job history to identify problems and improve overall system 
performance.

In Workflow Designer, workflow analytics enables you to view jobs (based on the job 
history currently in the database) on a case-by-case basis to:

• Identify performance bottlenecks by action in a workflow

• Analyze workflow execution as a result of decisions in a workflow

• Visualize the progress of multiple jobs submitted to a workflow

• Rank workflows and actions, based on processing time consumption.

Note: Because workflows may be modified over time, jobs run in the selected 
workflow prior to the last change are ignored.

Vantage administrators and personnel responsible for designing and implementing 
workflows can use this information to modify workflow design and improve Vantage 
domain performance and efficiency.

Note: In the Management Console, workflow analytics enables you to analyze 
workflows at the domain level. For details on using workflow analytics in the Vantage 
Management Console, click the Help button in the toolbar to display the Vantage 
Domain Management Guide.

Workflow analytics automatically includes new jobs that are submitted, as appropriate, 
displaying them in the Jobs table and recalculating metrics.
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Using the Workflow Analytics Panel
Click the Workflow Analytics tab (or click File > Workflow Analytics), and select the 
workflow in the Workflows panel to view job history information, which helps you 
identify performance bottlenecks and collect workflow processing statistics.

Actions display the average execution time, and stack rank time relatively by color—
green (fastest) through red (slowest).

To select a workflow to view, use the Workflows list to the left of the Workflow Analytics 
tab. Open the appropriate workflow category and click on any workflow to select it. You 
can then view all of the job history records for the selected workflow in the Workflow 
Analytics tab.

After making your job selection (see below), click the Run Analysis button to begin near 
real-time display of the analytics data. To stop calculating and updating the data (or to 
change the jobs you want to analyze), click Stop Analysis.

The following topics provide additional information:

■ Using the Jobs Table Toolbar

■ Using the Jobs Table

Jobs Table with toolbar Analysis Options
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Using the Jobs Table Toolbar
The toolbar for the Jobs table displays buttons for the following commands:

Groups—Click to organize the jobs by group, based on the primary column—the one 
you have selected. Click again to turn grouping off.

Filter—Click to display (and thus determine the set) only jobs that contain specific text 
in the job name. Enter the text to begin filtering displayed jobs. Delete the text to 
display all jobs again.

Using the Jobs Table
Click any column in the Jobs table to make it the primary column and sort it in 
ascending or descending order.

When you first select a workflow, no jobs are selected, so all jobs are considered in 
calculating the metrics. Select any job or jobs (Shift+click or Ctrl+click) to view the 
selected set’s analytic details.

To de-select all jobs and return the table to its original state, select one record, then 
Ctrl+click to de-select it.
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Performing Bottleneck Analysis
Select Bottleneck Analysis from the popup menu on the far right. Workflow Designer 
displays elapsed time for the selected records in the job history set.

In bottleneck analysis (which is enabled by default), you can identify the longest 
running actions in a workflow, based on color and time values.

Color values are applied to each action from green to red on a sliding scale, based on a 
comparison of the average of all selected job records. The shortest average execution 
time displays the darkest shade of green; the longest displays red. Those in between 
display color values through yellow-green, yellow (average), and orange.

Numeric values on each action display the average execution time of the actions which 
ran, based on the selected job records.

When performing bottleneck analysis, choose:

• Include Waiting Time—Check to add wait time to execution time and display the 
combined total time for each action. Wait time includes time spent in a Waiting 
state and a Paused state. Uncheck to display only execution time.

• Count Non-running Actions—Check to include the execution time (0 seconds) of 
actions that did not run, thus providing a weighted bottleneck analysis based on 
which branches in a workflow executed, based on decision actions. This allows you 
to focus upon the actions which are bottlenecks in real-world operations. 

Uncheck to disregard non-running actions when calculating the execution time. This 
allows you to find the most expensive actions, regardless of whether or not they are 
commonly run.
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Performing Execution Analysis
Select Execution Analysis from the popup menu on the far right. Workflow Designer 
displays percentile and numeric values for the selected records in the job history set.

In execution analysis, you can determine which percentage and number of actions 
executed, based on the selected job history set, based on color and percentile values.

Color values are applied to each action from black to green on a sliding scale. The 
lowest average execution displays the darkest shade of black; the highest displays 
green.

Darker actions are those that have not executed yet (near zero percent). Dark green 
actions are average (near 50 percent), and the highest percentile executing actions are 
bright green (approaching 100 percent). 

For each action, the percent of executions completed is calculated against the total 
number of jobs, based on your selected job criteria.

When using execution analysis, choose your job criteria:

All Jobs | Only Completed Jobs | Only Successful Jobs—Select to include all selected jobs 
regardless of their status, only completed jobs (thus excluding running or partially 
completed jobs), or only successful jobs in the calculations.
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Managing Hosted 
Workflows

The HostedWorkflow Manager window enables you to manage your Vantage domain’s 
Telestream Cloud hosted workflows directly in Workflow Designer. Hosted workflows 
typically exist in two locations: your Vantage domain, and in your Telestream Cloud 
account. These two copies are one in the same workflow, and they are associated with 
each other by their GUID.

Note: Use of HostedWorkflow Manager features requires that you have a Telestream 
Cloud account, and that you have added the API key for the account in the Vantage 
Management Console. When you’ve provided these credentials, Workflow Designer 
can be configured to operate in Cloud mode, with the same capabilities that it 
provides when a Cloud Developer license is installed.

Topics
■ Requirements

■ HostedWorkflow Manager Overview

■ Selecting Your Telestream Cloud Account & Store

■ Setting the Default Cloud Workflow Revision

■ Downloading Workflows from Telestream Cloud

■ Uploading New Workflow Revisions

■ Uploading Vantage Workflows to Telestream Cloud

■ Troubleshooting

Note: If you’re not familiar with using Telestream Cloud, see the Telestream Cloud 
User Guide on the telestream.net web site.

http://www.telestream.net
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Requirements
Before you use HostedWorkflow Manager, be sure that you meet these requirements:

• You have a Telestream Cloud account.

If you don’t have a Telestream Cloud account, go to https://cloud.telestream.net/
console/signup and create one. If you already have an account and want to log in, 
go to https://cloud.telestream.net/console/login.

• In Telestream Cloud, create one or more stores where you want to save workflows.

• If your domain is configured with user administration, your user must have Vantage 
Administrator privileges. 

In the Vantage Management Console, go to Settings & Options > General to verify 
user administration is enable or disabled. To view/modify user privileges with user 
administration enabled, go to Settings & Options > Users.

• You have created an account record in the Vantage Management Console. 

Go to Settings & Options and display the Cloud tab—create a record for the 
account and test it.

https://cloud.telestream.net/console/signup
https://cloud.telestream.net/console/signup
https://cloud.telestream.net/console/login
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HostedWorkflow Manager Overview
You can use the HostedWorkflow Manager window to manage your hosted workflows 
directly in Workflow Designer—create and upload them, or synchronize them in your 
Telestream Cloud account. You can also download hosted workflows in Telestream 
Cloud—for review, modification, and upload back to the Cloud—directly in Workflow 
Designer.

Note: For basic information on using Vantage client programs, see Vantage Client 
Programs Overview.

Here is a depiction of the HostedWorkflow Manager main window and its major 
components:

This window is comprised of two panels: Cloud Workflows and Vantage Workflows.

Telestream Cloud 
account

Cloud Workflows 
toolbar

Cloud 
Workflows 
panel

Vantage 
Workflows 
panel

Vantage Workflows 
toolbar

Previous | 
Next and 
Close 
buttons
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Using the Cloud Workflows Panel
The Cloud Workflows panel displays all of the workflows in the selected Telestream 
Cloud account, with details. 

You use this panel to operate on your workflows from the Cloud workflow perspective.

Toolbar Buttons for Cloud Workflow Operations
Select one or more workflows to operate on them, using the buttons in the toolbar. (Or, 
right-click on a workflow and select these operations from the menu.)

 Delete Cloud Workflow(s)—Permanently deletes the workflows from the store.

 Upload New Revision—When the workflow is out of date as indicated by the 
unsynchronized  icon, uploads the associated Vantage workflow to your 
Telestream Cloud account as a new revision. See Uploading New Workflow Revisions for 
details.

 Download Cloud Workflow(s)—For workflows that aren’t in your domain, copies 
the latest revision of the selected workflow(s) to your domain. See Setting the Default 
Cloud Workflow Revision for details.

 Revision Management—When several revisions exist, allows you to change the 
default revision for execution. See Setting the Default Cloud Workflow Revision for 
details.

 Find Vantage Workflow—For workflows with a corresponding Vantage workflow 
(as noted by the  icon in the Exists Locally column), finds the corresponding 
workflow in the Vantage Workflows list and selects it.

 Refresh—Reloads the workflows from the default store; displays a progress bar 
during the operation.

Cloud Workflows Table Columns
You can sort each column in ascending | descending order.

Cloud Name—The display name of the hosted workflow in Telestream Cloud. Permits 
sorting ascending | descending.

Number of Revisions—The number of variations in this hosted workflow.
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Default Revision—The revision number of the workflow that is used when this 
workflows executes a job.

Jobs in Last 30 Days—The number of jobs that have been executed by this workflow 
int he last 30 days.

Vantage Name—The name of the associated workflow in your Vantage domain.

Note:  Telestream recommends that you use the same name for workflows that are 
hosted both in your domain and in your Telestream Cloud account.

Exists Locally—Specifies by a check mark that an associated workflow exists in your 
Vantage domain.

Exported Timestamp— The Exported Timestamp indicates the date/time that the 
selected Default Revision of the workflow was exported (uploaded) from the local 
Vantage domain.

Workflow Synchronized—For workflows with an associated Vantage workflow, 
indicates whether they are in synch or not.

Using the Vantage Workflows Panel
The Vantage Workflows panel displays all of the workflows that are in your domain, 
with details. 

You use this panel to operate on your workflows from the Vantage workflow 
perspective.

Toolbar Buttons for Vantage Workflow Operations
Select one or more workflows to operate on them, using the buttons in the toolbar. (Or, 
right-click on a workflow and select these operations from the menu.)

 Upload Vantage Workflow(s)—Uploads the Vantage workflow up to your 
Telestream Cloud account, using the name you specify. See Uploading Vantage 
Workflows to Telestream Cloud for details.



Managing Hosted Workflows
HostedWorkflow Manager Overview

214

 Find Cloud Workflow—For workflows that have a corresponding Cloud workflow 
that was uploaded previously, finds and selects the corresponding workflow in the 
Cloud Workflows table.

 Refresh—Reloads the workflows from the default Telestream Cloud account.

Vantage Workflows Table Columns
You can sort each column in ascending | descending order.

Vantage Name—The name of the associated workflow in your Vantage domain.

State—The designation of the state currently assigned the workflow.

Category—The Workflow Designer category that this workflow is stored in.

Description—The description of the workflow.
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Selecting Your Telestream Cloud Account & Store
To select or change the Telestream Cloud account and store that you want to use, 
follow these steps.

1. In Workflow Designer, open the HostedWorkflow Manager window and select File 
> Vantage Cloud HostedWorkflow Manager
OR
Click the Telestream Cloud  icon in the Workflows panel title bar:

2. In the HostedWorkflow Manager window, click the Previous button at the bottom 
right corner. (The first time you display Hosted Workflows Manager, this panel 
displays first):

Workflow Designer displays the Account and Store dialog:

3. Select the account and store to use, and click Next to return to the main window.

Note: The store list is populated from your Telestream Cloud account. Make sure that 
your stores are valid, or that you are aware of which stores are valid. Your account may 
have stores whose buckets are no longer viable and is beyond control of Vantage.

Telestream Cloud icon—
displays the Hosted 
Workflows Manager
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Setting the Default Cloud Workflow Revision
For workflows with multiple versions in Telestream Cloud, the default revision is used 
for execution unless you override it during job submission. Usually, the default revision 
is the latest revision you’ve set; however, you can specify a different revision if you need 
to revert to a previous one.

Note: Telestream Cloud does not change the default (executable) revision without 
specific action. As a shortcut, when you upload a revision, you can set the new revision 
to the default (see Uploading New Workflow Revisions)—check Make this the default 
version in the Upload Revision dialog.
If you don’t change the default revision when you upload it, the revision remains the 
same until you change it in the Revision Management dialog. 

To change the default revision of a multi-revision workflow, follow these steps:

Workflow Designer displays the Revision Management dialog:

Select the revision to set as the default revision and click OK.
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Downloading Workflows from Telestream Cloud
You can download workflows from Telestream Cloud to your Vantage domain if they 
haven’t previously been downloaded or when they don’t have an associated workflow 
already in the domain. 

Note: Workflow Designer downloads the revision currently-assigned as the default 
version. See Setting the Default Cloud Workflow Revision for details.

To download workflows, follow these steps:

1. Verify your Telestream Cloud account and store—click Previous; change the 
account and default store as required, then click Next to return to the main window.

2. In the Cloud Workflows panel, select one or more workflows to download.

3. Verify that they do not already exist in your domain, as indicated by the lack of a  
icon in the Exists Locally column.

4. Click the  Download Cloud Workflow(s) button | right-click on the Cloud 
workflow and select Download Cloud Workflow(s) to transfer the selected 
workflows to your domain. 

Workflow Designer displays this dialog for each workflow selected:

Workflow Designer uses the Cloud workflow’s name as the name to apply to the 
copy you create in your Vantage domain unless the workflow was given a different 
Cloud Workflow name when it was originally uploaded. In this situation, the down-
loaded copy of the workflow uses the original Vantage Workflow name, not the 
Telestream Cloud name. 

As an example, if you upload a workflow named My Workflow and give it the Cloud 
workflow name My Workflow (cloud), and then you delete the Vantage workflow (or 
connect to a different domain) when that workflow is downloaded, the local Van-
tage copy will be named My Workflow, not My Workflow (cloud).

5. Select the workflow category that you want Workflow Designer to store the 
workflow(s) in.

Note: If the workflow (or any workflow, in a multiple workflow selection) already 
exists, Workflow Designer disables the Download button. Download is only permitted 
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when there is no workflow in the local Vantage domain with the same ID GUID as the 
selected Cloud Workflow.

6. Click OK to proceed.

Workflow Designer displays a progress bar during the operation. When the transfer 
is complete, Workflow Designer updates the workflow record in the Cloud Work-

flows table: It displays a  icon in the Exists Locally column, and displays the syn-
chronized  icon to advise you that the two revisions are identical. 
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Uploading New Workflow Revisions
When you modify a hosted workflow in Vantage, Workflow Designer flags its associated 
Cloud workflow with the unsynchronized  icon. 

Note: If the workflow (or any workflow, in a multiple workflow selection) already 
exists, Workflow Designer disables the Download button. Download is only permitted 
when there is no workflow in the local Vantage domain with the same ID GUID as the 
selected Cloud Workflow.

To upload the new revision that you’ve modified in Workflow Designer back to 
Telestream Cloud from your domain, follow these steps:

1. Verify your Telestream Cloud account and store—click Previous; change the 
account and default store as required, then click Next to return to the main window.

2. In the Cloud Workflows panel, select the unsynchronized workflow(s) and click the 
 Upload New Revision button 

OR
Right-click and select Upload New Revision to copy the workflow(s) to your 
Telestream Cloud account as new revisions.

Workflow Designer displays the Upload Revision dialog for each selected workflow:

3. Check Make this the default revision if you want to use this revision. If unchecked, 
the currently-specified revision remains unchanged unless you change it manually 
(see Setting the Default Cloud Workflow Revision).

4. Click OK to proceed.

5. Workflow Designer displays a progress dialog as it performs the operation, and 
updates the record in the Cloud Workflows table.
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Uploading Vantage Workflows to Telestream Cloud
When you create a hosted workflow in Workflow Designer and validate it for execution 
in Telestream Cloud, you can upload it to your account and store for execution. 

Note: Telestream recommends that you use the same name for both copies of the 
workflow to avoid confusion. Even if you name them differently in Vantage and 
Telestream Cloud, they are in fact, the same workflow with the same GUID.

To upload Vantage workflows to your account in Telestream Cloud, follow these steps:

1. Verify your Telestream Cloud account and store—click Previous; change the 
account and default store as required, then click Next to return to the main window.

2. In the Vantage Workflows panel, select the workflow(s) and click the  Upload 
Vantage Workflows button 
OR
Right-click and select Upload Vantage Workflow(s)... to copy the workflow(s) that 
you want to upload from your Vantage domain to your Telestream Cloud account 
as a new workflow. 

Note: Workflow Designer does not check for associated Cloud workflows. If the 
selected workflow(s) is in the account and store you’re working with, it displays an 
error, advising that this workflow is already associated with a Cloud workflow.

Workflow Designer displays the Upload Revision dialog for each selected workflow:

3. Enter the name for the Telestream Cloud copy or accept the default value: the same 
name. Telestream recommends using the same name in both Vantage and Cloud 
domains. These two copies are one in the same workflow, and they are associated 
with each other by their GUID and changing names can lead to confusion.

4. Click OK to proceed.

5. Workflow Designer uploads the new workflows, and displays a progress dialog as it 
performs the operation.

Note: If your workflow is not Cloud-compatible, Workflow Designer displays an error: 
“Unable to export workflow”. It provides information about what action or action’s 
configuration caused the error. Fix and retry.
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Troubleshooting
Use these topics to help solve problems you may encounter.

Problem: Workflow Designer displays an error—No Telestream Cloud 
credentials have been added to this domain when I attempt to open it. Or, 
Telestream Cloud account couldn’t be accessed. The API key may be incorrect.

Solution. You don’t have a Cloud account registered in Vantage or the account you 
entered is incorrect.

In the Management Console navigate to Settings & Options and display the Cloud Tab. 
Create a new Cloud account record using your Telestream Cloud credentials or update 
the account API key. Now, back in Workflow Designer, display the Hosted Workflows 
Manager window again.

If you don’t have a Telestream Cloud account, go to https://cloud.telestream.net/
console/signup and create one.

Problem: Workflow Designer displays a Does Not Exist error when I attempt to 
upload a workflow to a store:

Solution. You have selected a store whose bucket is no long valid. This list is populated 
from your Telestream Cloud account. Make sure that your stores are valid, or that you 
know which stores are valid. Your account may have stores whose bucket is not longer 
viable and is beyond control of Vantage.

https://cloud.telestream.net/console/signup
https://cloud.telestream.net/console/signup
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Workflow Designer displays an error when I tried to upload a workflow:

Solution. You have configured your workflow in a way that is not functional when 
executed in Telestream Cloud—thus, its not considered a valid cloud-hosted workflow. 
Read the error details, correct the configuration, and retry.
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Using Workflow Portal 
Configurations

This chapter describes how to operate each of the basic Workflow Portal 
configurations. Workflow Portal configurations are created in the Vantage 
Management Console. The functionality options and user interface components are 
specific to each type of configuration and are enabled in Workflow Portal when it is 
launched.

A Vantage administrator can make as many of each type of configuration as necessary, 
each one configured to support a specific media processing application. 
Configurations are developed in conjunction with a workflow designer, so that the 
configuration performs correctly with the associated ingest and publication workflows. 
Once you’ve used a configuration, the Workflow Portal opens to it automatically. 

Note: When you are using a given type of configuration—for example, a VOD 
configuration—it is common to think of and refer to Workflow Portal simply as the 
VOD Portal. When you read about a portal by any name (VOD, DPP, etc.), just 
remember—this particular Portal is Workflow Portal using its respective configuration.

Topics
■ Using Browse Catalogs Copy Binder and Forward Binder Portals

■ Using Windows Network Portals

■ Using EDL Portals

■ Using CML Portals

■ DPP Portal Overview

■ VOD | DAI Portal Overview

■ Tempo Portal Overview

■ Syndication Portal Overview

Note: Some of these configurations are described in their own product guides. Please 
refer to those guides for additional details.
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Using Browse Catalogs Copy Binder and Forward 
Binder Portals

Note: These configuration can be used in both the Workflow Portal Windows client 
and the Workflow Portal web app.

The Browse Catalogs configurations are the most broadly-focused operator-
intervention configurations. In these configurations, the key requirement is the 
registration of media in a catalog using an ingest workflow. This enables an operator to 
select it and review a proxy, edit metadata and variable values as required, and submit 
it to one or more publishing workflows. 

Browse Catalog configurations are not designed to solve any specific media processing 
application (such as DPP or CML); they simply enable operator-intervention processing 
of media registered in a Vantage catalog.

Note: Media trimming can be implemented in Workflow Portal in both Browse 
Catalog configurations. For example workflows, go to the Vantage Support page on 
the Telestream web site, and download the Workflow Examples zip file for your version 
of Vantage.

In a Browse Catalog Copy Binder Portal, the operator browses a catalog and selects a 
binder to prepare before submitting the job to a publishing workflow. A Copy Binder 
configuration automatically duplicates the original binder and submits the duplicated 
binder (with changes made by the operator) to the publishing workflow, leaving the 
original binder intact in the catalog for future use or re-submittal. (If you may ever need 
to use the copied binder later—in case of an error, for example—you should also use a 
Register action in the publication workflow to register the new binder in a catalog).

In order to have a binder to submit, the operator clicks the Submit button to trigger the 
duplication of the original binder. Now, using the copied binder as a template, the 
operator can edit metadata and variables as required, (in the copied binder) and submit 
it to the publishing workflow.

In contrast, in a Browse Catalog Forward Binder Portal, the original binder is modified by 
the operator during metadata and variable editing, and submitted to the publication 
workflow—without making a copy. (If you don’t need the binder after processing, you 
can automatically or manually delete it.) The operator can edit metadata and variables 
(in the original binder) directly in the main window and then click Submit to submit it 
to the publishing workflow.

Here are the differences between Copy Binder and Forward Binder configurations:

• Copy Binder—the operator clicks the Submit button before editing metadata and 
variables—to create a copy of the original binder.

• Forward Binder—the operator selects a binder and edits its metadata and vari-
ables—then click Submit to process the job.
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Depending on how the configuration has been set up, there will be variations in the 
features that are enabled, and the related tasks you can perform. In both 
configurations, the operator can review, edit, and update label-based metadata and 
variables for the selected media prior to submission to a publishing workflow.

Copy Binder Job Submittal Process
As depicted in the figure below, media is submitted to an ingest workflow through a 
watch folder, which performs any processing required, and registers the output media 
(organized with any other job-specific assets—metadata labels, for example—in a 
binder) into a specific Vantage catalog.

Alternatively, media can be submitted via a workflow, manually, or any other means. 

In Workflow Portal, the operator browses catalogs and selects a binder, clicks Submit to 
generate the copied binder, and performs operator tasks as appropriate. This may 
include scrubbing a proxy, reviewing and editing metadata, and setting variable values 
for the job.

Next, the operator submits the job to a publishing workflow, which can be designed to 
perform any task required. The binder being processed is a copy of the original binder. 
The original binder and its contents remain untouched.

Job Submittal Steps
When you’re using a Copy Binder Portal to process media, an operator follows this 
general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows associated with this process 
are running (in Workflow Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.
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3. Preview media in the Media Player (Previewing Proxy Media in the Media Player).

4. Check the workflow(s) you want to process the media with. This varies based on 
how the configuration is set up.

5. Click the Submit button to display the Submit Jobs window and prepare the copied 
binder’s assets for processing.

6. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

7. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

8. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).

Forward Binder Job Submittal Process
As depicted in the figure below, media is submitted to an ingest workflow through a 
watch folder, which performs any processing required, and registers the output media 
(organized with any other job-specific assets—metadata labels, for example—in a 
binder) into a specific Vantage catalog.

Alternatively, media can be submitted via a workflow, manually, or any other means. 

In Workflow Portal, the operator browses catalogs and selects a binder, clicks Submit, 
and performs tasks as appropriate. This includes reviewing and editing metadata, and 
setting variable values for the job as appropriate.

Next, the operator submits the job to a publishing workflow, which can be designed to 
perform any task required. The binder being processed is the original binder.
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Job Submittal Steps
When you’re using a Forward Binder Portal to process media, an operator follows this 
general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows associated with this process 
are running (in Workflow Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.

3. Preview media in the Media Player (Previewing Proxy Media in the Media Player).

4. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

5. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

6. Check the workflow(s) you want to process the media with. This varies based on 
how the configuration is set up.

7. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).
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Using Windows Network Portals
Note: This configuration can only be used in the Workflow Portal Windows client.

The Browse Windows Network Portal (Windows Network Portal for short) allows you to 
select one or more media files from servers on a Windows network and submit them to 
target workflows, depending on how the configuration is set up.

Like Browse Catalog configurations, Browse Windows configurations are also broadly-
focused. If the configuration permits, you can also add metadata to labels and edit 
variables to be submitted with the media. Unlike Browse Catalog configurations, assets 
normally associated with binders—pre-processed metadata labels, proxy files, etc.—
aren’t present.

In Workflow Portal, the operator browses a Windows file system and selects media, and 
performs tasks as appropriate. This includes reviewing and editing metadata, and 
setting variable values for the job as appropriate.

Next, the operator submits the job to a publishing workflow, which can be designed to 
perform any task required. 
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Job Submittal Steps
Windows Portal displays a Browse button and a list of selected files—instead of a 
Vantage Catalog list—as shown below.

1. Click the Browse button.

Windows Portal displays the Select media file(s) to submit dialog shown here.

2. Use the Select media file(s) to submit dialog to select the file(s) to process.
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3. Click Open.

Each file that you open displays in the Select media file(s) list.

Repeat the Browse process as necessary, to select and add more files from any 
directories.

If the file list is not correct, you can edit the list manually. For example, you can 
select a given file path and delete it. Or, you can edit a path or filename, copy and 
paste file paths, or add new ones. To delete the list entirely, click Clear.

4. If multiple publish workflows are displayed in the Target Workflows list, check any 
target workflow to which you want to submit the media in the list.

If a checked box is not editable, this is a required workflow for this configuration.

5. Click Submit.

If the configuration does not provide any additional options, Windows Portal sub-
mits the selected media files to each of the selected publication workflows.

6. If the configuration supports metadata labels or variables, Windows Portal displays 
the Submit Jobs dialog with tabs for these options. Some configurations display a 
tab for metadata and variable editing.

7. When you are done preparing for submission, click Submit.
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Using EDL Portals
Note: This configuration can only be used in a Workflow Portal Windows client.

The EDL Portal enables you to create an Edit Decision List (EDL) which you submit to a 
publishing workflow to process the EDL. You select the media to use by browsing 
catalogs and selecting binders created from previously-completed ingest workflow 
jobs. You add clips to the clip list, update metadata and variables, and then stitch the 
clips together, encoding them in the publishing workflow to which you submit the EDL. 

The Telestream Edit Decision List (TSEDL) files created in EDL Portal can only be 
processed by Flip action-based workflows.

■ Ingest Workflow for EDL Processing

■ Job Processing and Submittal Steps
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Ingest Workflow for EDL Processing
To prepare media for stitching from an EDL, create an ingest workflow to encode it as 
required in a transcoding action, and register it in a catalog, following these guidelines:

• All media must have the same frame rate, timecode notation, and frame size, and 
the same media essence.

• Use a Flip or other transcoding action (if necessary), to encode your production 
media using one of these encoders: 

– MPEG-2 Program Stream

– VOD/MPEG-2 Transport Stream

– MXF

The output media must use the nickname Vantage EDL, so that the EDL configura-
tion can identify which media file to use for stitching.

• Use a Flip or other transcoding action to encode your proxy media for previewing/
clipping.

– QuickTime encoder, H.264 video codec, AAC audio codec, QuickTime 7.6.9 
installed

OR

– MP4 encoder, x264 video codec, AAC audio codec, QuickTime 7.7.6 installed

– See Previewing Proxy Media in the Media Player for additional proxy format details.

 Assign the nickname Vantage Proxy, so that the media player can play it.

Note: Be sure to encode proxies at the same rate and timecode notation as your 
production media. Clips that you mark use the proxy timecode—Workflow Portal 
applies it to the Vantage EDL media.

• Use a Keyframe action to produce keyframes—configured with the Keyframe 
encoder. Assign the nickname Vantage Thumbnail.

• Register the job in your target catalog to make it available to Workflow Portal.

Note: EDL Portal configurations expect binders to have media identified as Vantage 
EDL, Vantage Proxy, and Vantage Thumbnail. If you don’t follow these guidelines, the 
binders may not display in the catalog, you won’t be able to view the proxy to create 
clips or view keyframes, and your publication workflow may fail.
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Job Processing and Submittal Steps
After you have processed all of the media you want to stitch through your ingest 
workflow, open Workflow Portal with an EDL configuration to create your EDL and 
submit it for processing. When submitted, the files are clipped to the EDL settings and 
merged together into a single output file by the publishing Vantage workflow.

Follow this general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows are running (in Workflow 
Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.

3. For each binder you select, preview its media (Previewing Proxy Media in the Media 
Player) and use the Create EDL tab to add clips, setting mark-in/mark-out points to 
crop the media and update the metadata for each clip (Creating Clip Lists/
Segments).

4. Optionally, use the Metadata Labels tab to preview metadata. You can’t edit it in 
this panel.

5. In the Forward to Workflows (if displayed), check the workflow(s) you want to 
process the media with. This varies based on how the configuration is set up.

6. Click the Submit button to display the Submit Jobs window where you prepare the 
media’s assets for processing.

7. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

8. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

9. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).
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Using CML Portals
Note: This configuration can only be used in the Workflow Portal Windows client.

The CML (Composition Markup Language) Portal configuration is designed to create a 
Composition (CML) file that defines an EDL—the set of clips you’ve added from media 
registered in binders, which you submit to a Post Producer publishing workflow with a 
Conform action. The Conform action processes the composition, stitching the clips and 
renders a single media file as output, based on the specifications in the CML.

Note: Use of the Conform action requires a Post Producer license. For details on using 
Post Producer and compositions, see the Post Producer Developer’s Guide.

The Workflow Portal Create EDL configuration also supports EDL processing—using 
the Flip action—with similar functionality. However, the primary difference—and 
advantage—of using a CML Portal configuration is that you can incorporate clips from 
different media files with mixed essences. While the EDL Portal requires that all clips 
have the same frame rate, frame size and video codec; the CML Portal does not have 
this restriction. CML processing also improves VANC and caption processing.

The CML configuration is a create binder configuration—a new binder is automatically 
created and submitted to the publishing workflow.

The composition (CML file) created by the CML Portal can only be processed by 
Conform action-based workflows.

■ Prototype CML Configuration Workflows

■ Media Pre-processing, CML Creation, and Job Submittal
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Prototype CML Configuration Workflows
This topic describes prototype ingest and publishing workflows that you can use to set 
up a basic CML-based media processing system that involves operator-driven job 
submission using Workflow Portal. 

Before you can use Workflow Portal to operate a CML-based media processing system, 
you must create the following two workflows:

■ Prototype CML Portal Ingest Workflow

■ Prototype CML Portal Publishing Workflow

Prototype CML Portal Ingest Workflow
Use this topic to create an ingest workflow to create a proxy, optionally encode the 
media as required, and register it in a catalog, following these guidelines:

• Assign the output media the nickname Original so that the CML Portal can identify 
which media file to use as the source media when it generates the CML file for pro-
cessing in the publishing workflow.

• If required, use a transcode action (the Flip action, typically—not shown in the 
workflow above) to encode your media into one of the supported Post Producer 
formats (which accepts a much broader set of video, audio, and container formats 
than the Flip action does for EDL processing). See Post Producer Developer Guide For-
mats in the Post Producer Developer’s Guide or the Products > Post Producer > 
Specs page on the Telestream web site.

If you are re-encoding your media, since you can’t use the same nickname on input 
and output media in the same action, simply assign the input file a nickname other 
than Original.

• Use a Flip action to encode your proxy media for previewing/clipping.

– QuickTime encoder, H.264 video codec, AAC audio codec, QuickTime 7.6.9 
installed

OR

– MP4 encoder, x264 video codec, AAC audio codec, QuickTime 7.7.6 installed

•  Assign the nickname Vantage Proxy, so that the media player can play it.

Note: Make sure that you encode the proxy at the same rate and with the same 
timecode notation as your production media.

http://www.telestream.net/post-producer/tech-specs.htm
http://www.telestream.net/post-producer/tech-specs.htm


Using Workflow Portal Configurations
Using CML Portals

236

• Use a Flip action to create a single thumbnail for viewing in the browser.

– Encoder: Keyframe Encoder

– Video Codec: JPEG

– Container: JPEG File

 Assign the nickname Vantage Thumbnail, to display them in Workflow Portal.

• Use a Register action to register the media in your target catalog to make it avail-
able in Workflow Portal.

Note: If you don’t follow these guidelines, the binders may not display in the catalog, 
you may not be able to set mark-in/mark-out points, and your stitch workflow may fail.

Prototype CML Portal Publishing Workflow
Use this topic to create a publishing workflow to stitch and encode your output file.

Unlike the ingest workflow, the requirements for your publishing workflow are minimal. 
In almost every case, in practice, your publishing workflow will be far more complex 
than the prototype shown here.

• The publishing workflow must start with a Receive action, so that it can accept an 
input file from Workflow Portal. The nickname of the input file is CML.

• Use a Conform action to stitch and encode your media using the specifications in 
the auto-generated CML file you submitted. Configuration details are described in 
the man pages in the Conform action.

These are the two required actions; all other actions and configurations depend on 
your publishing workflow requirements.
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Media Pre-processing, CML Creation, and Job Submittal
To prepare media for stitching, copy the media (one or more files) that you want to 
comprise your final output into the ingest workflow’s watch folder. 

The ingest workflow will submit a job for each file, and (depending on the workflow 
configuration), create a proxy, a thumbnail, optionally re-encode the media to meet 
Conform-action format requirements, and register the media in a binder in the target 
catalog.

After you have processed all of the media you want to stitch through your ingest 
workflow, open Workflow Portal with a CML configuration to create your CML and 
submit it for processing. When submitted, the files are clipped to the CML settings and 
merged together into a single output file by the publishing Vantage workflow.

When you’re using a Create CML Portal to process media, an operator follows this 
general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows associated with this process 
are running (in Workflow Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.

3. For each binder you select, preview the media and add clips, setting mark-in/mark-
out points to crop the media (Previewing Proxy Media in the Media Player) and 
update the metadata for each clip (Creating Clip Lists/Segments).

4. Check the workflow(s) you want to process the media with (Specifying Forwarding 
Workflows). This varies based on how the configuration is set up.

5. Click the Submit button (Submitting Jobs in the Windows Client) to display the 
Submit Jobs window where you prepare the copied binder’s assets for processing.

6. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

7. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

8. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).

9. Click Submit. If variables are included in this configuration, Workflow Portal displays 
the Variables window, where you can supply run-time values.
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DPP Portal Overview
Note: The DPP Packager User Guide is also provided for complete details regarding the 
production of DPP-compatible media in Vantage.

The purpose of the DPP Portal is to enable operators to assemble and produce SD or 
HD media files that conform to the current DPP standard, for broadcast in the UK 
market.

This configuration can only be used in the Workflow Portal Windows client. 

You use a DPP Portal to browse catalogs and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then generate DPP-
compliant media which comprises the programme. A DPP configuration defines each 
field of DPP metadata in the programme, which may be given a default value, and may 
be marked as read-only.

The DPP portal is designed to allow you to:

• Create a DPP programme containing one or more segments

• Enter DPP metadata to accompany that programme

• Create a DPP XML file and a Composition (CML) file from which to generate the 
programme’s media file (with Post Producer) and transcode to AS-11 with DPP 
metadata (with a Vantage Transcode Pro license).
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Note: You can add a DPP Validate action (located in the Analysis group) to your target 
workflow to validate metadata in a DPP package.

After you have prepared the media you want to include in the package, you open 
Workflow Portal with the proper DPP configuration to create your DPP package, enter 
metadata as required, and submit it for processing. 

The DPP Portal automatically generates a CML file that defines the media, unless the 
operator provides a custom CML. The CML file and all related media files are submitted 
to the target Vantage workflow for producing the package.
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VOD | DAI Portal Overview
Note: The VOD Producer | DAI User Guide is also provided for complete details 
regarding the encoding media for VOD markets using VOD Producer Vantage.

The purpose of the VOD | DAI Portal is to enable operators to prepare source media and 
automate:

• CableLabs-compliant stream-conditioned media generation

• Canoe/BlackArrow-compliant dynamic ad insertion (DAI) location definition CSV 
(comma-separated value) files for local and national ads

• Nielsen audio watermarking.

VOD Producer performs media encoding and conditioning and Nielsen watermarking, 
along with automated delivery of programs and advertisements to MVPDs, and 
metadata to ecosystem partners in supporting workflows.

This configuration can only be used in the Workflow Portal Windows client. 

Note: You can also process CML and EDL files with automated VOD Producer and 
VOD Producer DAI workflows to produce VOD assets, without using VOD Portal. These 
are implemented using Vantage automation workflows, and are covered in the Post 
Producer Developer's Guide.

Generating and delivering VOD assets in VOD Producer involves at least two Vantage 
workflows. The diagram following illustrates the general process an operator follows to 
prepare, generate, and deliver VOD assets.



Using Workflow Portal Configurations
VOD | DAI Portal Overview

241

First, an operator selects a single file or a set of source media files, and submits them to 
an ingest workflow, supplying metadata as appropriate. The ingest workflow creates 
frame-accurate proxies and processes the metadata. It registers each source media file 
and its metadata, proxy, and keyframes in a catalog for access in VOD Portal.

Next, using VOD Portal, the operator selects and prepares source media for submission 
to the publication workflow. 

In VOD Portal, the operator performs the following tasks as appropriate:

• Select and identify segments in source media

• Add interstitials for promotion and cross promotion

• Define frame-accurate locations and value for dynamic ad insertion

• Brand each segment

• Add SCC file to clips as appropriate

• Configure V-chip settings and graphics

• Specify copy protection requirements

• Specify where to insert local and/or national ads—Segment, Head, or OTT, and pre-
roll, post-roll, or mid-roll, or lead black. 



Using Workflow Portal Configurations
VOD | DAI Portal Overview

242

The operator then submits the job to a publishing workflow, which performs these 
operations:

• Assembles the playlist composition

• Encodes the media as a CableLabs-compliant transport stream, optionally encod-
ing to adaptive bit-rate or mezzanine formats

• Optionally, watermarks the audio for Nielsen measurement, produces Nielsen 
metadata and creates Nielsen documents

• Optionally, produces ad metadata and creates DAI location definition files for 
Canoe/BlackArrow

• Simultaneously distributes the VOD asset to the MVPD and delivers the metadata 
associated with the asset to ecosystem partners (Nielsen and Canoe).
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Tempo Portal Overview
Note: The Tempo User Guide is also provided for complete details regarding re-timing 
media using Tempo.

The Tempo Portal enables operator-driven re-timing of media assets—intelligently 
decreasing or increasing the running time of shows and segments by up to ten percent.

This configuration can only be used in the Workflow Portal Windows client.

Re-timing assets in Tempo involves at least two Vantage workflows. The diagram 
following illustrates the general process an operator follows to prepare and re-time 
media assets.

First, an operator selects a single file or a set of source media files, and submits them to 
an ingest workflow. The ingest workflow creates frame-accurate proxies and optionally 
re-encodes the media to meet Tempo-processing requirements. It registers each source 
media file and its proxy and keyframe in a catalog for access in Tempo Portal.
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Next, using the Tempo Portal, the operator selects and prepares source media for 
submission to the publication workflow. 

In Tempo Portal, the operator performs the following tasks as appropriate:

• Browse clips in the selected Vantage catalog.

• Drag clips into a segment list and view them in a built-in video player. 

• Mark In/Out to identify clip segments and include/exclude them from re-timing.

• Add a graphic overlay (bug) and/or content rating graphic to one or more clips.

• Set exact overall clip duration, or increase/decrease clip time by a percentage.

The operator then submits the job to a publishing workflow, which re-encodes the 
media, re-timing it in the process, per the instructions specified in the XML file auto-
generated by Tempo Portal.
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Syndication Portal Overview
Note: The TrafficManager User Guide provides complete details about TrafficManager 
automated and operator-managed processing of syndicated material for broadcast.

Syndication Portal configurations can be used only in the Windows Workflow Portal 
client, not in the web client.

The Syndication Portal enables operators to review and prepare syndicated (long-form/
episodic) media for submission to a publishing workflow to encode it for broadcast, 
including these tasks:

• Metadata label review and update

• Segment list review based on a template, and update as required.

Generating syndicated assets in TrafficManager via Syndication Portal involves at least 
two Vantage workflows. The diagram following illustrates the general process to 
prepare, generate, and deliver syndicated assets to a broadcast server.
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First, an ingest workflow is triggered by an operator submitting a file, dropping it into a 
monitored folder, or automatically, via a catch server. The ingest workflow typically 
creates a frame-accurate proxy and a thumbnail, and transforms the metadata sidecar 
file into a mezzanine file for use in other Vantage workflows. It registers each source 
media file and its metadata, proxy, and keyframe in a catalog for access using the 
Syndication Portal.

Next, in the Syndication Portal, the operator selects and prepares source media for 
submission to the publication workflow.

In the Syndication Portal, the operator performs the following tasks:

• Selects and reviews segments, updating attributes, adjusting timing and segment 
order, adding/modifying spots, joining/unjoining commercial segments, etc.

• Reviews any metadata labels, updating as necessary

• Submits the media to one or more publishing workflows.

When the operator submits the media, in Stitching and Segmenting modes, two files 
are auto-generated by the Syndication Portal: an updated mezzanine metadata XML 
file, and a CML file. However, in Pass-Thru mode generates a new XML file, but does not 
generate a CML file. Instead, it passes the source media from the ingest workflow—
which must be nicknamed Original— to the publishing workflow, so that the program 
can be transcoded without having to change the program's timeline.
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A typical Automation workflow uses the metadata file to perform these essential tasks:

• Uses the Automate action to convert the mezzanine metadata XML file into the for-
mat required for a given automation system (ASDB or Bxf, for example).

• Delivers the entire payload to the automation system. 

A typical on-air server workflow uses the CML file to perform these essential tasks:

• Assembles the playlist composition into the broadcast media format required, 
using a Conform action (which requires a Post Producer license).

• Delivers the encoded media to a broadcast server.

For more information on using the Syndication Portal, see Implementing Syndication 
Portal Media Processing in this guide and also see the TrafficManager User Guide.
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Ingest Workflow Considerations
The ingest workflow for this portal follows the same pattern as other portals. Ingested 
assets must be registered into a Vantage catalog by the Register action before they will 
become visible in the catalog and available for use in the Workflow Portal. A thumbnail 
image is recommended (for clip icons) and a QuickTime H.264/AAC MOV or x264/AAC 
MP4 proxy file is required to be registered into a catalog and given the nicknames 
Vantage Thumbnail and Vantage Proxy, respectively. 

In the example below, a Watch action accepts the input media and forwards it to Flip 
actions that format the media into thumbnail and proxy files, and pass these files on to 
a Register action that adds the files to a catalog. The catalog can be accessed by the 
portal where operators can view and manage the files.

An Analyze action after the Watch action can be used to extract Letterbox Detection 
and Curtain Detection metadata from the media and put it into variables. The Vantage 
Editorial metadata label includes parameters for crop top, bottom, left, and right which 
are bound via a Populate action to the variables.

Once included in the workflow, the metadata and variables can be viewed in the portal, 
and operators can manually update them as desired.
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The following figure shows Analyze and Populate configuration examples that enable 
metadata visibility in the Logging Portal Metadata Labels tab.

The Analyze action can also automatically detect black segments used as spacers 
between content segments and generate an Analysis Result attachment. As shown 
below, the Logging Portal Segment List tab detects the Analysis Result attachment and 
populates the segment list with the detected content segments.
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Target Publishing Workflow Considerations
The clip log target workflow must begin with a Receive action. The Receive action 
accepts the clip list attachment and media file and must emit the previously specified 
General Attachment or Generated CML nickname (such as XML or CML). Additionally, 
the Receive may optionally emit the Original media version nickname. 
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Using Workflow Portal

Vantage Workflow Portal is a client program (also available as a web app) designed for 
customizable, operator-driven media processing. Several Workflow Portal 
configurations are provided to implement specific operational needs. The 
configurations allow you to customize functionality and the user interface and 
generate a specific output (for example, DPP configurations). 

You create and configure Workflow Portal configurations in the Vantage Management 
Console, and load them in Workflow Portal when you launch it to perform specific 
media processing tasks.

Note: Workflow Portal is an optional, licensed Vantage feature. For licensing details, 
refer to http://www.telestream.net/telestream-support/vantage/vantage-
licenses.htm. These topics apply to both clients, except where noted. For information 
on using each configuration type, see Using Workflow Portal Configurations.

The Windows client provides optimum performance and the full feature set. You can 
use the Workflow Portal web app. on any computer with a supported web browser (see 
Web Application Browser Requirements) and a network or Internet connection to your 
Vantage domain. Not all configuration types are supported in the web app. 

Topics
■ Workflow Portal Overview

■ Workflow Design Guidelines

■ Starting a Workflow Portal Session

■ Changing or Reloading a Configuration

■ Managing Workflow Portal Projects

■ Performing Workflow Portal Tasks

■ Windows Client Menus

■ Web Client Menus

■ Troubleshooting Workflow Portal

http://www.telestream.net/telestream-support/vantage/vantage-licenses.htm
http://www.telestream.net/telestream-support/vantage/vantage-licenses.htm
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Workflow Portal Overview
Video processing applications frequently require some form of operator intervention 
during media processing. For example, an operator might run media through an ingest 
workflow to create a proxy to check timecode and closed captions and scrub and set 
trim points, review and add/edit metadata and variables, and then submit (or forward) 
the media to another workflow to start a production processing job.

Note: For basic information on using Vantage client programs, see Vantage Client 
Programs Overview.

Note: On Windows Server 2008, you may have problems minimizing windows that 
you maximize by dragging to the top of the monitor (AeroSnap). To disable AeroSnap, 
go to Control Panel > Ease of Access Center > Change how your mouse works. Check 
Prevent windows from being automatically arranged when moved to the edge of the 
screen.

■ Key Applications

■ How Workflow Portal Works

■ Key Workflow Portal Features

■ Workflow Portal Configuration Types

■ Implementing Workflow Portal-based Media Processing

■ Implementing Syndication Portal Media Processing

Key Applications
Key applications of Workflow Portal include:

• Highlight Extraction From Archive Files—An operator marks in and out timecodes 
and chooses the timecode for a thumbnail, and processes the media in a workflow 
the creates the clip.

• Promo Preparation—An operator marks the voice-over and graphics entry points 
on the timeline. A subsequent workflow reprocesses the promo for multiple mar-
kets, days, and languages, based upon this input.

• Clip Stitching—An operator can select media files of various metrics and define clips 
within that media, then submit the EDL to a stitching workflow to combine the 
clips and render them into a single output file.

• VOD Distribution—An operator creates a playlist of clips and enters metadata. A 
subsequent workflow merges (stitches) the clips into a single media file and trans-
forms metadata for distribution.

• VOD Digital Ad Insertion—An operator defines national and local ad locations for 
dynamic ad insertion by the cable vendor, and submits jobs for assembly of Cable-
Labs VOD content and provisions it for dynamic ad insertion (DAI).
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• TrafficManager—An operator searches catalogs, then reviews and submits com-
mercial inventory for processing to a specific publishing workflow.

• TrafficManager Syndication—An operator reviews catalogs and submits syndicated 
inventory to a specific publishing workflow. See the TrafficManager Guide for operating 
details.

• DPP Package Preparation—An operator enters DPP metadata, marks programme 
segments, and submits the assets to a workflow. Vantage adds bars, generates 
slates, and encodes to the appropriate MXF format with DPP metadata to create a 
DPP package.

• CML Preparation—An operator creates clips, and submits the auto-generated com-
position (CML file) to a Conform-based workflow to generate the specified output.

• Re-timing of assets— An operator selects a media file and submits it to a Tempo-
based workflow for re-timing— intelligently decreasing or increasing the running 
time of shows and segments. Tempo utilizes new time compression algorithms that 
deliver superior quality and faster turn-around times.

How Workflow Portal Works
This figure depicts how Workflow Portal is typically used in a Vantage domain.

Operator-access to job variables and media metadata is a powerful feature that enables 
operators to control the operation of the next workflow. For example, operators can 
edit embedded and label metadata parameters, modify variables to control content 
routing, or select other processing options in the next workflow.

Workflow designers and Vantage 
administrators create workflows 
and Workflow Portal 
configurations for operators.

Operators use Workflow Portal to review media 
in catalogs, update metadata, trim points, and 
other data, and submit media to workflows.
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Key Workflow Portal Features
Workflow Portal provides several features for performing operator-intervention media 
processing workflows. Workflow Portal has a customizable user interface where 
components and features are controlled by a configuration file, created in the 
Management Console, and loaded in Workflow Portal when launched by an operator.

Depending on your application and configuration, these features allow operators to:

• Browse Vantage catalogs and servers for media (registered in binders) from com-
pleted jobs to process.

• Create an Edit Decision List (EDL) of clips for stitching with a Flip action workflow 
(Windows client only).

• Create a Composition file (CML) of clips for stitching with a Post Producer Conform 
action workflow (Windows client only).

• Create/review/update XML-based or label-based metadata.

• Review/edit embedded metadata.

• Preview/scrub media proxies.

• Mark in/out trim points on an asset’s timeline.

• Perform playback of selected segments.

• Mark media as approved or rejected.

• Supply run-time values to variables to use in the next workflow.

• Submit (forward) the media to workflows for further processing.

Workflow Portal Configuration Types
Vantage provides several configuration types. Each type has specific functionality, 
implementing a common media processing application. Here are the configuration 
types as specified in the management console, along with their common names:

• Browse Catalogs (copy binder)—Copy Binder Portal

• Browse Catalogs (forward binder)—Forward Binder Portal

• Browse Windows Network (create binder)—Windows Portal

• Create EDL from Catalogs (create binder)—EDL Portal

• Create CML from Catalogs (create binder)—CML Portal

• Create DPP from Catalogs (create binder)—DPP Portal

• Create VOD from Catalogs (create binder)—VOD Portal

• Re-time Asset from Catalogs (create binder)—Tempo Portal

• Syndication—Syndication Portal

The names on the left match the names a domain administrator sees when creating 
and setting up a Workflow Portal configuration, using the management console. The 
names after the dash are the common names used in this and other guides.
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Note: Some configurations can only be used in the Windows client. Others are 
available in both the Workflow Portal web client and the Windows client. 

The Copy Binder and Forward Binder, as well as the Create EDL, CML, DPP, Tempo, and 
VOD configurations allow operators to browse Vantage catalogs and select binders that 
have been registered by a previous job for processing.

The Browse Windows Network configuration allows operators to browse a Windows 
server (not a Vantage catalog) to select media files. (Binders only exist in the context of 
a Vantage catalog.)

Each type of configuration causes Workflow Portal to operate differently, to achieve its 
intended result. The operation of the basic configurations are explained in detail in 
Using Workflow Portal Configurations. Configurations offered as Vantage editions are 
described in a separate user guide.

Each of the configuration types are summarized in these topics:

■ Browse Catalogs Copy Binder and Forward Binder Configurations

■ Browse Windows Network Configuration

■ Create EDL from Catalogs Configuration

■ Create CML from Catalogs Configuration

■ Create DPP from Catalogs Configuration

■ Create VOD from Catalogs Configuration

■ Re-time Assets from Catalogs Configuration

■ Syndication Configuration

Browse Catalogs Copy Binder and Forward Binder 
Configurations
The purpose of both Browse Catalogs configurations is to enable operator-intervention 
media processing on Vantage catalog-based media. That is, the media has already been 
processed by a Vantage workflow and registered in the catalog, potentially along with 
other job-related assets: attachment files, metadata labels, etc. The operator can enter 
and edit label-based metadata for the selected media, and also update variables as 
required for the workflow. Browse Catalogs configurations are intended for processing 
a single file; they do not support creation of a clip list and stitching.

Both types of configurations are supported in the Workflow Portal web app and the 
Workflow Portal Windows client.

In a Browse Catalog Copy Binder Portal, the operator can browse catalogs, select a 
binder and submit a job to a workflow to process the media—after clicking the Submit 
button. When the operator clicks the Submit button, the selected binder is copied—
duplicated and used only as a template for the current job—leaving the original binder 
unchanged and intact in the catalog for future use or re-submittal. The job (as always) 
creates a binder during execution; it may or may not be registered by the workflow into 
a catalog for further utilization.
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In contrast, in a Browse Catalogs Forward Binder Portal, the operator browses a catalog 
and selects a binder—before clicking the Submit button. The selected binder (with any 
changes the operator makes) is submitted to the workflow—without making a copy. 

Forward binder mode allows the workflow to modify the contents of the original 
binder, and those modifications will be visible the next time the user refreshes the 
binder in the portal.

Browse Windows Network Configuration
The general purpose of the Browse Windows configurations is to enable operator-
intervention on media processing, where the media files are stored directly on a 
Windows platform. The operator can review and edit label-based metadata for the 
selected media, and also update variables as required for the workflow. 

The Browse Windows configuration is supported only in the Windows client.

The Browse Windows Network Portal (Windows Portal for short) allows you to select 
one or more media files from servers on a Windows network and submit them to target 
workflow(s). The job (as always) creates a binder during execution; it may or may not be 
registered by the workflow into a catalog for further utilization.

Create EDL from Catalogs Configuration
The EDL Portal enables you to automatically create an Edit Decision List (EDL) which the 
operator submits to a Flip-based workflow to process the EDL. When creating an EDL, 
the operator selects the media files to submit by browsing Vantage catalogs and 
selecting one or more binders created from previously-completed jobs. 

The Create EDL from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

You can mark start and end points to clip your input media files, and then stitch the 
selected clips together in the workflow to which you submit the EDL. The EDL 
configuration publishing workflow must use the Flip action to stitch and encode the 
media. The EDL Portal requires that all clips have the same frame rate, frame size and 
video codec.

The operator can also review and edit label-based metadata for the selected media, 
and also update variables as required for the workflow. The job creates a new binder 
from assets in or more source binders and updates it during execution; it may or may 
not be registered by the workflow into a catalog for further utilization.

Create CML from Catalogs Configuration
The CML (Composition Markup Language) Portal is designed to automatically create a 
Composition (CML) file that defines an EDL—the set of clips you’ve added from media 
registered in catalogs, which you submit to a Post Producer publishing workflow with a 
Conform action. The Conform action processes the composition, stitching the clips and 
renders a single media file as output, based on the specifications in the CML.
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The Create CML from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

While the EDL Portal requires that all clips have the same frame rate, frame size and 
video codec; the CML Portal does not have this restriction. CML processing by Conform 
also improves VANC and caption processing.

The operator can review and edit label-based and embedded metadata for the selected 
media, and also update variables as required for the workflow. The job creates a new 
binder from assets in or more source binders and updates it during execution; it may or 
may not be registered by the workflow into a catalog for further utilization.

Create DPP from Catalogs Configuration
The purpose of the DPP Portal is to enable operators to assemble and produce media 
files that conform to the current DPP standard, for broadcast in the UK market.

The Create DPP from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

You use a DPP Portal to browse catalogs and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then submit it to a 
publishing workflow to generate DPP-compliant media which comprises the 
programme. A DPP configuration defines each field of DPP metadata in the 
programme, may be given a default value, and may be marked as read-only. In 
addition, the portal may be configured for either SD or HD.

The job creates a new binder from assets in or more source binders and updates it 
during execution; it may or may not be registered by the workflow into a catalog for 
further utilization.

Create VOD from Catalogs Configuration
The VOD Portal is designed to enable operators to prepare VOD assets, including digital 
ad insertion, metadata, captioning, ratings, branding, and copy protection, and submit 
them to a publishing workflow that encodes VOD assets and deliver them to multi-
channel video programming distributors (MVPDs).

The Create VOD from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

You use a VOD Portal to browse catalogs and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then generate CableLabs-
compliant media. The operator can review and edit label-based and embedded 
metadata for the selected media, and also update variables as required for the 
workflow. The job creates a new binder from assets in or more source binders and 
updates it during execution; it may or may not be registered by the workflow into a 
catalog for further utilization.
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Re-time Assets from Catalogs Configuration
Use Tempo Portal to browse catalogs and select source media that you want to re-time, 
create and mark clips to include or exclude from re-timing, and specify how much time 
expansion or compression to apply. 

The Re-time Assets from Catalogs configuration (commonly called the Tempo 
configuration) is supported only in the Workflow Portal Windows client.

When re-timing configuration is complete, the Portal generates a composition to 
describe that processing. The operator selects a Tempo workflow to process the CML, 
and the Tempo action in the workflow implements media file re-timing. The job creates 
a new binder from assets in or more source binders and updates it during execution; it 
may or may not be registered by the workflow into a catalog for further utilization.

Syndication Configuration
Use the Syndication Portal to browse catalogs containing syndicated media and select 
the media that you want to review, update, and process in TrafficManager for 
broadcast. 

The Syndication configuration is supported only in the Workflow Portal Windows client.

The Syndication Portal displays the selected media in a segmented view, based on the 
timing information obtained from the original syndication source (for example, 
PitchBlue).

When your review and configuration of segments and their attributes is complete, the 
Portal generates a new mezzanine metadata XML file as well as a composition (CML) file. 
The operator selects a publishing workflow to process either the mezzanine metadata file 
or the CML file for broadcast.

When using Pass-Thru mode, the Syndication Portal does not generate a CML. In Pass-
through mode, the Portal generates an XML (similar to the other modes), but in 
addition passes the source media from the ingest workflow—which must be 
nicknamed Original— to the publishing workflow, so that the program can be 
transcoded without having to change the program's timeline.
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Implementing Workflow Portal-based Media Processing
Implementing Vantage workflows that are intended for use with Workflow Portal 
requires planning and coordination by your Vantage administrator and workflow 
designer. To implement a Workflow Portal-based workflow, a Vantage domain 
administrator must first use the Vantage Management Console to do the following:

• Enable the utilization of Workflow Portal.

• Configure one or more Workflow Portal configurations, which define the Workflow 
Portal feature set for the specific application, including the components, features, 
and resources available to operators. This includes metadata and variables, and 
must be coordinated with the workflow designer to utilize the metadata and vari-
ables as appropriate for your application.

Note: Administrators who are responsible for creating Workflow Portal configurations 
should refer to the Vantage Domain Management Guide for details.

Workflow designers use Workflow Designer to create and configure the required 
workflows, including required metadata and variables, and activate them when you 
want to use them in testing or production.

Typically, a given media processing application involves at least 2 Vantage workflows:

• An ingest workflow, which transcodes media as required and registers it in a catalog 

• A publishing workflow, which processes the media the operator has selected and 
forwarded to the workflow to encode it for publication.
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Implementing Syndication Portal Media Processing
The Syndication configuration of the Workflow Portal is described in detail in the 
TrafficManager User Guide, including operating details and workflows. The following 
steps summarize how to use the Syndication Portal (TrafficManager option required).

1. Create a syndication catalog using Management Console > Catalogs. 

2. Create a new syndication template using the Vantage Management Console > 
Syndication folder > Templates feature. Use the Populate from XML button to import 
an XML metadata file for the show and then adjust the show segments, if needed.

For template configuration details, see the Vantage Domain Management Guide.

3. Create an ingest workflow that includes an origin action (Catch, Receive, Watch/
Associate) capable of ingesting and localizing a syndicated media file and its 
sidecar metadata file. 

Also use Flip actions to create thumbnail and proxy files.

Include a Syndicate action to apply the template to the sidecar file, producing a 
mezzanine file nicknamed Syndication. 

Include a Register action to register the files into a binder for entry into the syndica-
tion catalog. The catalog must contain media nicknamed Original, a proxy, and a 
syndication metadata attachment nicknamed Syndication as required inputs to the 
Syndication Portal. (Note that only XML files for programs require the Syndication 
nickname; commercial files do not.)

The portal can then be used to access the binder and its files from the catalog. 

4. Create a publishing workflow. Typically, you’ll want to start with a Receive action to 
accept the files submitted from the portal and an Automate or Conform action to 
convert the XML or CML files and the syndicated media to the desired formats. 

In Automate, you can select BXF or other automation formats for outputting to an 
automation system. 

Note: The Syndication nickname is required for the attachment file in both the 
Receive and Automate actions, and the CML nickname is also required by the 
Receive action in Stitching or Segmenting mode.

5. Create a Syndication Portal configuration using the Vantage Management Console 
> Application Configuration > Workflow Portal. Set the Mode to Syndication, and 
set the parameters in each tab. In Syndication Settings, specify the template you 
created as the Default template. Also select a Syndication mode:

Stitching mode: Submitting from the portal generates a single CML file and a sin-
gle Syndication XML file for the whole program. Stitching mode requires all seg-
ments to be normalized to the same frame rate. 

Segmenting mode: Submitting from the portal creates a separate job for each 
included segment. A CML file and a Syndication XML file are created for each job.

Pass-Thru mode: Submitting from the portal does not create a CML. Instead, the 
Original from the ingest workflow is made available to the publish workflow and a 
Syndication XML is generated based on the Segment List. On the Forward To Work-
flows tab, select (Add) the publishing workflow. 
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6. Open the Workflow Portal and use File > Change/Reload Application Configuration 
to load the Syndication Portal configuration created earlier. Refresh the catalogs, 
select the syndication catalog, and drag one or more binders into the Segment List. 

Use the portal to preview and adjust segments manually.

7. Forward the updated show to the publication workflow by accessing the Forward 
To Workflows tab, selecting the workflow, and clicking Submit.

Media and metadata files are delivered to your automation system in ready-to-use formats. 

Note: After you fine-tune the segments of a show, you can save the template from 
the portal using the Create Template button. 

You also have the option when creating workflows to completely bypass the 
Syndication Portal, combine ingest and publishing into a contiguous workflow, and 
process all the files without human intervention. 
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Workflow Design Guidelines
This topic is for those who are designing and implementing workflows. It provides 
general guidelines for creating workflows intended for use in Workflow Portal 
applications.

Note: In addition to these general guidelines, there may be application-specific 
guidelines that must also be followed. These guidelines are noted in their respective 
topics in Using Workflow Portal Configurations for basic configurations; for product-
specific guidelines, see the Tempo User Guide or the VOD Portal User Guide.

While you can use a single workflow to produce and distribute media, there are some 
media processing applications which require operator intervention using Workflow 
Portal, thus dividing the media processing into multiple workflows. Operator 
intervention tasks include QA, building clip lists, and for adding/editing metadata and 
variables prior to job submission for further processing.

Workflows for use in conjunction with Workflow Portal typically fall into two categories: 
ingest and publishing. 

For example, an ingest workflow can automatically analyze source media and detect 
media attributes and characteristics such as frame rate, dimensions, letter boxing, and 
macro blocking. Ingest workflows often encode media into the required format for use 
in the publishing workflow. You typically use Register actions in the ingest workflow, to 
create binders in Vantage catalogs, which operators will browse for files to process.

Ingest workflows can also produce proxy media that you can view with the Workflow 
Portal media player to evaluate quality issues and quickly define timecodes for trim 
points or commercial insertion, for example.

A publishing workflow is a workflow designed to process media submitted by Workflow 
Portal operators. Publishing workflows always start with a Receive action so that 
operators can submit jobs to them (and they must be running). When your application 
calls for an ingest workflow, you use Workflow Portal to evaluate the ingest workflow 
results, take any action required, and then submit the job to a publishing workflow. 
Frequently, a given application has more than one publishing workflow. 

You can also chain publishing workflows, providing operator intervention at more than 
one point in the process.

You might use Workflow Portal in a Browse Windows Network configuration, where 
your process may not require an ingest workflow. You can use Workflow Portal to select 
media, edit metadata and variables and submit jobs to a publishing workflow, rather 
than just placing media files in a watch file for automated processing. The advantage to 
operator submission is that you can set metadata and variables during submission, 
providing more control over publishing workflow processing.

These topics provide guidelines for creating workflows for use with Workflow Portal:

■ Ingest Workflow Guidelines

■ Publishing Workflow Guidelines



Using Workflow Portal
Workflow Design Guidelines

263

Ingest Workflow Guidelines
When you use any Workflow Portal configuration other than Browse Windows Network, 
an ingest workflow, you must use an ingest workflow with a Register action (which 
should be located after all transcoding, and any metadata and variable modifications in 
the workflow), to create a binder in a catalog. One binder is created for each job that 
executes. In addition to referencing each file ingested or created in the workflow, 
metadata labels which you specify are stored in the binder, along with variables. 

You can use the special nicknames Vantage EDL, Vantage Proxy, and Vantage Thumbnail 
in Workflow Portal ingest workflows Flip action for identifying specific-purpose files:

• Vantage EDL—in the Program Stream and Transport Stream encoders, for EDL con-
figurations.

• Vantage Proxy—in the QuickTime and MP4 encoders, for all configurations which 
create clip lists and/or utilize the media player to scrub media

• Vantage Thumbnail—in the Keyframe encoder for configurations where you can 
browse catalogs.

When you browse catalogs in Workflow Portal, you can view binders created by each 
job, giving you access to all resources defined in the binder, including the source media.

When building ingest workflows, observe the following general guidelines:

• Register Action Requirements—to make a binder available to Workflow Portal opera-
tors in any catalog-enabled configuration, use a Register action to save the binder 
in the appropriate catalog.

• Workflow Portal Windows Client Media Player Requirements—Use the Flip action to 
create a proxy file, using the nickname Vantage Proxy. Required format:

– QuickTime encoder, H.264 video codec, AAC audio codec, QuickTime 7.6.9 
installed

OR

– MP4 encoder, x264 video codec, AAC audio codec, QuickTime 7.7.6 installed

– See Previewing Proxy Media in the Media Player for additional proxy format details.

• Make sure that your encoded proxy file is the same frame rate and timecode nota-
tion as your production media. Configure container settings to generate a time-
code track to support the Use Clip Start Time feature. You can also burn in the 
timecode to make sure it is present.

• Workflow Portal Web Client Media Player Requirements—Use the Flip action to create 
a proxy for previewing in the HTML5 media viewer. The required format is:

Encoder: MP4 Encoder

Video Codec: x264

Audio Codec: AAC

Container: MP4 File

Make sure that your encoded proxy file is the same frame rate and timecode nota-
tion as your production media.
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• Proxy Viewing—to enable a selected binder’s media file to automatically display in 
the Workflow Portal media viewer, assign the Vantage Proxy file nickname to the 
media file. 

• Catalog Viewing—To support operator viewing of binders by thumbnail (instead of 
by name), configure a Flip action with the Keyframes encoder to create a thumbnail 
that uses the Vantage Thumbnail file nickname.

• Metadata and Variables—To make media information available to operators for ver-
ification or editing, configure an Analysis action (or a Workorder action for submit-
ting multiple jobs at one time, with metadata) to collect the information in 
variables. Use a metadata label to store this information in a binder to pass the val-
ues to another workflow indirectly. For example, an operator submits a job to a 
publishing workflow in Workflow Portal.

Publishing Workflow Guidelines
Unlike ingest workflows, publishing workflows can be designed and configured in 
almost any way you require. Few limits are imposed on the design of a publishing 
workflow that is used by Workflow Portal.

When you configure publishing workflows, follow these guidelines:

• The publishing workflow must start with a Receive action or other action that 
allows an operator to directly submit media to the workflow for processing.

• The publishing workflow should be configured to accept and process any metadata 
labels and variables that an operator enters, or that pass through from the ingest 
workflow jobs.

• The publishing workflow must use the type of transcoding action required to pro-
duce the output media you want and the Workflow Portal configuration you’re 
using. For example, an EDL Portal job requires a Flip action, while a CML Portal con-
figuration requires a Conform action.

There may be additional requirements for various configurations. See the respective 
configuration topic in Using Workflow Portal Configurations or available app notes or 
guides on the topic.
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Starting a Workflow Portal Session
The following topics describe how to start sessions with the Workflow Portal clients, 
and how to load a different configuration:

■ Starting a Session with the Windows Client

■ Starting a Session with the Web Client

Starting a Session with the Windows Client
To start a session with the Workflow Portal Windows client, do the following:

1. Start the Windows client as described in Starting Workflow Portal.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Selecting the Vantage Domain.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Windows Client Programs.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, select the 
configuration you want to use for this session.

To change the Workflow Portal configuration, see Changing or Reloading a 
Configuration.

Starting a Session with the Web Client
To start a session with the Workflow Portal web client, do the following:

1. Start the web client as described in Web App Home Page—Launching Web Apps.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Logging In or Changing Domains from Web Applications.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Web Applications.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, select the 
configuration you want to use for this session.

To change the Workflow Portal configuration, see Changing or Reloading a 
Configuration, below.
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Changing or Reloading a Configuration
You can change Workflow Portal configurations while you are running Workflow Portal.

If a Vantage domain administrator updates a Workflow Portal configuration while you 
are using it, the program continues to use the configuration as it was when you 
selected it. To obtain the updated version, reload it when advised by the administrator.

■ Changing/Reloading a Configuration in the Windows Client

■ Changing/Reloading a Configuration in the Web Client

Changing/Reloading a Configuration in the Windows Client
To change or reload a configuration in the Windows client, do the following:

1. Select File > Change/Reload Application Configuration.

2. When the Select Configuration dialog appears, select a configuration to use and 
click OK.

Changing/Reloading a Configuration in the Web Client
To change or reload a configuration in the web client, do the following:

1. Select Portals.

2. Select the configuration to which you want to change.

3. When the confirmation dialog appears, click OK.
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Managing Workflow Portal Projects
In any Workflow Portal configuration in the Windows client, you can select media and 
set up a job (with clips, metadata, variables, etc.) and submit it, then start over with new 
media for the next job, etc. You can also start working on a new job, and then save it, 
and open it later to complete the work and submit it for processing. 

In Workflow Portal, the collective settings are referred to as a project. Using projects in 
Workflow Portal is similar to opening and working on files in Microsoft Word or Excel. 
You can create, edit, save, and re-open them any time you want.

Note: Projects are only valid for the domain they are created in and the Workflow 
Portal configuration they were saved from. You can not save projects from one domain 
and re-open the project for use in another domain. You also can not re-open a project 
if the configuration from which it was saved has been deleted from the domain.

■ Creating a New Project

■ Saving a Project

■ Saving a Project With Another Name

■ Opening a Project

Creating a New Project
To create a new project in Workflow Portal, select File > New Project, or select the New 
Project (+) button in the upper left corner of the Segment List tab.

Creating a new project is just like opening Workflow Portal and starting work. No media 
has been selected, no clips (if enabled) have been created or configured, and no 
metadata or variables have been modified. Everything is reset.

Creating a new project is handy if you are working continuously on selecting media 
and preparing it for submission to a workflow, then getting ready to select new media 
and starting another job: It clears out everything so you can start over again.

You can also create a new project when you have made an error that is not easy to fix, 
or you just want to start over with a clean slate.

You don’t have to create a new project just because you may want to save it later.
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Saving a Project
To save work you are performing on a given set of media, select File > Save Project.

When you save a project, Workflow Portal displays a File Save dialog. You can name the 
XML file anything you want, and save it where ever you want.

Note: Unlike other Vantage resources—workflows, Workflow Portal configurations, 
variables, etc. which are all stored in the Vantage domain’s database—Workflow Portal 
projects are stored as XML files in a Windows directory of your choosing, just like any 
other program’s data files.

Each time you save the project after the first time, it just updates the project file.

You can re-open it later using the Open Project command.

Saving a Project With Another Name
To save a project you have open under another name, select File > Save Project As. 
Workflow Portal displays a File Save dialog. You can rename the XML file anything you 
want, and save it where ever you want.

You can re-open it later using the Open Project command.

Opening a Project
To open a project that has been previously saved, select File > Open Project. Workflow 
Portal displays the Open File dialog. Navigate to the file and click Open.
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Performing Workflow Portal Tasks
The following topics describe how to use the components that comprise Workflow 
Portal, to perform these basic tasks:

■ Browsing Catalogs for Media

■ Selecting a Binder

■ Previewing Proxy Media in the Media Player

■ Creating Clip Lists/Segments

■ Editing Metadata Labels

■ Specifying Variable Values

■ Specifying Forwarding Workflows

■ Submitting Jobs in the Windows Client

■ Submitting Jobs in the Web Client

Browsing Catalogs for Media
You can browse catalogs and select media in binders in all configurations except 
Browse Windows Network configurations.

Note: The binder list doesn’t automatically update when binders are added or 
deleted as workflow jobs execute. To update the list, click the Refresh button at the 
top of the Binder table.

Depending on your configuration, you may be able to perform the following:

• Browse and select binders from multiple catalogs

• Select specific media in a binder for submission

• View the list of media in a selected binder

• Manually delete binders
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Selecting a Binder
To select a binder, do the following:

1. If the Catalogs panel (in the top left corner of the window) displays, select the 
catalog or catalog folder you want to browse.

Note: The catalogs that you can access are specified in the configuration. The catalog 
browser may be hidden, when the configuration only allows access to one catalog, 
with no subfolders.

2. In the Binder table (directly above the tabbed workspace—upper right—displays 
the name of the catalog you are browsing), select the binder that you want to view.

In the Windows client (see below), use the Filter menu, located directly above the 
Binder Details panel, to help you filter binders. Use the Details menu (far right) to 
select Details or Thumbnails view.

The columns that display in this table are controlled by the configuration, and may 
include Binder Name, Created, Expiration, and the Play button and Submit button, 
and others.

Catalogs Panel Binder or Thumbnail ListBinder Filter
Binder TableRefresh Binder



Using Workflow Portal
Performing Workflow Portal Tasks

271

In the web client (see below), use the Filter menu (directly above the Binder Details 
panel) to help you filter binders. To return to an unfiltered list and display all binders, 
click the Filter icon again. 

1. Select a binder. When a binder is selected, Workflow Portal display its contents in 
the Binder Details panel directly below the Catalogs panel.

Using Binder Table Controls
The Binder table supports the following features:

Filtering

Type text in the Filter field or select a previously-entered string from the menu to filter 
the binders in the currently-selected catalog. Delete the text to display all binders in the 
catalog.

Sorting and Re-arranging Columns

Click on any column heading to sort the binder list, and click repeatedly to toggle the 
sort by ascending or descending order. Drag column headings to re-arrange the order.

Playing/Pausing Video

If enabled in the configuration, you can click the Play/Pause button in a binder row to 
preview the media. Click Repeatedly to play or pause the video. (Windows client only; 
the web client excludes this feature.)



Using Workflow Portal
Performing Workflow Portal Tasks

272

Submitting a Binder

If enabled in the configuration, you can click the Submit button to display the Submit 
Jobs window.

Details/Thumbnails View

Select Details or Thumbnails from the menu.
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Previewing Proxy Media in the Media Player
When you select a binder, Workflow Portal displays any file nicknamed Vantage Proxy in 
the media player, provided that it is encoded in a supported format. The binder 
contents may or may not display (above the media player), depending on the 
configuration.

Note: Some configurations allow you to perform tasks and access player controls that 
other configurations do not. This topic discusses the full functionality of the media 
player, not all of which may be visible in your current configuration.

The following topics describe how to preview media:

■ Previewing Proxy Media in the Windows Client

■ Previewing Proxy Media in the Web Client

■ Previewing Non-proxy Media

Previewing Proxy Media in the Windows Client
When you preview proxy files in the Windows client, you are using the QuickTime 
Player. If you don’t have QuickTime Player installed, download and install the player on 
your Workflow Portal workstation before you can preview these MOV files.

Current Scrubber 
Location: 
Clock Time and 
Timecode Time

Open Folder
Open File
Expand Panel

Video frame

Audio meters (L/R)

Speaker and 
Volume
Player Buttons: 
Jump to Start
Bump Back
Play
Bump Forward
Jump to End

Scrubber & 
Timeline

Navigate to Segments (Tempo)

Clip Duration

Resizing Handle 

Binder File List 
(Select proxy file to 
play)

Timeline Expansion:
Reduce Scale 1/2
Center Timeline Slider
Double Scale
History Backward
History Forward

Navigate to Silence (Tempo)
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When you select a binder, Workflow Portal displays any video file nicknamed 
Vantage Proxy, if present. You can use the window, keyboard, and mouse 
controls listed in Window, Keyboard, and Mouse Controls to control playback. 
You can also preview other supported media in the binder.

Proxy Encoding Requirements

Use the Flip action configured with the QuickTime or MP4 encoder to create a proxy file for 
previewing/clipping in the Windows client version of Workflow Portal:

• For QuickTime 7.6.9: QuickTime encoder, H.264 video codec, AAC audio codec

• For QuickTime 7.7.6: MP4 encoder, x264 video codec, AAC audio codec. 

• Set the proxy frame rate and timecode notation to match the source media.

• Assign the nickname Vantage Proxy, which the media player automatically loads.

• Set SD proxies (4:3) to a suggested 640 x 480 frame size. 

• Set HD proxies (16:9) to a suggested 640 x 360 frame size. 

• For x264 Video:

– Set Video Profile to Baseline.

– Set Interlace Mode to Progressive.

– Set Video Bit Rate to 1,000,000 to 2,000,000 bits/second.

– Set the IDR placement to Forced Interval Only (disable scene detection) and set 
Force IDR Interval to 50% of the frame rate—if frame rate is 30, set IDR to 15. 

• Configure the QuickTime Movie or MP4 file container to generate a timecode track. 

• Set AAC audio to Stereo (for stereo audio meters).

Note: For Create EDL from Catalogs mode, EDL processing requires Program Stream 
or Transport Stream MPEG-2 video, which must be included in the binder with the 
nickname Vantage EDL. Vantage also supports for MXF DV, IMX, and XDCAM HD video 
formats. All assets in the EDL must have the same frame size and frame rate.

Basic Media Player Controls

The Media Player panel displays the video in the viewing panel. The Media Player panel 
is resizable horizontally and vertically; the media frame displays the proper aspect ratio 
in the available space. A Maximize button in the upper left corner expands the player to 
fill the portal or reduces it back to the lower left corner.

You can play sound or mute it, by clicking the speaker icon just to the left of the volume 
adjustment bar, and you can vary the volume by adjusting the volume slider. 

Audio meters display on the left and right, representing left and right channel stereo. 
When the video is playing (even when sound is muted) or as you scrub the media, the 
meters provide a visual clue representation of sound volume. The audio meters are 
designed to visually show the points of silence near where the operator is creating a 
new segment. In Tempo configurations, operators can use the Silence buttons to 
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navigate to and choose points of silence to create a new segment, to avoid audio 
anomalies during the re-timing process.

The scrubber and timeline below the display enables you to scrub the media; and the 
player buttons enable you to play, stop, bump forward and back, and go to the start 
and end of the clip. 

The two bottom center timecodes display the current scrubber location clock time 
(HH:MM:SS.SSS) and timecode time (HH:MM:SS:FF@FPS). The timecode at the bottom 
right of the display shows total duration of the clip (HH:MM:SS.SSS). 

Tick marks and coloring displayed on the timeline indicate mark in and mark out points 
and clip segments. (In Tempo only, overlapping segments are highlighted in red to 
indicate that operator adjustment is required.)

Timeline Expansion Controls

Timeline expansion controls above the scrubber enable finer control of longer projects 
by expanding the length of the timeline. These controls are enabled and disabled by 
selecting or deselecting Options > Enable Preview Player Timeline Expansion.

The + and - buttons allow you to double or halve the timeline length with each press, 
and the tooltip for each control shows how much expansion has been applied.

When the timeline is expanded, a new slider below it controls which portion of the 
expanded timeline is visible. The C button centers the timeline slider. The two arrow 
buttons enable you to move backward and forward in timeline history. 

Note that the timeline automatically scrolls or centers the timeline when you perform 
actions on a part of the timeline that is not currently visible. 
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Window, Keyboard, and Mouse Controls
The Windows client window, keyboard, and mouse controls are listed in Window, 
Keyboard, and Mouse Controls.

Note: Clicking in the playback controls area or on the video focuses the preview 
player controls (indicated by the blue border). Focusing this area enables “JKL” controls 
instead of the shortcuts.

Function Controls

Play/Pause/Reverse Ctrl+P or Ctrl+Space

J (Reverse play—repeat for -1.5x, -2x, -5x, -8x)

K (Pause)

L (Play—repeat for 1.5x, 2x, 5x, 8x)

JK simultaneously (Reverse play slow motion -1/8x; repeat for 
-1/4x, -1/2x)

KL simultaneously (Forward play slow motion 1/8x; repeat for 
1/4x, 1/2x)

Stop Ctrl+S

Forward Frame Ctrl+F

Ctrl+Mouse Wheel, one frame per wheel click

K held down + L (Forward bump one frame)

L held down with K already pressed (Forward bump repeat 
1/4 speed)

Left Arrow (Reverse bump one frame)

Right Arrow (Forward bump one frame)

Forward/Reverse 10 
Frames

Up Arrow (Forward bump 10 frames)

Down Arrow (Reverse bump 10 frames)

Forward/Reverse 
One Second

Mouse Wheel (no modifier keys)—one second per wheel click

Forward/Reverse 
One Minute

Shift+Mouse Wheel—one minute per wheel click

Forward/Reverse 
One Hour

Ctrl+Shift+Mouse Wheel—one hour per wheel click
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Reverse Frame Ctrl+B

Ctrl+Mouse Wheel, one frame per wheel click

K+J (Reverse bump one frame)

k+J held down (Reverse bump repeat 
1/4 speed)

Mark In Ctrl+I or Ctrl+E (In points are indicated by tick marks on the 
timeline.)

Mark Out Ctrl+O or Ctrl+R

Go to mark in frame Ctrl+Q

Go to mark out 
frame

Ctrl+W

Go to start Ctrl+Home

Go to end Ctrl+End

Audio Mute (toggle) Ctrl+M 

Adjust Volume Drag volume button right or left to adjust volume.

Scroll media Drag media button right or left to scrub (scroll) media.

Duplicate selected 
clip

Ctrl+T (Selects the new clip and sets its mark in to the original 
clip’s mark out, if appropriate)

Jump to next 
segment

Alt+Left | Right Arrow Jumps to the next or previous segment, 
as noted by the white bars on the scrubber bar. Works even 
when segment markers are not displayed. 

Jump to next scene 
change marker

Shift-Alt+Left | Right Arrow Jumps to the next or previous scene 
change marker, as noted by the green bars on the scrubber bar. 
Works even when scene change markers are not displayed. 

Function Controls
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Previewing Proxy Media in the Web Client
When you view proxy files in the Workflow Portal web client, you are utilizing the native 
HTML5 Video Player in the web browser.

Note: The appearance of captions in the proxy may vary, depending on the browser 
you’re using. Try supported browsers to find one that best suits your requirements.

Web Workflow Portal Proxy Encoding Requirements

Use the Flip action to produce a proxy file for previewing in the Workflow Portal web 
client’s HTML5 media viewer, using these settings:

• For QuickTime 7.6.9: QuickTime encoder, H.264 video codec, AAC audio codec

• For QuickTime 7.7.6: MP4 encoder, x264 video codec, AAC audio codec. 

• Set the proxy frame rate and timecode notation to match the source media.

• Assign the nickname Vantage Proxy, which the media player automatically loads.

• Set SD proxies (4:3) to a suggested 640 x 480 frame size. 

• Set HD proxies (16:9) to a suggested 640 x 360 frame size. 

• For x264 Video:

– Set Video Profile to Baseline.

– Set Interlace Mode to Progressive.

– Set Video Bit Rate to 1,000,000 to 2,000,000 bits/second.

– Set the IDR placement to Forced Interval Only (disable scene detection) and set 
Force IDR Interval to 50% of the frame rate—if frame rate is 30, set IDR to 15. 

• Configure the QuickTime Movie or MP4 file container to generate a timecode track. 

• Set AAC audio to Stereo (for stereo audio meters).
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Note: You can right-click on the video to display a context menu with many player 
commands as an alternative to using the player controls or keyboard shortcuts. The 
available controls vary with the browser.

To view a proxy, select a binder and use the controls in Web Workflow Portal Keyboard 
Controls to control playback. 

Previewing WebVTT Caption Files
Vantage can process media containing closed captions and produce a proxy media file 
and an accompanying WebVTT caption file. The proxy can be previewed with WebVTT 
captions using the HTML5 media player in Internet Explorer.

Note: Only Internet Explorer supports this playback feature. 

To create a proxy with WebVTT captions, follow these requirements in an ingest 
transcoding workflow:

• Use an Analyze action, with Ancillary Data Detection > Publish Metadata > Generate 
WebVTT Attachment implemented to create a WebVTT file. It must be nicknamed 
Vantage Caption Source. The file will be saved in a Vantage store.

• A newer alternative to creating a WebVTT file is the Timed Text Flip action. Specify 
the input media, caption, or subtitle file to decode; then specify a WebVTT output.

Note: An HTTP alias must be set up for the web portal. See Web Application Browser 
Requirements.

• Use a Flip action to transcode the file using the MP4 x264 encoder with closed cap-
tions enabled.

• Use a Register action to add the job (for accessing the proxy and the WebVTT files) 
in a catalog. 

• Display the proxy with captions in the Workflow Portal web applications’ media 
player. Be sure to set the player caption control in the gear menu to enable Closed 
Captions. 

Listening to Individual Audio Tracks
To listen to individual audio tracks in a proxy file using the web version of Workflow 
Portal, enable multiple audio streams in the Flip action (encoding MP4) that produces 
the Vantage Proxy nicknamed proxy file in the ingest workflow.

Note: Only Internet Explorer supports this playback feature. 
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Web Workflow Portal Keyboard Controls
The keyboard controls are dependent on the web browser (and the version) that you 
use. Most browsers provide fast forward, and some—such as Internet Explorer—
provide reverse as well. Workflow Portal’s playback rates aren’t generally implemented 
in every step—usually only x2 and x8 are supported. 

Note: The HTML5 Video Viewer must be in focus (you must click in the video frame) in 
order to use the player controls and keyboard shortcuts.

Function Controls

Play

Enabled in play mode (click 
Play button or press K key).

  (appears in binder list)

Press L x 1—play 1x speed (normal).
Press L x 2—play 2x speed.
Press L x 3—play 3x speed.
Press L x 4—play 5x speed.
Press L x 5—play 8x speed.

(IE only) Tap the + (plus) key to accelerate the clip’s play 
speed to the next level. Press the - (minus) key to 
decelerate the clip’s play speed down the next level.

Reverse Play

Enabled in play mode (click 
Play button or press K key).

 

Press J x—reverse play.
Press J x 2—reverse play 2x speed.
Press J x 3—reverse play 3x speed.
Press J x 4—reverse play 5x speed.
Press J x 5—reverse play 8x speed.

(IE only) Press the + (plus) key to accelerate the clip’s play 
speed up to the next level. Press the - (minus) key to 
decelerate the clip’s play speed down the next level. 

Play/Pause

Press K—play forward or pause. Hold K down to step in 
reverse. 

Forward Frames

Press L—step forward one frame.

(IE only) Press the Right Arrow key—move forward 10 
frames. 

(Chrome and IE 11) Press the Right Arrow key—move 
forward 1 frame. Press the Up Arrow key to move forward 
10 frames. 

The arrow keys on the numbers keypad function in the 
same manner.
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Reverse Frames  

Tap J—move reverse one frame.

(IE only) Press the Left Arrow key—move reverse 10 
frames. 

(Chrome and IE 11) Press the Left Arrow key—move 
reverse 1 frame. Press the Down Arrow key to move 
reverse 10 frames. 

The arrow keys on the numbers keypad function in the 
same manner.

Go to start

(IE only) Press the Home key.

Go to end

(IE only) Press the End key.

Mute audio

(IE only) Press the M key during play. Press again to 
unmute.

Scroll media  

Full screen mode

Press this button to expand to full screen mode.

Zoom mode (IE 11 only) Press Z to zoom in. Press Z again to zoom back 
out. 

Video-safe overlay  

Click to display/hide the video safe overlay frame, for SD 
and HD proxies. 

Closed captioning  

Click to display closed captions, when provided by 
browser.

Audio track menu

When multiple audio tracks are present, the Audio menu 
displays. Click to select the track you want to hear. (IE only).

Function Controls
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Previewing Non-proxy Media

Note: This feature is only supported in the Windows client and only when the binder 
detail display is enabled in the configuration.

Media with a nickname other than Vantage Proxy may be played under certain 
conditions. Select the media in the binder list (directly above the media player) and try 
these methods:

1. For QuickTime (.mov) files, select the file and use the media player controls to play 
the media file.

2. To play a QuickTime file outside the embedded media player, right-click the media 
and select Open With Default Program or click the file icon directly above the 
binder list to play the media file in the default program for MOV files.

3. If you don’t have a default program assigned to handle MOV files, right-click the 
media asset, and select Open Containing Folder or click the folder icon directly 
above the binder list. The Windows folder containing the media opens, so you can 
right-click the file and play it using Open With to select a suitable program.

4. For files other than QuickTime, right-click the media and select Open With Default 
Program or click the file icon directly above the binder list to play the media file in 
the default program for the specified suffix of the file.

5. If you don’t have a default program assigned to play this file type, right-click the 
media asset, and select Open Containing Folder or click the folder icon directly 
above the binder list. The Windows folder containing the media opens, so you can 
right-click the file and play it using Open With to select a suitable program.

Previewing Media Using the Switch Player
The Telestream Switch video player can be installed and used (without a separate 
license) as an alternative to the Workflow Portal preview player in portal configurations 
that support Switch. When available, Switch player access appears as a small red Switch 
logo  in the preview player toolbar. Click the logo button, and if Switch is properly 
installed on the client computer, it will open the selected clip. See the Switch guide and 
Help for Switch installation and operation.
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Creating Clip Lists/Segments

Note: Microsoft User Account Control, by default, prevents Windows programs (such 
as the Workflow Portal client program) from writing files in certain protected folders. If 
you receive an error message indicating that access to a particular Vantage store or 
folder is denied, contact your Vantage administrator. Solutions include changing the 
location of the store/folder or disabling UAC on computers running Vantage clients.

Configurations that support clip/segment lists display a clip or segment management 
tab in the workspace (this tab differs, depending on the configuration):

To create a clip/segment list, do the following:

1. Browse the binders in the selected catalog, and select a binder to display its proxy 
in the media player.

2. Display the clip management tab (named Create EDL | Create CML | Create Parts | 
Segment List, depending on the configuration), and use the following topics to 
create and configure clips/segments:

■ Adding Clips

■ Evaluating Clip Metadata and Attributes

■ Editing Clip Start and End Times

■ Updating Segment Attributes in VOD/DAI Configurations

■ Updating a Selected Segment and Configuration

■ Deleting Clips

■ Reordering Clips
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Adding Clips
You can add multiple clips to a list, and you can add the same clip multiple times. 

Note: If you do not want to combine clips in one file, you can clip the same file 
multiple times. For example, if you are extracting multiple highlights from a single 
media file, you can mark a highlight, select Submit, and then mark a new highlight 
without affecting the first one.

To add a clip to the list from the media in the selected binder, click the Add button , 
or drag the binder to the list.

Note: EDL/Segment List clips must have the same frame size and frame rate. In a CML 
configuration, this is not a requirement. When you add the first clip to an EDL, the 
frame size and rate of the EDL are set to the metrics of that clip. Once the frame size 
and rate are set for a list, Workflow Portal does not allow you to add an incompatible 
clip. If you select a binder with a clip that is incompatible, the Add button is disabled to 
indicate that the clip cannot be added.

Each clip you add creates a tick mark on the timeline where the Mark In point is located.

Evaluating Clip Metadata and Attributes
When you select a clip, Workflow Portal displays the clip details to the right. The 
information may include the frame size and the frame rate, as well as other information 
about the selected clip, depending on the configuration.

Editing Clip Start and End Times
The default clip start and end times are the start and end times defined in the source 
media file. To trim the clip, edit the start and end times to define the clip you want.

To change the clip start time do any of the following:

• Use the media player to scrub to the start time and frame, then click the Mark In 
button to set the mark in time.

• Click in the Mark In time setting and press Ctrl+M.

• Type time or frame values in the Mark In time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark In time setting, click one of the numbers and use the up and down con-
trols to change the value.

To change the clip end time do any of the following:

• Use the media player to scrub to the end time and frame, then click the Mark Out 
button to set the mark out time.

• Click in the Mark Out time setting and press Ctrl+M.



Using Workflow Portal
Performing Workflow Portal Tasks

285

• Type time or frame values in the Mark Out time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark Out time setting, click one of the numbers and use the up and down 
controls to change the value.

• Adjust the duration timecode, which adjusts the mark out point relative to the mark 
in point. This field indicates the duration of the media between the mark in/out 
points of the currently selected clip.

If you specify a mark in, mark out, or duration timecode that makes one or more of the 
timecodes invalid, the affected timecodes display a red background. For example if you 
select a Mark In timecode that starts after the Mark Out timecode, the Mark In and 
Duration timecodes display red. Also, if the duration timecode moves the mark out 
timecode beyond the end of the clip timeline, both the Duration and Mark Out fields 
display red to indicate the error.

The duration timecode can be dropframe or non-dropframe, depending on the setting 
of the Use dropframe notation for duration when appropriate checkbox in the Vantage 
Management Console Workflow Portal Configurations panel. By default (unchecked), 
durations are always shown in non-dropframe. When checked, durations match the 
dropframe setting of the in/out values. (The Web Workflow Portal uses non-dropframe 
notation only.)

Updating Segment Attributes in VOD/DAI Configurations
VOD/DAI configurations include Segment Metadata which is adapted for ad insertion. 

A check box allows the rating graphic to be inserted into the selected segment. Details 
for the rating graphic are specified in the Vantage Management Console VOD/DAI 
Portal configuration Graphic Settings tab. These details include the graphic file to use, 
its screen location, duration on the screen, and other attributes, 

An SCC caption file can be included for each segment by browsing for the file.

An Ad insertion selection specifies the segment type:

Segment—This segment is marked for replacement by a dynamically inserted 
advertisement.

Head—This segment follows a dynamically inserted advertisement.

OTT—This segment consists of content to be delivered over-the-top (streamed).

None—This segment is program content or other content not designated for 
replacement by an ad (the default).

A Descriptor for Segment and Head can be selected to put ad breaks into the correct 
locations in the Canoe CSV report—at lead black, pre-roll, mid-roll, or post-roll. See the 
Post Producer Developer’s Guide for rules governing these selections.

CML Configuration settings (in CML and DPP Portals) allow you to specify an Output 
File Name for the completed project, indicates the approximate duration of the entire 
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project, and allows you to choose to unjoin segments that were joined previously using 
the portal.

Updating a Selected Segment and Configuration
For some portals types, such as Logging, a selected segment displays and allows you to 
edit segment and configuration details. These details vary by portal:

Mark In—The time marked in using the portal player.

Mark Out—The time marked out using the portal player.

Duration—The segment duration (difference between mark in and mark out).

Name—Segment name.

Description—Segment description.

Type—Segment type (a descriptive term selected from a list created in the Vantage 
Management Console).

Attachment Name—The XML clip list attachment generated by the portal and 
read by the target workflow. The default name for logging is [clip name]_DATA.

CML Name—(in CML and DPP Portals) The CML clip list name attachment for log-
ging is [clip name]_CML.

Job Name—A name you choose for the job. The default is the clip name.

In some portals you can also check Not Included to exclude a segment from the output. 
When a segment doesn’t match the type or the Not Included template setting, the clip 
is marked with a badge to alert you of the inconsistency, which may indicate a problem.

You can also modify the base name of the output files (an updated mezzanine 
metadata file and a CML file), and create a new template using the current segment 
configuration.

The configuration panel also includes segment cropping values for both the preview 
and Switch players. The Switch player’s values can be assigned to variables.

Reordering Clips
To change the order of a clip in the list, click on the clip and click the up  and down  
buttons, or click and drag the clips, to change the clip position.

Joining (Merging) and Unjoining (Splitting) Clips
Some configurations include a Join/Merge button  that allows you to join or combine 
two or more clips selected by Ctrl+clicking. When joined, the clips become one clip. To 
unjoin (split) clips and separate them again into individual segments, select Unjoin/Split 
button .

Deleting Clips
To delete a clip from the list, click on the clip and click the Delete button .
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Editing Metadata Labels
When the Workflow Portal configuration permits it, you can view and update the 
metadata labels ingested, produced, updated, or passed through previous workflows. 

Note: In a Forward Binder configuration, you edit metadata before submitting the 
binder to a publishing workflow. Changes are made in the binder you selected in the 
catalog. 

In a Copy Binder and Logging configurations, you click Submit and then enter 
metadata for the new binder you are creating. Your edits do not affect the original 
binder you selected from the catalog—only the new, copied binder.

In a VOD/DAI configuration, a Metadata Label source clip check box specifies which clip 
should be used as the source for metadata labels. The Metadata Labels tab then shows 
the labels associated with the selected clip.

When you submit a binder, all metadata labels are included. If the configuration 
supports metadata entry and editing, you can modify metadata labels before you 
submit. All metadata labels are applied to all media files that are being submitted.

The following topics describe how to edit metadata labels:

■ Editing Metadata in the Windows Client

■ Editing Metadata in the Web Client

Editing Metadata in the Windows Client
If the configuration supports metadata editing, you can edit them as follows:

1. Display the Metadata Labels tab.

2. Select the label you want to edit in the Metadata Label list.

3. In the Parameter list to the right, edit the parameter values. 
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4. If the metadata label you want to configure does not display in the list and the 
configuration permits adding labels, click the new label button, select a label to 
add, and click OK.

Note: This option is not available when submitting files in a Browse Windows 
Network configuration.

Editing Timecode Values with Hot Keys

If hot keys are assigned to input, output, or duration parameters in this configuration, 
you can use them to set these values as you scrub the media in the player. Roll over the 
mark button to display the assigned hot key in the tool tip.

Editing Timecode Values in Trim Groups

If trim groups are defined (a set of input, output, and duration parameters) in this 
configuration, the duration is automatically calculated. If you change the input value or 
output value, duration is automatically updated. If you change the duration value, the 
output value is automatically updated.

The duration timecode can be dropframe or non-dropframe, depending on the setting 
of the Use dropframe notation for duration when appropriate checkbox in the Vantage 
Management Console Workflow Portal Configurations panel. By default (unchecked), 
durations are always shown in non-dropframe. When checked, durations match the 
dropframe setting of the in/out values.
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Editing Metadata in the Web Client
If the configuration supports metadata editing, you can configure them as follows:

1. Initiate submit mode as described in Submitting Jobs in the Web Client.

2. To add a metadata label to configure, do the following:

a. Click Add Label.
b. Select a label to add from the Add Metadata Labels dialog.
c. Click Add.

3. To edit metadata label parameters, locate the tab for the label, select the tab, and 
configure the label parameters.

Note: If a label parameter includes a valid URL, an Open button automatically appears 
next to the parameter, allowing you to open to that URL by clicking the button.

4. To remove a metadata label configuration, locate the tab for the label, select the 
tab, and click Remove Label.

5. Repeat metadata label selection and parameter configuration until all required 
metadata labels are configured.

6. If you need to configure variables, see Specifying Variable Values.

7. When you are done preparing for submission, click Submit.
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Specifying Variable Values
You can set up Workflow Portal configuration to enable you to review and edit/add 
variable values stored in a binder from a previous job, before you submit the media 
(and the variables) to a publishing workflow.

Note: In Forward Binder configurations, you can edit variables in the main window; in 
Copy Binder configurations, you can only edit variables after you click the Submit 
button, in the Submit Jobs window. For details, see Browse Catalogs Copy Binder and 
Forward Binder Configurations.

Edit run-time variable values as follows:

Display the Variables tab on the main window or the Submit Jobs window (depending 
on the type of configuration), as shown below:

For each variable displayed, enter or update the run-time value as required.
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Specifying Forwarding Workflows
Depending on your configuration setup, you may or may not be able to specify which 
workflow to submit jobs to:

• One or more workflows have been set as required in the configuration, and they are 
displayed as checked and disabled.

• One or more workflows have been set as required in the configuration, but the 
workflows list is hidden.

• One or more workflows are displayed; you can check those that you want to pro-
cess this job. If this is the case, the Forward to Workflows panel displays:

Check the workflows you want to submit this job to and click Submit. (These workflows 
must be activated in Workflow Designer, or your jobs will fail to run.)

For details on submitted jobs, see Submitting Jobs in the Windows Client or Submitting 
Jobs in the Web Client.
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Submitting Jobs in the Windows Client
When you click Submit, depending on the Workflow Portal configuration you are using, 
you may or may not have performed the following tasks at this point in the process:

■ Previewing Proxy Media in the Media Player

■ Editing Metadata Labels

■ Specifying Variable Values

■ Specifying Forwarding Workflows

For each of these tasks (which must be performed before you can submit the media to 
the publishing workflow for processing), the associated panel is displayed.

Click the link above to display the help topic for the task you are performing.

Submitting Jobs in the Web Client
When you initiate job submission in the web client, the Workflow Portal view changes 
from displaying media information to submitting information. 

The Workflow Portal configuration may specify one or more required workflows, or you 
might be allowed to select one or more workflows from a list. Some of these options are 
limited to a particular configuration, and some of them can be disabled. The options 
that apply to your environment are defined by the Vantage domain administrator and 
the workflow designer.

If the selected configuration allows you to view the workflows to which you can submit, 
Workflow Portal displays a Forward to Workflow tab. If the configuration does not 
support operator viewing of workflows, Workflow Portal just displays a Submit button.

To initiate submit mode, do the following:

1. If the Workflow Portal window displays a Forward to Workflows tab, do the 
following:

a. Select the Forward to Workflow tab.
b. Check or clear each workflow checkbox to specify which publishing workflows 

should process the job.
c. Click Submit to enter submit mode.

2. If Workflow Portal does not display a Forward to Workflows tab, do one of the 
following to initiate submit mode:

– Click the Submit button.

– Click the submit button  to the right of the binder name in the binder list.

If no other configuration options are available, the binder is submitted to the 
selected workflows.

3. If other configuration settings are available, Workflow Portal displays a dialog in 
which you can configure those options. For more information, refer to Editing 
Metadata Labels and Specifying Variable Values.

4. When you are done preparing for submission, click Submit.
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Windows Client Menus
This table describes the menu selections in the Workflow Portal Windows client.

Menu Selection Description

File Change Vantage Domain Enables you to log into another Vantage 
domain. See Selecting Vantage Domains and 
Logging In.

Change Vantage User Enables you to change Vantage users. See 
Changing Vantage Users in Windows Client 
Programs.

Recent Domains Lists the last few Vantage domains that 
were used in this client.

Change/Reload 
Application Configuration

Enables you to select another 
configuration, or reload a configuration 
that has been modified to pick up the 
changes. See Changing or Reloading a 
Configuration.

New Project Resets the Workflow Portal configuration to 
a new state, clearing all media and data in 
all tabs. See Creating a New Project.

Open Project Opens a project that was previously saved 
so that you can continue working or submit 
a job. See Opening a Project.

Save Project Saves the project in its current state—
media you’ve selected, and all data you’ve 
entered or set, for future use. See Saving a 
Project.

Save Project As... Saves the current project under another 
name, replicating the media and data and 
settings as another project. See Saving a 
Project With Another Name.

Exit Closes the Workflow Portal program.

Options Restore Tips & Warnings Restores the display of Workflow Portal tips 
and warnings after the feature has been 
disabled.

Hide Tips & Warnings Hides Workflow Portal tips and warnings.
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Use Clip Start Time Toggle this feature. When a check displays, 
the preview window uses the start time 
defined in the proxy media. If no check 
displays, the start time begins at zero.

Help Contents Display a Windows help version of this 
guide.

Index Display the index of this guide.

Search Search for key words in this guide.

Online Help Display the Vantage guides available on the 
Telestream web site.

About Display the Workflow Portal version 
information.

Menu Selection Description
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Web Client Menus
This table describes the menu selections and title bar options in the web clients.

Menu Selection Description

Title bar 
options

Change Password See Changing Passwords in Windows Client 
Programs.

Logout Log out the current Vantage user.

Change Domain See Selecting Vantage Domains and Logging 
In.

Catalogs 
menu

Refresh Catalog Listings Click to refresh the display of catalogs.

Help 
menu

About Select to display Workflow Portal product 
version information.

Help Documentation Click this entry to toggle the display of the 
submenu.

User Guide Click to display the PDF version of this 
guide in a separate browser window.

Web Help Click to display the HTML version of this 
guide in a separate browser window.
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Troubleshooting Workflow Portal
Use the following topics to help you solve certain problems with Workflow Portal:

■ Opening Workflow Portal the First Time

■ Difficulties Changing Configurations

■ Problems Playing Proxy Files

■ Configurations Don’t Display in the Web Client

■ No Session Licenses Available

Note: For customer service, see Contacting Telestream. You may use the Data 
Collection Utility (Vantage Management Console > Support Utilities > Data Collection). 
You may also use the Change Log or Error Log utilities to provide information during 
your service call.

Opening Workflow Portal the First Time
When opening Workflow Portal for the first time, depending on the design of your 
network and the location of your client workstation and Vantage domain server, the 
Domain login dialog may not display your Vantage domain. If this is the case, you may 
be able to log in by using the name or IP address of the Vantage domain server. For 
more details, see Selecting Vantage Domains and Logging In.

Difficulties Changing Configurations
When you change domains or configurations, you may also encounter these problems:

• No Configurations Available...

Workflow Portal displays this error when you log in to a domain where no Workflow 
Portal configurations are defined or where you do not have access to any of the 
defined configurations.

Contact your Vantage domain administrator.

• No session licenses available for this application...

Either the domain is not licensed for running Workflow Portal or all available Work-
flow Portal licenses are in use. Workflow Portal will operate in unlicensed/demo 
mode, but will not allow you to submit jobs or edit metadata labels until a Work-
flow Portal license becomes available.

Contact your Vantage domain administrator.

Note: An administrator can release a license in the Vantage Management Console.
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• Problem communicating with database—could not find stored procedure Select-
SessionsByExecution...

This error displays when Workflow Portal is attempting to display a list of configura-
tions from the selected domain, but the version of the domain is not compatible 
with your client. Contact your Vantage domain administrator to upgrade the Work-
flow Portal program on your computer.

• The requested workflows are either not running or no longer exist...

This error displays when you submit an asset or media file to a workflow that has 
been deleted, or is not activated. Contact your Vantage domain administrator, who 
can activate the Vantage workflow or edit the configuration to correct the problem.

Problems Playing Proxy Files
If you can’t play proxy files in a binder, review these issues:

– In the web client, the Wait cursor displays forever: 
Your virtual directory may not be implemented in IIS

– The location path may not be specified correctly, or it may be using a letter drive 
where a UNC path is required for remote client/service access

– The alias to the directory may not be specified in the store

– The alias path may be incorrect.

It is valid to use a drive letter as part of a Virtual Directory. This imposes no restric-
tions other than requiring the Vantage store to be located on a drive attached to 
the web apps host (such as a local hard drive or more commonly a SAN).

• In Workflow Portal, make sure that you create a QuickTime H.264/AAC proxy for 
previewing media or creating clips. Use the QuickTime encoder, and configure the 
container settings to generate a timecode track. Make sure that your encoded 
proxy file is the same frame rate and timecode notation as your production media. 
Assign the nickname Vantage Proxy, so that the media player in Workflow Portal 
automatically loads and displays your proxy. 

• Alternatively, the Workflow Portal Windows Client Media Player supports MP4 with 
x264-encoded H.264/AAC, provided that QuickTime 7.7.6 or later is installed on the 
computer running the Workflow Portal Windows client. 

• For previewing media in the Workflow Portal web client’s HTML5 media viewer, 
make sure the video is encoded using the Flip action (and nicknamed Vantage 
Proxy), with these settings:

Encoder: MP4 Encoder

Video Codec: x264

Audio Codec: AAC

Container: MP4 File

• Previewing EDL clips and working with them in the Create EDL clip list requires an 
MPEG-2 file nicknamed Vantage EDL. If an EDL catalog does not display a binder, 
the absence of a Vantage EDL file in the binder may be the cause.
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• When using the Workflow Portal Web Application on a Windows Server platform, 
you must install the Desktop Experience feature in order to view proxy media in the 
HTML5 Media Player.

• When playing to the end of a proxy in Chrome, versions 35 and 36, Telestream has 
observed that the media player may display an incorrect duration as a result of a 
round-up error. This anomaly is cosmetic. If you set this frame as a mark-out point, 
the correct timecode is entered by Workflow Portal.

Configurations Don’t Display in the Web Client
You’ve created a new configuration, but you can’t select it in the web Workflow Portal.

•  Perhaps it is not a Copy Binder or Forward Binder configuration— the other types 
are not designed to function in the web client, only the Windows client.

• Perhaps you (your Vantage user) don’t have permission to use it.

No Session Licenses Available
Workflow Portal displays this message when the number of active session licenses is 
equal to the number of authorized seats in your license, and no more are available.

Note: Open the Vantage Management Console > Licenses and use the Licenses and 
Portal Sessions tabs to determine how many servers can run Workflow Portal 
concurrently, and how many sessions are currently active.

Identify the reason and resolution:

•  The maximum number of operators are concurrently using Workflow Portal. Either 
increase the number of authorized servers (concurrent instances) or wait until 
someone closes Workflow Portal and releases a license. Open the Vantage Manage-
ment Console > Licenses and display the Licenses tab to review your license.

• Workflow Portal has crashed one or more times, and the session is still active even 
though that instance of Workflow Portal is not. Open the Vantage Management 
Console > Licenses and display the Portal Sessions tab to verify each active session 
and the associated computer. If Workflow Portal is not running on that server, select 
and delete the session to release it.
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Using the Job Status 
Views Web Application

Job Status Views is a web application that enables basic Vantage job management via a 
web browser. You can use Job Status Views to access job information and manage jobs 
in your Vantage domain from anywhere on the LAN, or via the Internet if you provide 
such access your Vantage domain.

Note: For information about Vantage web application requirements, starting and 
stopping web applications, and other basic topics, see Vantage Client Programs 
Overview.

Topics
■ About the Job Status Views Web Application

■ Job Status Views Web Application Overview

■ Using Public and Private Views

■ Sorting Jobs by Column

■ Paging Through Job Tables & Setting Page Size

■ Filtering the Job Table

■ Highlighting Job States Row by Row

■ Managing Jobs

■ Troubleshooting
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About the Job Status Views Web Application
You can use the Job Status Views web application to do the following:

• Display information about submitted jobs

• Sort and filter job entries

• Highlight and identify jobs in different states

• Stop, restart, and delete jobs

• Troubleshoot job processing issues

The views that you see in Job Status Views are defined by Vantage administrators, who 
control which job information displays and which job control functions (such as the 
ability to delete a job) are allowed. Views may be public or private. Public views are 
available to everyone, and private views are for use by specified Vantage users.

Changing Web Applications Language and Date Format
Vantage Web Applications detect the language and date format specified in your 
browser. For example, selecting English (United Kingdom) as the language displays UK 
spelling and date format (DD/MM/YYYY). Selecting English (US) as the language 
displays US spelling and date format (MM/DD/YYYY).

To change language and date formats, follow these steps:

Internet Explorer Language and Date
1. Open Internet Explorer.

2. Select the Tools menu and then Internet Options.

3. Click Languages.

4. Click Set Language Preferences.

5. Choose your language, for example, English (US) or English (United Kingdom).

6. Close and reopen the browser and access the web apps. Your language and date 
format should be displayed in the web apps.

Chrome Language and Date
7. Open Chrome.

8. Select the “three dots” menu at the far right, and then select Settings.

9. Expand the Advanced link at the bottom.

10. Under Languages, expand Language.

11. Click Add Languages, scroll and select a language, and click Add.

12. Click the menu button to the right of the desired language, check Display Google 
Chrome in this language, and click Move to the top. The language at the top should 
display your selected language.

13. Close and reopen the browser and check the web apps language and date format.
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Job Status Views Web Application Overview
The Job Status Views web application displays the jobs table, as shown here. 

The Job Status Views display is presented in three panels.

To display or hide the title or panels, click the Show/Hide controls.

• Title panel (top)—displays the home button, Vantage domain and user name, and 
controls to manage the user password, change domains, and to log out of the 
domain.

• View panel (left)—displays views that define which jobs are listed in the job list. This 
panel also includes controls to display product version information and this guide.

• Job list panel—Center, right—displays the job list in table format, along with the 
program’s toolbar, which contains command buttons and menus.

Note: If you don’t log in as a Vantage user, private views display None Available.

The following sections describe how to use the web application:

■ Using Public and Private Views

■ Sorting Jobs by Column

■ Paging Through Job Tables & Setting Page Size

■ Filtering the Job Table

■ Highlighting Job States Row by Row

■ Managing Jobs

■ Troubleshooting
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Using Public and Private Views
All views are defined either as public or private, and are created and configured in the 
Management Console. Click on the view to select it, and display jobs for this workflow. 
Only private views that are enabled for your Vantage user name are listed.

The default view is the All Workflows public view, which displays jobs for all workflows. 
The information that All Workflows displays depends on how it is configured in the 
Management Console, and whether it is enabled or not. If no private views have been 
defined, or if you log in as Public, the Private Views list displays None Available. 

The following topics provide more information on views:

■ About Public and Private Views

■ About View Definitions

About Public and Private Views
Public views are views that the Vantage administrator has made available to all Vantage 
users. Anyone who connects to the Vantage domain can display public views in the Job 
Status Views web application.

Private views are views that are available only to those Vantage users for which the 
Vantage administrator has enabled access. The administrator might configure custom 
views for different departments, users by role, or customers, and limit access to those 
views to the appropriate users.

About View Definitions
All views that you create are based on a specific workflow. In addition to being public or 
private, views limit the information that is displayed and specify which job control 
features (if any) the user has to use. If no controls are enabled, the view is considered a 
read-only view. You cannot create or configure views directly in Job Status Views; views 
are created by the Vantage administrator, via the Vantage Management Console, and 
specified as public or private; enforced by which user logs in.

There are many options for views, and displaying all options usually provides too much 
information for most applications. For example, it might be more convenient to display 
fewer columns. This view might only display active jobs, and it might disable controls 
that allow jobs to be restarted, stopped, or deleted.

The following topics provide information on what can be customized (and thus, may or 
may not be present) in views

■ Displaying Items in Views

■ Controls in Views

Note: Administrators should refer to the Vantage Domain Management Guide for 
information on how to set up custom views.
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Displaying Items in Views
Two items of information are always displayed as columns in a view:

• Job—The name of the file submitted to start the job, and the type of submission: 
Manual Submit, for example.

• State—The current state of the job, which can be:

State—This column displays color-coded key words to identify the status of the job:

• In Process—the job is active (being processed).

• Paused—the actions in this job have been paused.

• Complete—all of the actions in this job have completed successfully.

• Failed—one or more of the actions in this job have failed.

• Waiting—the job is active, but is currently waiting for a resource (a service) to 
accept and process one of the actions in the workflow.

• Stopped by User—the job was stopped by a user.

• Waiting to Retry—the job is active, but is currently waiting for one of the actions in 
the workflow to re-execute.

These optional columns can be added to a view:

• Total Progress—The progress of the job (in percent) if still running.

• Started—The date and time the job was started.

• Updated—The date and time the job was last updated.

• Workflow—The name of the workflow that started the job.

• Run Time—Displays the total elapsed execution time for the job.

• Expires—The date and time when the job expires and both the job entry and the 
job entry is deleted.

Controls in Views
An administrator can configure the following controls in a view:

• Enable—Enables or disables use of the view.

• Show Only In Process Jobs—Displays only jobs that are currently running.

• Stop | Start | Delete—Enables or displays the ability of the operator to manage 
jobs—stopping, restarting, and deleting them.
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Sorting Jobs by Column
To sort the displayed job list according to the entries in any column, click that column 
label. Each time you click the column label, the sort changes in the following sequence: 
ascending order, descending order, and default sort order.

Paging Through Job Tables & Setting Page Size
A job table may span multiple pages. Use the page size control at the bottom center of 
the job list to specify the number of jobs to display on a page.

The page controls on the bottom left allow you to change pages and jump to the first 
or last page of a job list. The figure below indicates where the page controls appear in 
the job panel.

Page controls Page size
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Filtering the Job Table
Job filters allow you dynamically control which jobs display in the job table. The default 
configuration displays all jobs specified in the view for the workflow. However, during 
troubleshooting, you might want to display only those jobs that are in a failure state. 
Other times, you might want to display only those jobs that are in progress.

To display the Job List filters, click Show Filters in the toolbar. The filters are displayed 
directly below the column titles in the job list table, as shown in this figure:

To hide filters, click Show Filters again.

Which jobs display in the job list is determined by all the filters working together to 
filter the list. If multiple filters are configured, the job list includes all jobs that meet the 
criteria of all configured filters.

■ Setting the Job Name Filter

■ Setting the Job State Filter

■ Setting the Total Progress Filter

■ Setting the Date and Time Filters
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Setting the Job Name Filter
You can use the job name filter to limit the job list display to only those jobs with a 
name that meet criteria you specify. The following sections describe how to set and 
clear the job name filter:

■ Specifying a Job Name Filter

■ Clearing the Job Name Filter

Specifying a Job Name Filter
To specify a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box above the job names, enter text that is part of job names that you 
want to include or exclude from the list.

3. Click the control to the right of the filter text box and select one of the following 
filters:

– Contains—Displays all jobs that have a name that contains the text you specified.

– DoesNotContain—Displays all jobs except those that have a name that contains 
the text you specified.

– EqualTo—Displays only those jobs that have names that exactly match the text 
you specified.

– NotEqualTo—Displays all jobs except those that have a name that exactly 
matches the text you specified.

Clearing the Job Name Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter text box and select No Filter.
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Setting the Job State Filter
The job state filter allows you to selectively exclude jobs from the job list based on the 
job state. The default configuration displays jobs for all of the following job states:

• Complete

• Failed

• In Process

• Stopped By User

• Waiting

• Waiting to Retry

When the job state filter is set to display jobs in all states, the filter name for the State 
column is All States. When the job state filters disable the display for jobs in one or more 
states, the filter name for the State column changes to Custom.

To specify a state filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control below the State column head and check and clear the checkboxes 
to define the states for which you want to display jobs.
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Setting the Total Progress Filter
You can use the total progress filter to limit the job list display to only those jobs that 
meet progress criteria that you specify. The following topics describe how to set and 
clear the total progress filter:

■ Specifying a Total Progress Filter

■ Clearing the Total Progress Filter

Specifying a Total Progress Filter
To specify a total progress filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box below the Total Progress column name, enter the progress level you 
want to include or exclude from the list. The range is 0% to 100%. 

3. Click the control to the right of the total progress text box and select one of the 
following filters:

– Contains. Displays all jobs for which the total progress includes the value you 
specified.

– DoesNotContain. Displays all jobs except those for which the total progress 
includes the value you specified.

– EqualTo. Displays only those jobs for which the total progress matches the value 
you specified.

– NotEqualTo. Displays all jobs except those for which the total progress matches 
the value you specified.

Clearing the Total Progress Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the Total Progress text box and select NoFilter.
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Setting the Date and Time Filters
The date and time filters allow you to limit the job display list to jobs that started, 
updated, or expire within a specified time period. There are three separate date and 
time filters for:

• Started

• Updated

• Expires

The following topics describe how to set and clear the date and time filters:

■ Specifying a Date and Time Filter

■ Clearing a Date and Time Filter

Specifying a Date and Time Filter
To set any of the date and time filters, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box in the appropriate column.

If the filter label box is empty, no filter is defined. If a filter is defined, the filter label 
box displays Custom.

3. In the panel that appears, click on the calendar and clock buttons to set the date 
and time for the period start and period end.

If you omit the period From date and time, the program displays all jobs up to the 
To date and time. If you omit the period To date and time, the program displays all 
jobs after the From date and time.

4. When the period is defined, click Apply.

Clearing a Date and Time Filter
To clear a date and time filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box.

3. Click Clear.
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Highlighting Job States Row by Row
Job state highlighting allows you to use colors to make the different job states more 
visible. Or, you can use the same color for all job states to draw less attention to the job 
states.

To toggle job state highlighting, click the Highlight State Rows button in the toolbar. 
Each time you click the button, the job state highlighting changes from the current 
state to the opposite state.

Managing Jobs
Job management, when enabled in a view, enables you to stop, restart, and delete jobs.

The following topics describe how to stop, restart, and delete jobs:

■ Stopping Jobs

■ Restarting Jobs

■ Deleting Jobs

Stopping Jobs
You might want to stop a job to make Vantage resources available for another job, or 
you might stop a job in preparation for system maintenance. 

To stop a job, do one of the following:

• Right-click on a job in the job list, and select Stop.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Stop.

Restarting Jobs
Jobs can be stopped by service or network interruptions, or an operator might stop a 
job to give another job priority. To restart a job, do one of the following:

• Right-click on a job in the job list, and select Restart.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Restart.
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Deleting Jobs
You might want to delete a job because the job has failed, or because the output file is 
no longer needed, for example.

To delete a job, do either of the following:

• Right-click on a job in the job list and select Delete.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Delete.

Troubleshooting
Job Status Views enables troubleshooting and correction at the job level. For more 
comprehensive troubleshooting, use the Vantage Dashboard web application.

The first step in Vantage troubleshooting with Job Status Views is to identify the jobs 
that are having problems. There are several ways to do this:

• Enable Highlight State Rows to indicate job status with colors. Failed jobs are high-
lighted in red, and other states have distinct colors. (See Highlighting Job States Row 
by Row for more information.)

• Click the State column head to sort the jobs by the current state, then locate the 
group of jobs you want to investigate.

• Use filters to display only the jobs in the state you are investigating. (See Filtering 
the Job Table for more information.)

After you locate the jobs with issues, look for common traits among those jobs. The 
following are some possible issues and suggestions for resolution:

• All jobs are failed or waiting. Look for network, database, or service issues. If all jobs 
within a certain time period had problems, there might have been a temporary 
issue that has since been corrected. Restart failed jobs as described in Restarting 
Jobs.

• All jobs for a specific workflow have failed or are waiting. Look for issues with the 
workflow. Has the workflow ever worked? Are all resources used by that workflow 
available?

• All jobs for a particular watch folder or destination have failed or are waiting. If you 
know that all the troubled jobs use the same watch folder or destination, it could 
be that the location is not available. 

After you resolve a problem, some jobs might restart on their own, and others might 
require further action from you. If your view is so enabled, you can take the following 
actions on jobs in the job list:

• Restart—Restart stopped jobs as described in Restarting Jobs.

• Delete—Delete jobs as described in Deleting Jobs.

• Stop—If a job seems unlikely to complete or stop, you can stop the job as described 
in Stopping Jobs. Once a job is stopped, you can try to restart the job or delete it.
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Shortcut Keys

Vantage implements keyboard shortcuts in many Vantage client programs to improve 
usability.

Topics
■ Vantage Workflow Designer Shortcuts

■ Workflow Portal Shortcuts

■ Portal Player Shortcuts

■ Vantage Dublist Portal Shortcuts

■ Web Apps Shortcuts

■ Vantage Management Console Shortcuts
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Vantage Workflow Designer Shortcuts
The following functions and shortcut keys apply to the Vantage Workflow Designer.

Function Shortcut

Ctrl+A Selects all actions in the current workflow.

Ctrl+C, Ctrl+V Duplicates the selected action or text entry.

Ctrl+D Alternates between detailed and simple action view.

Ctrl+G Turns grid lines on or off.

Ctrl+O Display/hide action annotations in the workflow 

Ctrl+Q Exit the program.

Ctrl+R Re-centers the workflow in the design space.

Ctrl+V Pastes cut or copied text.

Ctrl+W Creates a new workflow.

Ctrl+X Cuts the selected text.

Ctrl++, Ctrl+- Zooms in, zooms out.

F1 Opens the Vantage User Guide.

Alt+F4 Closes the Vantage User Guide.

F5 Opens the selected workflow.

F10 Selects the File menu for mouse-free operation. Use right and 
left arrows to move to other top menus. Use up and down 
arrows to navigate menu selections. Press Enter to select the 
highlighted menu.

Arrow keys Used in various menus to navigate instead of the mouse.

Tab Moves through functions to enable mouse-free operation.
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Workflow Portal Shortcuts
The following functions and shortcut keys apply to the Vantage Workflow Portal.

Function Shortcut

Ctrl+A Selects all files in the current list.

Ctrl+G Opens the selected file in the Switch player.

Ctrl+G For Tempo Portal only when playing files in Switch, gets 
timecode from Switch and copies it to the Tempo proxy player

Ctrl+C | Ctrl+V Duplicates the selected item or text entry.

Ctrl+Q Exits the program.

Ctrl+S For the Tempo Portal playing TIFO files only, opens the Switch 
Player and sets the player’s timecode to Tempo timecode.

Ctrl+T Duplicates the selected segment (TrafficManager & Tempo)

Ctrl+V Pastes cut or copied text.

Ctrl+X Cuts the selected text.

Ctrl+0 (Zero) Half sized video (TrafficManager & Tempo)

Ctrl+1 Normal sized video (TrafficManager & Tempo)

Ctrl+2 Double sized video (TrafficManager & Tempo)

Ctrl+3 Scale video to fit (TrafficManager & Tempo)

F1 Opens the appropriate user guide for the portal configuration.

Alt+F4 Closes the user guide.

F10 Selects the File menu for mouse-free operation. Use right and 
left arrows to move to other top menus. Use up and down 
arrows to navigate menu selections. Press Enter to select the 
highlighted menu.

F11 Save Project 

F12 Save Project As...

Tab Moves through functions to enable mouse-free operation.
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Portal Player Shortcuts
The following shortcuts operate the Workflow Portal Preview Player.

Clicking in the playback controls area or on the video focuses the preview player 
controls (indicated by the blue border). Focusing this area enables the “JKL” controls, so 
that you don’t have to use shortcuts.

Function Controls

Play/Pause/Reverse Ctrl+P or Ctrl+Space

J (Reverse play—repeat for -1.5x, -2x, -5x, -8x)

K (Pause)

L (Play—repeat for 1.5x, 2x, 5x, 8x)

JK simultaneously (Reverse play slow motion -1/8x; repeat for 
-1/4x, -1/2x)

KL simultaneously (Forward play slow motion 1/8x; repeat for 
1/4x, 1/2x)

Stop Ctrl+S

Forward Frame Ctrl+F

Ctrl+Mouse Wheel, one frame per wheel click

K+L (Forward bump one frame)

K+L held down (Forward bump repeat 
1/4 speed)

Left Arrow (Reverse bump one frame)

Right Arrow (Forward bump one frame)

Forward/Reverse 10 
Frames

Up Arrow —Forward bump 10 frames

Down Arrow—Reverse bump 10 frames

Forward/Reverse 
One Second

Mouse Wheel (no modifier keys)—one second per wheel click

Shift + Left Arrow (Reverse bump one second)

Shift + Right Arrow (Forward bump one second)

Forward/Reverse 
One Minute

Shift +Mouse Wheel—one minute per wheel click

Forward/Reverse 
One Hour

Ctrl+Shift+Mouse Wheel—one hour per wheel click

Reverse Frame Ctrl+B

Ctrl+Mouse Wheel—one frame per wheel click

K+J—Reverse bump one frame

K+J held down—Reverse bump repeat 1/4 speed
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Mark In Ctrl+I or Ctrl+E (In points are indicated by tick marks on the 
timeline.)

Mark Out Ctrl+O or Ctrl+R

Go to mark in frame Ctrl+Q

Go to mark out 
frame

Ctrl+W

Go to start Ctrl+Home

Go to end Ctrl+End

Audio Mute (toggle) Ctrl+M 

Adjust Volume Drag volume button right or left to adjust volume.

Scroll media Drag media button right or left to scrub (scroll) media.

Duplicate selected 
clip

Ctrl+T (Selects the new clip and sets its mark in to the original 
clip’s mark out, if appropriate)

Jump to next 
segment

Alt+Left | Right Arrow Jumps to the next or previous segment, 
as noted by the white bars on the scrubber bar. Works even 
when segment markers are not displayed. 

Jump to next scene 
change marker

Shift-Alt+Left | Right Arrow Jumps to the next or previous scene 
change marker, as noted by the green bars on the scrubber bar. 
Works even when scene change markers are not displayed. 

Ctrl+: Switches to dropframe timecode.

Ctrl+; Switches to non-dropframe timecode.

Tab Moves through functions to enable mouse-free operation.

Function Controls
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Vantage Dublist Portal Shortcuts
The following functions and shortcut keys apply to the Vantage Dublist Portal.

Function Shortcut

Ctrl+A Selects all in the current list.

Ctrl+C, Ctrl+V Duplicates the selected item or text entry.

Ctrl+Q Exits the program.

Ctrl+V Pastes cut or copied text.

Ctrl+X Cuts the selected text.

F1 Opens the Vantage Domain Management Guide.

Alt-F4 Closes the Vantage Domain Management Guide.

F10 Selects the File menu for mouse-free operation. Use right and 
left arrows to move to other top menus. Use up and down 
arrows to navigate menu selections. Press Enter to select the 
highlighted menu.

Tab Moves through functions to enable mouse-free operation.
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Web Apps Shortcuts
The media player shortcuts are described below for the apps that include the player. 

Function Controls

Play

Enabled in play mode (click 
Play button or press K key).

  (appears in binder list)

Press L x 1—play 1x speed (normal).
Press L x 2—play 2x speed.
Press L x 3—play 3x speed.
Press L x 4—play 5x speed.
Press L x 5—play 8x speed.

(IE only) Tap the + (plus) key to accelerate the clip’s play 
speed to the next level. Press the - (minus) key to 
decelerate the clip’s play speed down the next level.

Reverse Play

Enabled in play mode (click 
Play button or press K key).

 

Press J x—reverse play.
Press J x 2—reverse play 2x speed.
Press J x 3—reverse play 3x speed.
Press J x 4—reverse play 5x speed.
Press J x 5—reverse play 8x speed.

(IE only) Press the + (plus) key to accelerate the clip’s play 
speed up to the next level. Press the - (minus) key to 
decelerate the clip’s play speed down the next level. 

Play/Pause

Press K—play forward or pause. Hold K down to step in 
reverse. 

Forward Frames

Press L—step forward one frame.

(IE only) Press the Right Arrow key—move forward 10 
frames. 

(Chrome and IE 11) Press the Right Arrow key—move 
forward 1 frame. Press the Up Arrow key to move forward 
10 frames. 

The arrow keys on the numbers keypad function in the 
same manner.
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Reverse Frames  

Tap J—move reverse one frame.

(IE only) Press the Left Arrow key—move reverse 10 
frames. 

(Chrome and IE 11) Press the Left Arrow key—move 
reverse 1 frame. Press the Down Arrow key to move 
reverse 10 frames. 

The arrow keys on the numbers keypad function in the 
same manner.

Go to start

(IE only) Press the Home key.

Go to end

(IE only) Press the End key.

Mute audio

(IE only) Press the M key during play. Press again to 
unmute.

Scroll media  

Full screen mode

Press this button to expand to full screen mode.

Zoom mode (IE 11 only) Press Z to zoom in. Press Z again to zoom back 
out. 

Video-safe overlay  

Click to display/hide the video safe overlay frame, for SD 
and HD proxies. 

Closed captioning  

Click to display closed captions, when provided by 
browser.

Audio track menu

When multiple audio tracks are present, the Audio menu 
displays. Click to select the track you want to hear. (IE only).

Tab Moves through functions to enable mouse-free operation.

Function Controls



Shortcut Keys
Vantage Management Console Shortcuts

321

Vantage Management Console Shortcuts
The following functions and shortcut keys apply to the Vantage Management Console.

Function Shortcut

Ctrl+A Selects all in the current list.

Ctrl+C, Ctrl+V Duplicates the selected item or text entry.

Ctrl+Q Exits the program.

Ctrl+V Pastes cut or copied text.

Ctrl+X Cuts the selected text.

F1 Opens the Vantage Domain Management Guide.

Alt-F4 Closes the Vantage Domain Management Guide.

F10 Selects the File menu for mouse-free operation. Use right and 
left arrows to move to other top menus. Use up and down 
arrows to navigate menu selections. Press Enter to select the 
highlighted menu.

Tab Moves through functions to enable mouse-free operation.
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action

An action is the smallest unit of work that can be specified in a Vantage workflow. 
Actions are connected together in a workflow to perform a useful task. Each action 
must be configured to perform its task in the context of the workflow, using an 
action Inspector. Action inspectors are specific to each type of action.

Actions are grouped in Workflow Designer by functional categories: 
communication, transcoding, file operations, metadata processing, etc. Each action 
is defined by the specific task it performs. For example, an email action, or a 
metadata label/file transformation action. All actions are executed by Vantage 
Windows services, which correlate to the functional categories. 

Actions have limited interdependency, and so, are very flexible. You may impose 
limitations on actions in a workflow. For example, you might require action B to 
depend on action A in a Vantage workflow.

During execution, actions operate on files, binders, variables, and states, and they 
generate an action state when they complete. Actions are executed by Vantage 
services, which perform the requirements of the action. In the case of the Vantage 
Transport Service and most transcoding services, the services may manage file 
transfers and transcoding/rendering via an out-of-process resource.

AAF action

The AAF action uses the Vantage Avid Service to ingest incoming AAF files and 
processes the MXF folder referenced in the AAF file. Avid Media Composer then 
utilizes Persistent Media Record (PMR) files for information about the online status 
of file Media Object information (MOB). Each PMR file provides an index in a form 
that an editor can quickly load all the file MOBs and their associated media files in 
the media directory in which the PMR file resides.

action state

The action state describes the condition of an action execution in process and after 
completion.

During execution, an action may be Queued | Paused | In Process | Waiting. After 
execution, an action's final state may be Success | Ignore | Failure. Certain actions 
(Decide/Examine/Compare/Identify, for example) allow the use to specify the post-
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execution state, including Ignore. For all other actions, the post-execution state is 
set by the service, and is either Success or Failure. These states display in the 
Vantage Workflow Designer Job Status tab.

Action states are always passed to subsequent actions. The incoming state is tested 
by the next actions to determine whether or not following actions should execute.

Some actions allow you to specify that an action should execute on a specific state 
(right-click the action, and select Perform On > Success | Failure | Ignore | Any).

If an action fails, then the next action will inherit the Failure state and (in most 
cases) will not execute. If one action fails, the entire job fails.

Similarly, if you specify an action to set the Ignore state, the next action will inherit 
the Ignore state and will also likely not execute. Certain special actions, such as 
Message, can be configured to perform on any state (Failure, for example)—this 
allows workflows to send an email if they detect a failure.

Action states have precedence when an action receives states from multiple 
incoming actions (a merge of multiple branches):

- If at least one incoming state is Failure, regardless of other incoming states, the 
action will inherit the Failure state. Failure has precedence over all action states.

- If there is no Failure state, but at least one Success state, then the action will inherit 
the Success state. Success has precedence over Ignore states.

- If all incoming states are Ignore, the action will inherit the Ignore state. Ignore has 
lowest precedence of the three states. If an action receives an Ignore state and does 
not explicitly fail, then it emits a Success state. Otherwise, it emits a Failure state 
unless it is an action which can emit Ignore, and you have configured it to do so.

Alchemist File action

The Alchemist File action, which is executed by the Vantage Alchemist Service, 
allows you to configure connection settings with an existing installation of Grass 
Valley Alchemist File software.

Vantage Alchemist Service

The Alchemist Service allows Vantage to interact with an installation of the Grass 
Valley Alchemist software via the Alchemist File action. For configuration and set 
up details, see the Alchemist File app note available on the Telestream web site.

All-in-one domain

An all-in-one (or single-node or single-server) Vantage domain is one in which all 
server components of Vantage—the Microsoft SQL Server database, all Vantage 
services, and the optional Vantage web applications—are installed and operate on 
a single computer.

See also Vantage array. 

Analyze action

The Analyze action, which is executed by the Vantage Analysis Service on-premises 
or the Cloud Service when in Vantage Cloud mode, enables you to perform analysis 
on media using a variety of analysis tools, specifying the result of the analysis in 
variables, for use in downstream actions. It is Vantage Cloud capable.
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Vantage Analysis Service

The Analysis Service is the Vantage component which executes the actions relating 
to the analysis of content: Examine action, Compare action, Identify action, Analyze 
action, Report action, and MediaInfo action.

Archive action

An Archive action, which is executed by the Vantage Staging Service, uses the 
selected archiver (TAR, for example) to convert the selected input file to another 
format, usually in preparation for copying, moving, or deploying a file to a given 
system that has special file format requirements.

array

An informal term for Vantage array. 

Vantage Aspera Service

An Aspera Service implements the Aspera software for Vantage, and provides two-
way communication between workflows (and the Faspex Delivery action) utilizing 
the Aspera software itself.

Asset Monitor action

The Asset Monitor is an origin action. It uses the Vantage Avid Service to monitor 
the specified Interplay server for new files to ingest and generate output in one or 
more media descriptor formats [CML (Interplay Metadata) or MPEG 4 Reference 
files] from the ingested input file. This action is Open Workflow capable.

When a new file is discovered, the Asset Monitor action submits a job for the 
workflow to process the file.

Associate action

An Associate action uses the Vantage Monitor Service to continually (and at regular 
periods) poll a target location (a directory, for example) on a device or file system 
(FTP, network folder, etc.) to discover new files, based on some permutation of the 
name of the file being processed by the current job.

Associate actions can be executed on any action state.

Generally, the Associate action uses the file name of an existing media file or 
attachment as the basis for discovering new files. For example, if media file 
Vantage.mpg is currently in the workflow, then the Associate action may look for 
Vantage.scc. This behavior can be configured in the Associate action's Inspector.

Associate actions begin executing when a job is submitted, and execute until a new 
file is discovered—subsequent actions do not execute until the file is found. When 
the new file is discovered, the Associate action makes the file available to the other 
actions in the workflow.

Configuration is accomplished in the inspector, and is based on the target device/
file system being monitored and other requirements.

attachment

An attachment is a non-media file that is associated with media during execution of 
a workflow. For example, an attachment may be an XML file that contains 
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metadata, an SCC caption file, or an STL or PAC subtitle file. An attachment may also 
be a PDF file, Excel spreadsheet, or Word document, for example. Attachments are 
identified and processed using nicknames for simplicity. Processing is optional—
attachments may be simply passed through a workflow for storage with the 
processed media and registered in a Vantage catalog.

attachment nickname

An attachment nickname is an alias or alternate name that is assigned to an 
attachment file during Vantage workflow execution. When an attachment file is 
submitted to a workflow, the actual file name and location is stored in a Vantage 
binder along with a nickname as defined in the workflow. Within the workflow, all 
references to a file are by nickname. However, when Vantage needs to access a file, 
Vantage uses the actual file name and location stored in the binder.

See media nickname and nickname.

AudioTools action

An AudioTools action is an optional, licensed feature in Vantage. It uses the Vantage 
AudioTools Service to enable Vantage workflows to utilize and interact with various 
AudioTools products from Minnetonka Audio Software. The AudioTools Custom 
Workflow executes a selected, pre-defined AudioTools Server workflow. AudioTools 
Loudness Control executes the typical loudness processes, including hitting 
multiple target parameters using an iterative processing pass.

Vantage AudioTools Service

The AudioTools Service implements the AudioTools Connector and enables Vantage 
workflows to utilize and interact with various AudioTools products from 
Minnetonka Audio Software.

Aurora action

An Aurora action is an optional, licensed feature in Vantage. It uses the Vantage 
Aurora Service to enable Vantage workflows to utilize and interact with various QC 
tests provided by the Digimetrics Aurora software. The tests provide the ability to 
determine whether a particular input media (specified by nickname) either passes 
or fails a particular QC check. Each test also generates a report file that may be 
utilized during later stages of the workflow.

Vantage Aurora Service

The Aurora Service implements the Digimetrics Aurora software for Vantage, and 
provides two-way communication between workflows (and the Aurora action) 
utilizing Aurora and the Aurora software itself.

Automate action

The Automate action, which is executed by the Vantage Communicate Service, is 
similar to the Notify action. It contains system-integration extensions which are 
relevant to TrafficManager workflows, enabling you to save job or other metadata 
to a file and interface/integrate with external automation systems. This capability 
ranges from writing XML-based material to a file system to direct integration with 
specific automation systems.
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In TrafficManager applications, this action is useful to notify automation systems 
that a commercial has been processed and is available for air. For example, a Notify 
action can create text or CSV dublists and provide them to automation systems that 
are capable of processing dublists in that format. 

Vantage Avid Service

The Avid Service is the Vantage component which executes the actions relating to 
use of media on Avid Interplay servers using the Media Creation action, Asset 
Monitor action, and AAF action. Before you can use these actions in a Vantage 
workflow with a given Avid Interplay server, you must first create an Avid Interplay 
connection in the Vantage Management Console and configure it.

Baton action

A Baton action is an optional, licensed feature in Vantage. It uses the Vantage Baton 
Service to enable Vantage workflows to utilize and interact with various QC tests 
provided by the Baton software. The tests provide the ability to determine whether 
a particular input media (specified by nickname) either passes or fails a particular 
QC check. Each test also generates a report file that may be utilized during later 
stages of the workflow.

Vantage Baton Service

The Baton Service implements the Baton software for Vantage, and provides two-
way communication between workflows (and the Baton action) utilizing the Baton 
software itself.

binder

A binder is a collection of file and metadata information, created for each job that 
Vantage executes. A binder contains media and attachment file references and 
metadata labels that were ingested or created during the job. While a binder is 
created for every job, many binders are never used. Therefore, only media 
processing scenarios which require operator intervention should use the Register 
action in ingest workflows to create binders in a user-accessible Vantage catalog.

You use the Register action to automatically create binders during a job, and you 
use Exist to determine if a binder of a certain name has already been created. 
Binders are most often named by some permutation of the name of the file that 
started the job. Binders that are not explicitly registered are accessible to users only 
in Workflow Designer, in the Job Status tabs. 

Vantage catalogs and their binders are accessible in Workflow Portal. Binders are 
saved in the Vantage domain database until deleted manually or by job expiration 
policies. You can also view binders in the Vantage Management Console, and 
manually create them there—or delete them. 

Binders are not file folders and are not part of the Windows file system—they are 
records in the Vantage database. Thus, binders do not contain the files themselves; 
they only have the paths to those files. 
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Camera Ingest action

A Camera action is an origin action; it uses the Vantage Monitor Service to regularly 
poll a target location (a directory, for example) on a card reader device or Windows 
file system to discover new camera files.

When a new file or shot is discovered, the Camera action submits a job for the 
workflow which it is part of, for processing.

Capture action

A Capture action is an origin action; it supports Open Workflows on the outbound 
side and it is used to capture live SDI | IP inputs and output captured media files to 
Live Storage using the specified output container and encoder. The Capture action 
is executed by the Vantage Live Service, and only works in a Vantage domain on a 
Lightspeed Live Server hosting Capture.

catalog

Similar in concept to the folders in a file system, a Vantage catalog is a container 
that stores binders. Catalog folders are sub-containers that organize binders. To 
access a binder, Workflow Portal operators search through the visible catalogs and 
folders, just as they might sort through folders in a file system.

Vantage Catalog Service

The Catalog Service is the Vantage component that executes the Register action 
and Exist action.

Catch action

A Catch action is an origin action; it is a specialized origin action for ingesting 
commercials and syndicated media assets (including metadata) from catch servers 
in TrafficManager applications. It uses the Vantage Traffic Service to regularly poll 
the catch server to discover new files.

When a new file is discovered, the Catch action exposes all relevant metadata and 
submits a job to the workflow for processing. Typically, the workflow is an ingest 
workflow which localizes the media, populates a metadata label, creates proxies 
and thumbnails, and registers the asset in a Vantage catalog. The Catch action also 
includes an interface to common cloud storage systems, allowing storage in the 
cloud to be monitored. For more details, see the TrafficManager User Guide.

Cerify action

A Cerify action is an optional, licensed feature in Vantage. It uses the Vantage Cerify 
Service to enable Vantage workflows to utilize the Tektronix Cerify suite of QC 
components. Cerify is a fully automated system for verifying and checking file-
based content.

Vantage Cerify Service

The Cerify Service implements the Cerify software for Vantage, and provides two-
way communication between workflows (and the Cerify action) utilizing the Baton 
software itself.



Vantage Glossary 329

Change Log

The Change Log (Vantage Management Console > Support Utilities) captures 
changes to the Vantage domain configuration and operation and records the 
following details: date and time of change, Vantage user who made the change, 
host computer where the change occurred, change summary message.

Chronicle action

The Chronicle action, along with Colocate, Compose, and Conform actions, are part 
of the optional, licensed Post Producer feature in Vantage. The Chronicle action 
uses the Vantage Edit Service to convert post-rendered Composition XML files into 
formats for use in other systems—ad-insertion systems, for example.

Vantage Cloud mode

Vantage Cloud mode is an execution option that you can enable in Vantage Cloud-
capable actions to enable processing in the cloud (enabled by configuring your 
Vantage domain with a valid Telestream Cloud account). When supported actions 
execute in the Vantage Cloud mode, they are executed by the Cloud Service. 

Cloud Service

The Cloud Service connects a Vantage domain with Telestream Cloud or 
Encoding.com. The Cloud service acts primarily as a proxy for Telestream Cloud as 
the Vantage component that is responsible for transporting files and executing 
actions which interact with resources in Telestream Cloud or are related to Cloud 
processing: Cloud Qualify action | Cloud Speech action | Location action. In 
addition, the Qualify Action is provided, in the Cloud category. The Cloud Service is 
also responsible for executing the Analyze action | Conform action | Flip64 action | 
IPTV Flip action | Multiscreen Flip action | Tempo action | Timed Text Conform 
action | Timed Text Flip action when these actions execute in Vantage Cloud mode. 

To use the Cloud Service and its associated actions and features in your workflows, 
you must have an Encoding.com account or Telestream Cloud account. For 
Encoding.com accounts, contact your Telestream support team. 
You can create a Telestream Cloud account on the Telestream Cloud web site: 
https://cloud.telestream.net. When you create your Telestream Cloud account, you 
are supplied an API key. Use this key in the Vantage Management Console > 
Settings & Options > Telestream Cloud tab to allow Vantage to log into your 
Telestream Cloud account automatically to perform cloud processing that you 
specify in workflows.

Cloud Qualify action

The Cloud Qualify action The Cloud Qualify action is part of the Cloud group, which 
is executed by the Vantage Telestream Cloud service. The Cloud Qualify action is 
supported in Vantage Cloud hosted workflows. For details on using hosted 
workflows, consult the Vantage Cloud User Guide. 

To use the Cloud Qualify action you must have a Telestream Cloud account and it 
must be registered in Vantage. In your account, you should create one or more 
Quality Control projects that can be executed by Cloud Qualify workflows in 
Vantage.

https://cloud.telestream.net/
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The Cloud Qualify action processes a media file (identified by nickname) in a 
Qualify project in your account, and returns a report and the result: A string variable 
with the results of the test. 

Cloud Speech action

The Cloud Speech action submits media from Vantage workflows to Telestream 
Cloud for speech-to-text conversion. To use the Cloud Speech action you must 
have a Telestream Cloud account and enter the account credentials in the Vantage 
Management Console Settings to enable Vantage to access the account. When the 
Cloud Speech action executes, the input file is uploaded and processed according 
to the Cloud Timed Text Speech project chosen in the Cloud Speech action, and the 
results and status are returned to the on premises workflow. The Cloud Speech 
action is supported in Vantage Cloud hosted workflows. For details on using hosted 
workflows, consult the Vantage Cloud User Guide available on the Telestream web 
site.

Colocate action

The Colocate action, along with Chronicle, Compose, and Conform actions, are part 
of the optional, licensed Post Producer feature in Vantage. The Colocate action uses 
the Vantage Edit Service to ingest Composition XML files with references to non-
file-based URLS (for example, Amazon S3), localize the files, and convert the media 
references in a copy of the CML into paths to the localized files. 

Common action

Common actions are implemented in multiple Vantage services (Catalog, 
Communicate, Staging, and Metadata) so they are not restricted to execution by a 
single service. See Receive action, Forward action, Decide action, Compute action, 
Construct action, Synchronize action.

ComponentPac

Vantage ComponentPacs are version-controlled Vantage components, such as an 
updated Capture action. ComponentPac versions are controlled using Telestream's 
Secure Version Control. For details, see the Secured Version Control application 
note on the Telestream web site.

Secured Version Control provides the ability to update Vantage—and create or 
update workflows that utilize new versions of actions—while keeping existing 
workflows untouched and operating using existing versions of actions. When you 
want to upgrade an action in a workflow, you can do so at a convenient time.

Vantage Communicate Service

The Communicate Service is the Vantage component that executes the actions 
relating to electronic messaging: Message action, and Notify action.

Compare action

A Compare action uses the Vantage Analysis Service to compare media files based 
on certain metrics (for example, PSNR). These metrics can generally be published as 
variables or as metadata labels.

http://www.telestream.net/pdfs/app-notes/app-Secured-Version-Control.pdf
http://www.telestream.net/pdfs/app-notes/app-Secured-Version-Control.pdf
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Compose action

A Compose action, along with Chronicle, Colocate, and Conform actions, are part of 
the optional, licensed Post Producer feature in Vantage. The Compose action uses 
the Vantage Edit Service to convert various media descriptor file formats 
(Anystream AN2, Final Cut Interchange XML, Simplified Avid AAF, QuickTime 
Reference, Adobe FC7XML, and Telestream TSEDL) into a Composition XML file so 
that it can be used by the Conform action to compose media) into a Composition 
XML file so that it can be used by the Conform action to compose media.

Composition (CML) file

A Composition file is an XML schema that provides the vocabulary to describe 
media elements and their temporal and spatial relationships on a video timeline. 
Composition files (or Composition XML objects in a computer program) are 
submitted to a Conform action in a workflow to render the media file from the 
description.

Compute action

A Compute action, which is implemented in every Vantage service, performs various 
arithmetic and string manipulation functions, permitting you to create and modify 
values in variables, for use in downstream actions. This action is Open Workflow 
capable.

Conform action

A Conform action, along with the other Edit actions, are part of the optional, 
licensed Post Producer feature in Vantage. The Conform action, which is Vantage 
Cloud capable, uses the Vantage Edit Service to assemble and optionally transcode 
multiple video and still image files into a single output file, applying filters as 
specified by you. The input files and related specifications for the output file are all 
defined in a Composition XML file. This action is Open Workflow capable except 
when executing in Vantage Cloud mode. 

Construct action

A Construct action, which is implemented in every Vantage service, enables you to 
construct complex strings, paths, and math expressions from literals, variables, and 
tokens, for use in downstream actions. This action is Open Workflow capable.

Copy action

A Copy action is executed by the Vantage Transport Service and is used to replicate 
a file from a source target (file system/device and directory) to a destination target 
(file system/device and directory). It typically performs this task by copying the file 
to the destination. 

Copy actions can be executed on any action state. This action is Open Workflow 
capable.

database

The term database is the common term used to refer to the Vantage domain 
database, where all specifications for the domain are stored, along with workflows 
and job history.
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Data Collection Utility

The Data Collection Utility is built into the Vantage Domain Console (Support 
Utilities > Data Collection). It enables you to collect relevant information about 
selected services for transmission to Telestream during a troubleshooting session. 
You can also log point-in-time details about a selected service into a log file for 
diagnostics purposes.

Delay action

The Delay action provides the ability to delay the workflow for a fixed number of 
seconds before continuing. The Delay action operates in Open Workflow mode; for 
example, if you set a 60 second delay, the action will turn green, delay 60 seconds, 
then propagate the Open signal to the next action.

Decide action

A Decide action, which is implemented in every Vantage service, is an action which 
allows you to explicitly set the action state based upon analysis of variable values at 
runtime. It is most commonly used to determine whether or not subsequent 
actions (or actions in a given branch) in a workflow should execute.

When the Decide action is used, the state set by the Decide action is passed to the 
next action. Typically, more than one Decide action is required to support decision 
branches. For example, if one branch is for HD media, it will start with a Decide 
action that will set the state to Success for HD content, or set it to Ignore otherwise; 
if another branch is for all other media, it will start with a Decide action that 
performs the opposite behavior.

See variable, action state.

Delete action

A Delete action is executed by the Vantage Transport Service, and is used to 
permanently remove a file from a source target (file system/device and directory). 
Delete actions can be executed on any action state.

Deploy action

A Deploy action is executed by the Vantage Transport Service, and is used to save 
the specified files to a destination outside the Vantage domain. Unlike Delete, 
Move, or Copy actions, Deploy actions allow multiple files to be operated on 
simultaneously, and do not maintain a reference to those files in the binder after 
completion.

distributed domain

Another term for Vantage array. 

Diva Archive action

The Diva Archive action is part of the DIVA group in Workflow Designer. It is 
executed by the Vantage Diva Service, and enables a workflow to add a new object 
to a specified Content Manager | DIVA Core.
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Diva Lookup action

The Diva Lookup action is part of the DIVA group in Workflow Designer. It is 
executed by the Vantage Diva Service, and enables a workflow to determine if a 
specific object has been archived in the specified Content Manager | DIVA Core.

Diva Restore action

The Diva Restore action is part of the DIVA group in Workflow Designer. It is 
executed by the Vantage Diva Service, and enables a workflow to write content to a 
storage system external to Content Manager and Vantage, that was previously 
archived in the specified Content Manager | DIVA Core. 

domain

See Vantage domain.

DPP Validate Action

The DPP Validate action is executed by the Vantage Analysis Service. You can use 
the DPP Validate action to confirm compliance of a DPP metadata XML file. If the 
XML file passes validation, TRUE is generated; otherwise FALSE is generated. You 
can test the results of the action downstream to change the workflow’s actions 
based on the validation results. Optionally, you can also generate a validation 
report. The DPP Validate action is supported in Vantage Cloud hosted workflows 
with the exception of the validation report option which is not supported. For 
details, consult the Vantage Cloud User Guide available on the Telestream web site. 

DRM action

The DRM action is part of the Multiscreen group, and is executed by the Multiscreen 
Service. You use the DRM action to execute a script that utilizes input data and 
generates a JSON string. The string contains the information required to encrypt 
streaming media with DRM (digital rights management) in Multiscreen workflows.

Scripts are created externally in a supported language and added to a Vantage 
domain via the Vantage Management Console > Workflow Design Items > Scripts. 
The specified script is executed in the DRM action, generating the output into a text 
variable for use in a downstream Multiscreen action. Multiscreen Flip uses the 
output of the script when encoding the media.

Dublist action

A Dublist action is a specialized origin action for ingesting dublist files from a 
specified server and directory in TrafficManager applications. It uses the Vantage 
Monitor Service to regularly poll the server to discover new files.

When a new dublist file is discovered, it is parsed by the specified scheme and new 
entries are added to the master dublist maintained by Vantage. The Dublist action 
simultaneously polls the selected Vantage catalog for any media files which match 
entries in the master list; when found, it submits a job to a TrafficManager 
application workflow for processing. The Dublist action uses the binder name as 
the unique identifier for the commercial, so it should be set to the Ad ID.

Typically, the workflow is an on-air processing workflow which transcodes the 
media, optionally trims the clip and alters audio for compliance. Then, it delivers 
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the media to an on-air server and notifies an automation system. For more details, 
see the TrafficManager User Guide.

Dublist Portal

Dublist Portal is a client Windows program provided as part of a TrafficManager 
license. Dublist Portal enables customers who are performing advertisement 
processing to define, manage, and process dublists as part of their automated 
TrafficManager workflows.

Edit Decision List

A Vantage edit decision list (EDL) is a list of clips that will be merged together in a 
target clip. The list entries specify the start and stop of the clip, and Vantage 
supports list entries from multiple media files. Vantage operators use the Workflow 
Portal program to create EDLs.

Vantage Edit Service

The Edit Service executes the Playlist actions: Colocate action, Conform action, 
Chronicle action, and Compose action. In the case of Conform, the Edit Service may 
manage the rendering via an out-of-process resource.

emotion Action

The emotion action is an optional, licensed feature in Vantage. The emotion action 
enables Vantage to utilize and interact with Emotion Systems Emotion Engine 
audio software.

Error Log

The Error Log utility captures Vantage errors and records the following details: date 
and time of error, error source (Vantage service), host computer where the error 
occurred, type of error (Info or Error), and error message.

Examine action

An Examine action uses the Vantage Analysis Service to evaluate the video and 
audio of a media file to measure certain characteristics, such as audio loudness, or 
to detect characteristics, such as the presence and size of curtains. You can 
configure it to publish metadata or variables containing the results of analysis.

Exist action

An Exist action uses the Vantage Catalog Service, and allows you to determine if a 
binder of a given name (or name fragment) is present in a specified catalog.

Extract action

The Extract action, executed by the Vantage Metadata Service, is used to extract 
specific values from element attributes in XML or key-value pairs in JSON metadata. 
The Extract action identifies and extracts specific values from structured metadata 
and populates variables for use in downstream actions. The Extract action enables 
you to browse a sample file and identify the location in the structured data where 
the value is located.

The workflow can ingest an XML or JSON file during job execution or by making 
web service calls. The Extract action automatically generates XPATH or JSONPath 
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references from the structured metadata in these files to extract the data, and 
populates a variable with the value. During execution, each extraction path is 
evaluated against the input and the associated variables are populated for use in 
downstream actions.

This action is Open Workflow capable if the Open Workflows license is installed.

Faspex Delivery action

A Faspex Delivery action, which is executed by the Vantage Aspera Service, is used 
to deliver files to Aspera Faspex servers. Upon delivery, recipients are notified and 
can download the package.

Faspex 5 Delivery action

A Faspex 5 Delivery action, which is executed by the Vantage Aspera Service, is used 
to deliver files to Aspera Faspex 5 servers. Upon delivery, recipients are notified and 
can download the package.

FileCatalyst action

The FileCatalyst action is an optional, licensed feature, which enables Vantage 
workflows to access and deliver files to FileCatalyst servers via integrated 
FileCatalyst client software. It is executed by the Vantage FileCatalyst Service.

Vantage FileCatalyst Service

The FileCatalyst Service implements the FileCatalyst action for Vantage.

Flip action

A Flip action is executed by the Vantage Transcode Service, and implements the 
specified codec, which is used to transcode decoded digital baseband media into 
another media encoding format. The Telestream Media Transcode and Analysis 
Engine performs the transcode on behalf of Vantage. The Flip action has an Export 
command, which allows you to save the configured Flip action as an XML file, for 
use in SDK applications.

Flip64 action

The Flip64 action is a Vantage Cloud-capable, 64-bit multi-core-optimized encoder 
running under the Vantage Transcode Service (except in Vantage Cloud mode, 
when it is executed by the Cloud Service, operating as a proxy of Telestream Cloud). 
It transcodes media from one or more input files into another format as specified by 
the output configuration you specify. Available resolutions extend from SD to 
UltraHD and 4K in a broad range of file formats, from QuickTime to MPEG-4 and 
TIFO, and including encoding for x264, x265 (H.265 HEVC), MXF, and more. This 
action is Open Workflow capable except when executing in Vantage Cloud mode.

Forward action

A Forward action, which is implemented in every Vantage service, forwards a binder 
and all current variables to another workflow, starting a new job with the target 
workflow. A Forward action may be added to the end of a workflow, and requires 
that the target workflow have a Receive action as its first action.

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to 
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chain workflows enables you to create comprehensive, intelligent run-time 
switching workflows consisting of smaller workflows used as building blocks.

See Receive action.

Frame.io action

The Frame.io action is implemented by the Vantage Publish Service and, via the 
Frame.io connector, allows for the creation and delivery of assets, between Vantage 
and Frame.io, an online hub that facilitates the organization of and collaboration 
around media assets. Frame.io allows team members to upload material, annotate 
this material, and collaborate with other team members on material. A special 
license is required to use this feature. 

Gather action

A Gather action is implemented by the Vantage Staging Service, and collects one or 
more files from a specified server and directory (and optionally, its subfolders), and 
brings them into the workflow as attachments. Use of a file matching pattern 
allows you to select only certain types of files.

hosted workflows

A hosted workflow is a workflow that has been exported to Telestream Cloud after 
being designed in Workflow Designer. They are managed in the Telestream Cloud 
console after deployment in Telestream Cloud. 

Jobs to hosted workflows are either submitted via the Telestream Cloud’s Cloud 
console or a Telestream Cloud API-based client program, and all action execution 
occurs exclusively in Telestream Cloud. For details on using hosted workflows, 
consult the Vantage Cloud User Guide available on the Telestream web site.

hot folder

A hot folder is a directory on a server that has been identified as a directory for 
storing media to be processed by a workflow in Vantage. When the workflow 
monitor identifies new media in this folder, it is submitted for processing. Also 
referred to as a Watch folder.

See Watch action, Vantage Monitor Service.

Identify action

An Identify action uses the Vantage Analysis Service to determine certain properties 
of a media file, such as codec type, video bit rate, or file size. This information can 
then be published as a metadata labels or variables.

Inspector

An inspector is a series of one or more panels in Vantage Workflow Designer that 
facilitate the setup and configuration of a given action. Inspectors are unique to 
each action—for example, configuring a Watch action is very different than 
configuring a Flip action.

IPTV Flip action

The IPTV Flip action is included with the Cable / IPTV version of TrafficManager. IPTV 
Flip actions are Cloud capable, and are executed by the Vantage IPTV VOD 
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Transcode Service except when operating in Vantage Cloud mode, when the Cloud 
Service executes it as a proxy for Telestream Cloud. IPTV Flip can optionally run on a 
Lightspeed Server for GPU-enhanced x264/x265 encoding and video processing. 
The IPTV Flip action and IPTV VOD Service supports the features required to handle 
varying IPTV, set-top box and cable encoding requirements, and ancillary metadata 
specific to cable ad splicing and cable/IPTV set-top box environments. This action is 
Open Workflow capable except when executing in Vantage Cloud mode.

Vantage IPTV VOD Transcode Service

The IPTV VOD Transcode Service is the Vantage component that executes the IPTV 
Flip action. This service (which can optionally run on a Lightspeed Server for H264 
and HEVC encoding and video processing), supports the features required to 
handle varying IPTV, set-top box and cable encoding requirements, and ancillary 
metadata specific to cable ad splicing and cable/IPTV set-top box environments. 
Transcoding is performed by the Telestream Media Framework on behalf of 
Vantage. Rendering may be performed by an out-of-process resource managed by 
the IPTV VOD Transcode Service. 

job

A job is each execution of a Vantage workflow. Jobs have a state (separate from 
action states), and jobs are comprised of actions that are executing. Jobs, like 
actions, may be in-process or they may be complete.

As a job executes, each action may be performed by any service (on any computer) 
in the Vantage domain that is capable of performing it. The capability of a service to 
perform a specific job depends on its current operating state, its workload, and its 
suitability, defined by a qualification rule.

Jobs for a given workflow can be viewed in the Vantage Workflow Designer by 
selecting the workflow in the Workflow Designer panel and displaying the Job 
Status tab. Alternatively, all in-process and failed jobs within a Vantage Domain 
may be viewed in the Status details panel of the Management Console.

job routing

See qualification rule and run on rules.

job state

A job state is the current status of a job. Keyword values are In Process | Paused | 
Complete | Failed | Waiting | Stopped by User | Waiting to Retry.

Job Status Views Web Application

The Vantage Job Status Views web application is installed on a Vantage web server 
and enables you to view real-time information about jobs in the domain from 
anywhere on your network with a web browser.

label

A label or metadata label defines a set of metadata by use of name/value pairs 
associated with content. For example, a spot label may contain Agency, Author, or 
Ad-ID and other metadata values; this set of metadata is collectively called a Spot 
metadata label. Metadata labels can be stored in binders with the associated media 
and attachment files.
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Vantage supplies a set of default metadata labels for use in workflows. In addition, 
you can create and modify labels for your use using the Management Console 
(Workflow Design Items > Metadata Labels).

license

A Vantage license is stored in the Vantage domain database and enables one or 
more Vantage features within a Vantage domain. Licenses are delivered as XML files 
and imported into the database and activated via the Vantage Management 
Console.

Lightspeed Live Capture

Telestream’s Lightspeed Live Capture is a scalable, multi-channel on-premise capture 
solution hosted on a Lightspeed Live Server for ingesting live, live linear or tape-
based media directly into production, post-production and broadcast workflows. It 
is implemented in two web apps—Live Capture and Tape Capture.

Lightspeed Live Server

Telestream’s Lightspeed Live Server is a 1RU, GPU-enabled, multi-core CPU server 
used to host Lightspeed Live Capture and Lightspeed Live Stream. 

Lightspeed Live Stream

Telestream’s Lightspeed Live Capture is an enterprise-class, live streaming system 
hosted on a Lightspeed Live Server that can ingest, encode, package and deploy 
multiple sources to multiple destinations. Lightspeed Live Stream is for 
broadcasters and media and entertainment companies that are producing high-
production-value live streaming video that needs to be encoded and packaged for 
distribution.

Lightspeed Server

A Vantage Lightspeed Server is a 1RU, GPU-enabled, multi-core CPU server used to 
host Vantage services and accelerate video processing and x264 transcoding. 
Lightspeed Server accelerates compute-intensive image processing, including 
scaling, de-interlacing, frame rate conversion, motion vector calculation, and other 
tasks that require computation and analysis to modify or create new video frames. 

Lightspeed Live Schedule

Live Schedule is a Windows service-based web application (Scheduling Live 
Capture Sessions); an optional, separately licensed feature offered as part of 
Lightspeed Live Capture. Live Schedule enables you to create events you want 
captured for each source, and automatically starts and stops capturing video on an 
event-by-event basis, with optional SDI router control.

Lightspeed Live Play

Live Play is an optional, separately licensed product offered as part of Lightspeed 
Live Capture. The Live Play web app is an enterprise-class software solution that 
provides flexible and scalable SDI video playback on Telestream’s Lightspeed Live 
Server. Live Play enables you to perform confidence monitoring of file-based and 
streaming media by playing it back on-screen and via SDI.
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Listen action

The Listen action uses the Vantage Monitor Service to listen to a cloud-based 
message queue and generate jobs from received messages. The Listen action uses 
a plugin model for various cloud endpoints such as Amazon Simple Queue Service 
(SQS). The content of these messages could be very simple and contain a single 
value such as a file path or some sort of identifier to be used, or they could be more 
complex such as a blob of json/xml to be processed by a downstream action such 
as Extract. The Listen action automatically deletes messages from the queue as it 
processes them. Any messages that are present in the queue when the Listen 
action starts up will be processed.

Location action

The Location action uses the Cloud Service to determine if a specified file is located 
in Cloud-native storage or in local storage with an optional, 24-hour signed URL for 
HTTPS access. This information is usually utilized in branching workflows which 
execute a given workflow branch based on the location of the file.

Lookup action

The Lookup action is part of the Metadata group and is executed by the Metadata 
Service. The Lookup action performs a search operation on a set of key-value pairs 
in a master CSV file, based on values extracted from the metadata file associated 
with a job submission. If the key is found, the value is returned in the output 
variable, for use downstream. Lookup is typically used with a Catch action 
workflow, in TrafficManager applications. 

Management Console

The Management Console enables Vantage system administrators to effectively 
configure Vantage domains, and scale domains across multiple servers to meet 
their operating requirements and perform effectively in their environment.

MediaInfo action

The MediaInfo action, which is executed by the Vantage Analysis Service, performs 
2 tasks, based on its analysis of the media file and its streams:

- Creates variables from properties, using the MediaInfo API

- Creates a report of the properties and their values.

In each category, you can produce variables of selected metrics with the results the 
analysis.

Media Creation action

The Media Creation action uses the Vantage Avid Service to deliver new media to 
the specified Interplay server and issue the Interplay commands necessary to check 
the file into the Interplay server. This action is Open Workflow capable.

media nickname

A media nickname is an alias or alternate name that is assigned to a media file 
during Vantage workflow execution. When a media file is submitted to a workflow, 
the actual file name and location is stored in a Vantage binder along with a media 
nickname as defined in the workflow. Within the workflow, all references to a file 
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are by media nickname. However, when Vantage needs to access a file, Vantage 
uses the actual file name and location stored in the binder.

See attachment nickname and nickname.

MediaMate action

A MediaMate action uses the Vantage MediaMate Service to enable Vantage 
workflows to utilize and interact with the Subtitling capabilities of Screen 
MediaMate. Each subtitling option provides different capabilities that relate to the 
subtitle process.

Vantage MediaMate Service

The MediaMate Service implements the MediaMate Screen software for Vantage, 
and provides two-way communication between workflows (and the MediaMate 
action) utilizing the MediaMate Screen software itself.

Message action

A Message action is implemented in the Vantage Communicate Service and enables 
you to generate and transmit an electronic Message—an email, for example. A 
Vantage administrator must configure Vantage to use an SMTP server (Vantage 
Management Console: Settings & Options > Email) before email can be utilized.

Vantage Metadata Service

The Metadata Service executes the actions the extract metadata values, and 
perform conversions between attachment files, metadata labels, and variables. 
Metadata Service actions include the Extract action, the Populate action, and the 
Transform action.

Vantage Metric Service

The Metric Service gathers and supplies machine-level information about a specific 
Vantage node. It monitors CPU, network, and RAM utilization and reports these to 
Vantage. On a Lightspeed server, it also monitors the GPU activity. The bulk of the 
information that the Metric Service presents is visualized in the Machine Metrics 
section of the Vantage Console. By convention, a Metric Service should be installed 
and running on every node in a Vantage domain. If you do not have a Metric 
Service running on a specific machine, then that machine will not appear (will not 
have an entry) in the Machine Metrics section of the Vantage Console.

Vantage Monitor Service

The Monitor Service is the Vantage component that executes Watch actions and 
Associate actions, Camera Ingest action, Workorder action, and Listen action all 
relating to the discovery of files and starting jobs.

Move action

A Move action is executed by the Vantage Transport Service, and is used to move a 
file from a source target (file system/device and directory) to a destination target 
(file system/device and directory). It performs this task by copying the file to the 
destination, then deleting the source. The copy first, delete last process insures that 
the move completes normally before deleting the source file.

Move actions can be executed on any action state.
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Multi-Decide action

The Multi-Decide action simplifies a Vantage workflow by allowing multiple phases 
of Boolean logic called Decision Groups to be implemented within a single action. 
One Multi-Decide action can evaluate many different groups of variables and set a 
Result variable to represent the evaluation result for each group. 

A key feature is that the Decide groups defined in the action can be chained 
together, similar to Compute and Construct actions, so that the Result variable of 
one group within the action can feed the input conditions of a subsequent group 
within the same action. This provides powerful internal logical processing within a 
single Multi-Decide action. The variable values resulting from a Multi-Decide action 
can trigger any of several branches in a workflow.

As an example, a Multi-Decide action can implement internal logic to trigger 
downstream workflow branches. For example, IF the video format is MXF AND the 
video frame rate is 60, THEN IF the bit rate is 35 MB/sec, execute branch 1; IF the bit 
rate is 50 MB/sec, execute Branch 2; otherwise, execute Branch 3. IF the video 
format is not MXF or the frame rate is not 60, execute Branch 4. The Multi-Decide 
greatly reduces the number of Decide actions required per workflow because many 
expressions can be grouped into a single action. 

Multiscreen Flip action

The Multiscreen Flip action is an optional, licensed feature. Multiscreen Flip actions 
are Cloud actions; executed by the Vantage Multiscreen Service in Vantage or by 
the Cloud Service operating as a proxy, when executed in Telestream Cloud. The 
Multiscreen Service performs adaptive bit-rate encoding and simultaneous 
packaging of decoded digital baseband media into multiple bit-rate variants of 
H.264/HEVC video and containers in adaptive rate streaming formats, including 
Adobe HDS, Apple HLS, Microsoft HSS, and players the support MPEG DASH. You 
can configure the Multiscreen action to perform transcoding on a standard 
Vantage server or on a Lightspeed Server. This action is Open Workflow capable 
except when executing in Vantage Cloud mode.

Vantage Multiscreen Service

The Multiscreen Service is the Vantage component that executes the Multiscreen 
Flip action and the DRM action. This service (which can optionally run on a 
Lightspeed Server for H264 and HEVC encoding and video processing), supports 
the features required to handle varying adaptive bit-rate encoding and packaging 
requirements. Transcoding is performed by the Telestream Media Framework on 
behalf of Vantage. Rendering may be performed by an out-of-process resource 
managed by the Multiscreen Transcode Service. 

Nexidia Action

The Nexidia action is an optional, licensed feature in Vantage. It uses the Vantage 
Nexidia Service to interact with Nexidia QC servers running Nexidia QC software. 
The specified input files are passed to the Nexidia QC software where they are 
analyzed using the test profile selected.
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Vantage Nexidia Service

The Nexidia Service is an optional, licensed feature in Vantage. It executes Nexidia 
actions.

nickname

A nickname is an alias or alternate name that is assigned to a media or attachment 
file during Vantage workflow execution. When a media or attachment file is 
submitted to a workflow, the actual file name and location is stored in a Vantage 
binder along with a nickname as defined in the workflow. Within the workflow, all 
references to a file are by nickname. However, when Vantage needs to access a file, 
Vantage uses the actual file name and location stored in the binder.

Nicknames may refer to either media files or attachment files. Certain actions only 
allow the use of certain nickname types. For example, a Flip action only allows 
media file nicknames to be used as the inputs and outputs. However, other actions 
(such as the Move and Copy actions) operate on any type of file and allow the use 
of any nickname.

See attachment nickname and media nickname.

Notify action

A Notify action is implemented in the Vantage Communicate Service, and is an 
action which saves job information to a file to interface with an external system. 
You can configure a Notify action to produce an XML file, and you can also use it to 
invoke a Web Service. 

TrafficManager-centric extensions are presented here for backward compatibility. 

Open Workflows

An option to Vantage workflow functionality (enabled by the Open Workflows 
license), Open Workflows enhance the processing speed of workflows by enabling 
most actions to begin processing media before the previous action has completed 
its work. Open workflows only operate in Open mode when operating on Vantage 
domain nodes that are running on Windows in your local environment. They can 
not operate in Open mode when executing in Vantage Cloud mode.

origin action

An origin action is a specific type of action, which must be used to start a workflow. 
A workflow without an origin action as its first action is not properly designed, and 
cannot be activated. The origin actions include the Capture action, Watch action, 
Workorder action, and Receive action, as well as the Catch action and Dublist 
actions (optional TrafficManager actions).

Original nickname

The media nickname Original is a reserved nickname that is typically assigned to 
media files in a workflow by the origin action.

See media nickname.
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Populate action

A Populate action uses the Vantage Metadata Service to read and write metadata 
labels. During ingest, metadata labels can be added to ingested media and 
generally include trim information, audio levels, file properties, and commercial 
metadata. The metadata labels can then be reviewed and modified by operators 
using Workflow Portal. At any stage of a workflow, Vantage can extract information 
from labels using the Populate action, allowing Vantage for example to use trim 
points during a transcode, or audio level information when creating the final 
broadcast asset. This action is Open Workflow capable.

Post Producer

Post Producer is a specially-licensed set of actions and functionality in Vantage that 
enables iterative, template-driven assembly and encoding of assets for publication. 
Post Producer workflows automate assembly and reduce production costs by 
producing multi-layer video deliverables with transition and image effects, graphic 
overlays, and conformed for  IPTV and cable VOD production, news or weather 
updates, international localization, promo assembly and insertion and 
advertisement insertion.

Vantage Publish Service

The Publish service implements the Frame.io actionand Stanza action in Vantage.

Pulsar Action

The Pulsar action is an optional, licensed feature which enables broadcasters to 
integrate the Pulsar suite of content verification components directly in Vantage 
workflows. It is executed by the Vantage Pulsar Service.

Vantage Pulsar Service

The Pulsar service implements the Pulsar action in Vantage.

qualification rule

A qualification rule influences or controls the routing and execution of actions 
among Vantage services of the same type in a distributed Vantage domain. 
Qualification rules can be used to ensure that jobs are routed to services that are 
best suited for the task. Vantage uses values contained in variables to determine 
the suitability of a given service to execute the action.

Qualification rules are exclusively based on variables; they are not based on any 
actual machine analysis. As a result, it is up to the system administrator to correctly 
set up variables and qualification rules, and apply variables to the appropriate 
actions to ensure that jobs are routed correctly.

Qualification rules are created and managed in the Vantage Management 
Console> Services.

See also run on rules.

Qualify Action

The Qualify action allows Vantage to execute Quality Control functionality using 
the Encoding.com cloud platform and content present in cloud storage. Contact 
Telestream support for configuration or account details.
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Receive action

A Receive action is an origin action which is implemented in every Vantage service. 
Receive actions are designed to receive files from other systems: workflows, SDK-
based applications, and Workflow Portal, for example. Files can also be 
automatically submitted to a workflow starting with a Receive action from another 
workflow using the Forward action.

See Forward action.

Register action

A Register action uses the Vantage Catalog Service to add the binder created by 
each job to a Vantage catalog. Register actions can be executed on any action state.

See also Vantage catalog.

Remove action

A Remove action is executed by the Vantage Catalog Service, and is used to 
permanently remove a binder from the catalog and set the associated file resources 
to expired. If the action succeeds, it emits an action state of Success; otherwise, 
Failure.

Report action

A Report action, which is executed by the Vantage Analysis Service, generates a list 
of variables and their values and saves them in a file format specified by you.

resource cost

A resource cost is an integer value, implemented in the Vantage Management 
Console on each action type to specify a relative computer resource consumption 
value in relation to all other action types. This value enables Vantage to maximize 
resources and optimize transactions, so that you can tune your Vantage system for 
the highest possible throughput on your particular hardware.

retry rules

Retry rules are rules that you can specify on certain actions, to re-execute actions 
that fail primarily due to platform access and network latency problems. The retry 
rules you set on a given action override the default retry rules established in the 
Management Console.

run on rules

Run on rules are rules that you specify on a given action, to qualify which services 
have the characteristics that enable them to execute this action. Rules are set up by 
specifying variables which have been bound to a given Vantage service and values 
set. After configuration, the action can test each rule by comparing its run time 
value to the value in the service’s copy and determine if there is a match before 
attempting to execute it. 

See also qualification rule.
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Vantage SDK Service

The SDK Service is the Vantage component which enables integration with third-
party or custom-developed client programs, for submitting jobs, tracking status, 
etc.

Session Log

The session log is a function of the Job Status and Domain Job Status panels in the 
Workflow Designer. This log displays session activity entries, if any, including which 
variables have been provided to each action and which ComponentPac was used 
to run an action. This information can be helpful when debugging the use of 
variable, or when working on an issue with Telestream Customer Service.

Signiant Delivery action

A Signiant Delivery action, which is executed by the Vantage Signiant Service, is 
used to deliver files to servers controlled by Signiant file transfer products.

Signiant Media Shuttle action

A Signiant media Shuttle action, which is executed by the Vantage Signiant Service, 
used for automated Media Shuttle accelerated file transfers among a specified list 
of users using Vantage workflows.

Vantage Signiant Service

The Signiant Service is the Vantage component which enables integration with 
third-party or custom-developed client programs, for submitting jobs, tracking 
status, etc.

The Signiant Service implements the Signiant file transfer product for Vantage, and 
provides two-way communication between workflows (along with the Signiant 
Delivery action and Signiant Media Shuttle action) utilizing the Signiant software 
itself.

Vantage Staging Service

The Staging Service is the Vantage component which executes Archive actions and 
Gather actions.

Stanza action

The Stanza action is part of the Publish group and is executed by the Vantage 
Publish Service. The Stanza action allows Vantage to create new projects within an 
installed server instance of Stanza. For more information on Stanza server 
installations and configurations, see the Stanza page on the Telestream web site for 
details. 

service

See Vantage services.

Secured Version Control

The Secured Version Control feature provides the ability to install the latest software 
and begin building workflows that utilize new ComponentPac libraries (software 
libraries), while keeping the existing workflows untouched and operating off a 
previous ComponentPac version. When the user desires to upgrade a workflow or 

https://www.telestream.net/telestream-support/stanza/support.htm
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action within a workflow, it can be done at a convenient time. For a detailed 
description of Secured Version Control, search the Vantage Domain Management 
Guide.

Synchronize action

A Synchronize action is a connector action, for the sole purpose of uncluttering 
workflow connectors. In workflows where there is a many-to-many relationship (for 
example, 6 Flip actions connecting to 6 Deploy actions, which connect to 6 
Deletes), instead of drawing connection between them all, you simply connect 
them to a common Synchronize action. There is no Inspector for the Synchronize 
action, because no configuration is required.

Syndicate action

The Syndicate action processes and can apply a template to metadata 
accompanying syndicated content from providers such as Pitchblue and generic 
providers. The Syndicate action is part of TrafficManager, an optional, licensed 
feature of Vantage, enabled with the TrafficManager license. It is executed by the 
Vantage Traffic Service. The purpose of this action is to automatically rearrange 
segments according to the template, or to mark specific segments as “not 
included” in the final program. Use the Syndicate action in syndicated media ingest 
workflows to convert sidecar metadata XML files to a mezzanine format for use in 
downstream actions in the workflow, or for use in Syndication Workflow Portal 
applications. 

Syndication Forward action

The Syndication Forward action is part of TrafficManager, an optional, licensed 
feature of Vantage, enabled with the TrafficManager license. It is executed by the 
Vantage Traffic Service. 

The Syndication Forward action processes incoming jobs from a traditional 
syndication source, such as a catch server, and allows for automatic forwarding of a 
CML file to a publishing workflow which performs segment extraction and 
processing. This removes the step of manual Workflow Portal interactions involving 
a typical Syndication action workflow in cases where an automated process is 
required or desired.

Tape action

The Tape action is an origin action (and may be the only action in a workflow) used 
to start SDI-based tape capture workflows created in any Vantage domain installed 
on the Lightspeed Live server. The Tape action inspector allows you to select and 
configure VTR sources for processing, filtering, transcoding, and output. You can 
also use the action to add metadata labels.

Vantage Diva Service

The Diva Service is the Vantage component that executes the DIVA Lookup | Diva 
Restore | DIVA Archive actions, communicating with a target Content Manager | 
DIVA Core as defined in the Vantage Domain Management Console, via the DIVA 
Rest API. 



Vantage Glossary 347

Telestream Live Persistence Service

The Telestream Live Persistence Service handles the persistence of source material.

Telestream Live Service

The Telestream Live Service corresponds to the Live Manager capability and 
arbitrates resource allocation for Lightspeed Live Capture. 

Telestream Live Source Service

The Telestream Live Source service manages the acquisition of material from a 
specific source (spawned by the Telestream Live Service).

Telestream Media Framework

The Telestream Media Framework is a software framework developed by Telestream 
for reading, writing transcoding, and analyzing many different kinds of media files. 
Telestream Media Framework is integrated in many Telestream products, including 
Vantage.

Telestream Playlist Service

The Telestream Playlist Service implements Telestream Live Play, which is used to 
play out files created by Live Capture.

Telestream Playlist Service is an optional, separately licensed feature. The Live Play 
web app provides on-screen and SDI-based real-time playback features based on 
custom playlists you create.

Telestream Schedule Service

The Telestream Schedule Service is an optional, separately licensed feature. It 
implements Live Schedule, including Live Schedule, a service-based web 
application. Live Schedule works in conjunction with Live Capture, enabling you to 
create events you want captured for each source, and automatically starts and 
stops capturing video on an event-by-event basis.

Tempo action

The Tempo action is part of the Edit group executed by the Vantage Edit Service and 
is Cloud capable. When in Vantage Cloud mode, it is executed by the Cloud Service 
in Telestream Cloud. The Tempo action is included in Tempo, a time-adjusting 
encoding solution built on the Vantage platform. The Tempo action re-times file-
based content and intelligently decreases or increases the running time of shows 
and segments. This action is Open Workflow capable. 

Timed Text Conform action

The Timed Text Conform action is part of the Timed Text group and is Cloud 
capable. The Timed Text Conform action is executed by the Vantage Timed Text 
Service or via the Cloud Service when executed in Telestream Cloud. The Timed 
Text Conform action ingests a Timed Text CML file with references to caption/
subtitle files in order to create SCC, MCC, or IMSC outputs.
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Timed Text Flip action

The Timed Text Flip action is part of the Timed Text group and is Cloud capable. The 
Timed Text action is executed by the Vantage Timed Text Service, or by the Cloud 
Service operating as a proxy, when executed in Telestream Cloud. The Timed Text 
Flip action automates caption file-type conversions, extracts caption data from 
media with embedded captions, creates subtitle overlay graphics, and manipulates 
the timecode of caption data to match media. 

Vantage Timed Text Service

The Timed Text Service is the Vantage component which executes the Timed Text 
Conform action or Timed Text Flip action.

Vantage Traffic Service

The Traffic Service is the Vantage component which executes the Catch action | 
Dublist action | Syndicate action.

TrafficManager

TrafficManager is an optional, licensed feature which enables automated 
advertisement and syndicated media processing from catch server to automation 
systems and on-air servers, serving both the broadcast and cable industry. It 
includes the Catch action for catch servers and the Dublist action for dublist 
management. It also includes the Syndicate action for processing syndicated 
media.

transcode

Transcode means the process of decoding media in one format (MPEG2, for 
example) down to digital baseband and then encoding it in another media format 
(MPEG4, for example). 

Vantage Transcode Service

The Transcode Service is the Vantage component that executes the Flip action | 
Flip64 action —transforming media from one format to another. Transcoding for 
the Flip action is performed by the Telestream Media Transcode and Analysis 
Engine on behalf of Vantage. The remaining actions are performed within the 
Telestream Media Framework.

Transform action

A Transform action uses the Vantage Metadata Service to transform metadata 
between XML files (attachments) and labels. XSL style sheets are used to perform 
these transformations; style sheets can be managed in the Vantage Management 
Console: Workflow Design Items > Style Sheets. This action is Open Workflow 
capable.

Vantage Transport Service

The Transport Service is the Vantage component that executes (or manages the 
execution via an out-of-process resource) the actions relating to file operations: 
Move action, Delete action, Copy action, and Deploy action. File transfers may be 
performed by an out-of-process resource managed by the Transport Service. 
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Utilization action

A Utilization action enables users to determine the relative load on the domain as 
well as transcoding services within the domain. Other downstream actions can 
then make intelligent branching decisions based on that information: Telestream 
Cloud versus on-premises transcoding of media, for example.

Vantage array

A Vantage array is a Vantage domain whose software components are distributed 
among multiple computers for durability and scalability, instead of installed and 
operating on a single computer (often referred to as a distributed domain). A 
typical array has the Vantage domain database installed on a dedicated server, and 
all Vantage services installed on another computer, and additional Transcode 
Services each installed on other computers for high-performance, parallel 
transcoding.

Vantage catalog

Formal name for catalog. Similar in concept to the folders in a file system, a Vantage 
catalog is a container that stores binders. Catalog folders are sub-containers that 
organize binders. To access a binder, Workflow Portal operators search through the 
visible catalogs and folders, just as they might sort through folders in a file system.

Vantage domain database

A Vantage domain database is a Microsoft SQL Server database which contains all 
workflows, actions, jobs, binders, licenses, and configuration information for a 
Vantage domain.

Vantage domain

A Vantage domain is a collection of computers, Vantage workflows, actions, 
Vantage services, jobs, binders, and configuration settings, all known to and 
interacting with each other, stored in a database. This collection constitutes a 
Vantage domain. Vantage domains may exist on a single computer or they may be 
distributed across many computers for durability and scalability.

The name of a Vantage domain is the same as the name of the server that hosts the 
Vantage domain database.

Multiple Vantage domains may exist on a network, but they are independent 
entities that do not communicate with each other. They are not bound together 
and do not share resources or work. The purpose of storing an entire domain in a 
database is to provide an easy way to create and manage the domain and to 
provide access to all the details about each resource in the domain to any other 
resource that needs it.

Vantage EDL nickname

The nickname Vantage EDL is a reserved nickname that is typically assigned to 
media files that are created in catalog ingest workflows, to identify the ingest files 
of an Edit Decision List in Workflow Portal, during Stitch and Trim operations. See 
media nickname.
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Vantage folder address

A Vantage folder address is an alias to a local or remote file folder. You can create and 
manage Vantage folder addresses in the Vantage Folder Address Book dialog, in 
Copy and Move actions in Vantage Workflow Designer, and in the Vantage 
Management Console.

After you create a Vantage folder address, you can specify the destination directory 
in any workflow simply by selecting the Vantage folder address. Changes to a 
Vantage folder address—such as updating an IP address or a password—
immediately affect all workflows that use that Vantage folder.

Unlike Vantage stores, temporary files that are created during workflow execution 
are not automatically deleted from Vantage folders according to job expiration 
settings. 

Vantage Live Service

Part of the Vantage Media Processing Platform on a Lightspeed Live Server, the 
Vantage Live Service is listed in the Management Console Services list and executes 
the Capture action processes.

Vantage Proxy nickname

The media nickname Vantage Proxy is a reserved nickname that may be assigned to 
media files encoded using the QuickTime encoder in H.264/AAC as QuickTime 
movies or MP4 files with x264/AAC, which enables previewing with the media 
viewers provided in Vantage programs such as Workflow Designer, Workflow Portal, 
and the Vantage Management Console.

Alternatively, the Workflow Portal Windows Client QuickTime Media Player 
supports MP4 with x264-encoded H.264/AAC, provided that QuickTime 7.7.6 or 
later is installed.

See media nickname.

Vantage services

The term Vantage services refers to the collection of Windows services in a Vantage 
domain, which are responsible for executing all of the actions in a workflow as it 
executes.

Vantage store

A Vantage store is a directory on a Windows file system that stores temporary files. 
Stores are managed by the Vantage domain for the purpose of centralizing large 
directories for reading and writing files. Unlike a Vantage folder, temporary files 
placed in a Vantage store are deleted when the binder is deleted. Vantage stores 
are generally used to hold temporary files for the duration that a job is executing.

Vantage stores are managed in the Vantage Management Console: Storage. 
Services that create temporary files, such as the Transcode Service, can be 
configured to use specific stores.
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Vantage Thumbnail nickname

The media nickname Vantage Thumbnail is a reserved nickname that is typically 
assigned to output media files that are created to display thumbnail images instead 
of binder names in Vantage programs such as Workflow Portal.

See media nickname.

variable

In Vantage, a variable is a container for temporary job information—a symbolic 
name (or identifier) which contains some known or unknown quantity or element 
of information; a value. You use the variable name to reference the current value; 
this separation of name and content allows the name to be used independently of 
the exact information it represents. The variable can be bound to a value (that is, 
you can set a variable to a given value) during run time, and the value of the 
variable may change during the course of workflow execution. 

A variable identifies temporary job metadata. Variables have a name (such as 
Number of Audio Channels), a type (such as Integer Number) and a default value 
(such as 50). Variables values can be set inside a job in a variety of ways: through 
analysis, through metadata population, in the Watch and Associate actions, as a 
property of an action, or by a service as it executes an action.

Variables are used by Vantage services and actions to control workflow execution. 
Many settings in actions can be bound (or attached) to variables, allowing the 
workflow to dynamically update values on a job-by-job basis. 

For example, a variable may be assigned a value by an Analysis action to determine 
how many lines of black are at the top of a video frame; a crop filter later in the 
workflow can bind to that variable, ensuring that every crop in every job is 
appropriate to the workflow requirements.

Variables in services may be also be used for job routing. For example, an action 
with a boolean variable named hostnameRequired set to TRUE must pass this 
condition to a service which evaluates the condition to determine if it can 
successfully perform the action.

Variables can be created in Vantage Management Console (Workflow Design Items 
> Variables) or in Vantage Workflow Designer, and assigned for use in workflows 
and services.

VidChecker action

A VidChecker action is an optional, licensed feature in Vantage. It uses the 
VidChecker Service to enable Vantage workflows to utilize and interact with various 
QC tests provided by the VidChecker software.

VidChecker Service

The VidChecker Service implements the VidChecker QC software for Vantage, and 
provides two-way communication between workflows (and the VidChecker action) 
utilizing the VidChecker software to perform media quality tests.

Watch action

A Watch action is an origin action; it uses the Vantage Monitor Service to regularly 
poll a target location (a directory, for example) on a device or file system (FTP, 
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Windows network folder, etc.) to discover new files. This action is Open Workflow 
capable.

When a new file is discovered, the Watch action submits a job for the workflow 
which it is part of, for processing the file—typically, a media file.

Web Dashboard

The Web Dashboard is an optional, licensed web app which displays important 
domain information from anywhere on your network in a web browser. The Web 
Dashboard is installed on the IIS server on your Vantage domain database server. 

workflow

A workflow in Vantage is a set of actions designed to perform an automated 
process. Vantage workflows are created using the Vantage Workflow Designer by 
adding and configuring actions and connecting them together. Workflows are 
stored in the Vantage domain database, and executed by Vantage services.

Workflow Designer

Vantage Workflow Designer is a client program that enables you to create and edit 
workflows, activate and deactivate workflows, monitor job status, and review and 
delete jobs that have completed.

Workflow Portal

Workflow Portal is a client program that features a customizable set of functionality 
to support various operator-related tasks: selecting media and submitting jobs, 
updating variables and metadata, forwarding jobs, creating EDL-based jobs, etc.

Customization is implemented in the Vantage Management Console, when 
Vantage administrators construct the user interface and functionality they want for 
a given task, then save it. When operators launch Workflow Portal, they select the 
configuration appropriate to the task at hand, and Workflow Portal dynamically 
display the user interface components specified in the configuration file.

Workflow Portal Web Application

The Workflow Portal web app is a limited implementation of Workflow Portal, for use 
in a web browser over a network or Internet connection.

Workorder action

A Workorder action is an origin action; it uses the Vantage Monitor Service to 
regularly poll a target Windows directory for new workorder files to process. The 
Workorder action provides a simple and highly effective method of submitting 
multiple similar jobs without using the SDK. 

When a new file is discovered, the Workorder action submits one job for each row 
in the file.

workorder file

A workorder file is a comma-separated value (CSV) text file containing one or more 
work orders, or job descriptions. Each row in the CSV file specifies a job, and each 
column specifies either an input file for the job, or value for run-time use; typically 
assigned to a variable in the workflow. Workorder file configurations are specified 
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in the Domain Management Console. At least one workorder scheme must be 
created in order to use a Workorder action.
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